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UNIT

1
COMPUTER – AN INTRODUCTION

L E A R N I N G  O B J E C T I V E S

After studying this unit, you should be able to understand:

Define a computer and its various parts.

Classify computer according to purpose, technology used, size and capacity.

Describe various characteristics of computer.

Describe various Input and output devices.

Understand the concept of Office Automation.

Describe various components of a computer system.

Describe various generations of the computer.

U N I T  S T R U C T U R E
1.1 Introduction
1.2 What is a Computer?
1.3 Importance of Computers (Man vs. Machine)
1.4 Classification of Computers
1.5 Popularity of Personal Computers (IBM PC vs. Apple Mac PC)
1.6 Architecture of a Computer System
1.7 Computers in Business
1.8 Facilities Available in Computerised System
1.9 Indian Computing Environment
1.10 Office Automation
1.11 Components of a Computer System
1.12 Hardware Components of Micro Computer
1.13 Classification of Software
1.14 Generation of Computers
1.15 Computer Languages
1.16 Language Translators
1.17 Summary
1.18 Keywords
1.19 Review Questions
1.20 Further Readings

1.1 INTRODUCTION

Nothing has revolutionized modern life the way rapid progress of computers has. For better or
worse, computers have infiltrated every aspect of our society. Today, computers do much
more than simply compute. They make airline or railway reservation and teach on-line; some
super store scanners calculate our grocery bills while keeping the store inventory; computerised
telephone switching has greatly improved the telephone system and Automatic Teller Machines
(ATM) let us conduct banking transactions from virtually anywhere in the world.

As computers become more widespread in the workplace, new ways to harness their potential
developed. As smaller computers become more powerful, they could be linked together, or
networked, to share memory space, software, and information and communicate with each
other.
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in Management 1.2 WHAT IS A COMPUTER?

In a laymans language, a computer is a fast calculating device that can perform arithmetic
operations. Although the computer was originally invented mainly for doing high speed
and accurate calculations, it is not just a calculating device. The computer can perform any
kind of work involving arithmetic and logical operations on data. It gets the data through an
input device, processes it as per the instructions given and gives the information as an
output. We can define computer as follows:

Definition

A computer is a fast electronic device that processes the input data according to the
instructions given by the programmer/user and provides the desired information as an
output.

The terminology used in the above definition is summarized in Table 1.1.

1.3 IMPORTANCE OF COMPUTERS (MAN VS. MACHINE)

Computers play a vital role for processing of data in an organization. Computer: help in
processing the volumes of data efficiently and accurately within a short time. A computer
has the following characteristics which make it so important for an organization:
1. Fast: A computer is so fast that it can perform the given task (arithmetical or logical)

in few seconds as compared to man who can spend many months for doing the same
task. A computer can process millions of instructions per second.

2. Accurate: While doing calculations, a computer is more accurate than man can make
mistakes in calculations but a computer does not make mistakes, if it is provided
accurate instructions.

3. Diligence: A computer does not suffer from the human traits of tiredness and boredom.
Man will be tired and bored while doing millions of calculations but a computer, being
a machine, does this job very efficiently and without any tiredness and boredom.

4. High Memory: A computer has much more memory or storage capacity than human
being. It can store millions of data and instructions, which can be retrieved and recalled
even after a number of years. This is not possible in case of human brain.

5. No Intelligence: A computer is a machine and obviously has no intelligence of its
own. Each and every instruction must be given to the computer for doing a task. Man
has an intelligence and it is the man who invented computer and gives it all the
instructions and logic to work. A computer cannot take decisions on its own and it is
the main drawback of computer.

1.4 CLASSIFICATION OF COMPUTERS

The classification of computers is based on the following three criteria:

(a) According to Purpose

(b) According to Technology used

(c) According to size and Capacity
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Computer – An IntroductionBased on these criteria, the classification of computers is illustrated in Figure 1.1 and
discussed below:

According to Purpose

According to the utilization of computer for different uses, computers are of following two
types:

1. General Purpose Computers: Computers that follow instructions for general
requirements such as sales analysis, financial accounting, invoicing, inventory,
management information etc. are called General Purpose Computers. Almost all
computers used in offices for commercial, educational and other applications are
general purpose computers.

2. Special Purpose Computers: Computers designed from scratch to perform special
tasks like scientific applications and research, weather forecasting, space applications,
medical diagnostics etc. are called Special Purpose Computers.

According to Technology Used

According to the technology used, computers are of following three types:

1. Analog Computers: Analog computers are special purpose computers that represent
and store data in continuously varying physical quantities such as current, voltage or
frequency. These computers are programmed for measuring physical quantities like
pressure, temperature, speed etc. and to perform computations on these measurements.
Analog computers are mainly used for scientific and engineering applications. Some
of the examples of analog computers are given below:

(i) Thermometer: It is a simple analog computer used to measure temperature. In
thermometer, the mercury moves up or down as the temperature varies.

(ii) Speedometer: Car's speedometer is another example of analog computer where
the position of the needle on the dial represents the speed of the car.

2. Digital Computers: Digital computers are mainly general purpose computers that
represent and store data in discrete quantities or numbers. In these computers, all
processing is done in terms of numeric representation (Binary Digits) of data and
information. Although the user enter data in decimal or character form, it is converted
into binary digits (0's and l's). Almost all the computers used nowadays are digital
computers and we will discuss the detailed working and components of these
computers in subsequent sections of this unit.

3. Hybrid Computers: Hybrid computers incorporate the technology of both analog and
digital computers. These computers store and process analog signals which have
been converted into discrete numbers using analog-to-digital converters. They can

Figure 1.1 : Classification of Computers Based on Different Criteria



10

Computer Application
in Management

also convert the digital numbers into analog signals or physical properties using
digital-to-analog converters. Hybrid computers are mainly used in artificial intelligence
(robotics) and computer aided manufacturing (e.g. process control).

Student Activity 1
1. What is a computer?
2. What are the main characteristics of computer?
3. What are general purpose computers?
4. What are analog computers? Give examples.
5. What are hybrid computers?

According to Size and Capacity

According to the size and memory/storage capacity, computers are of following four types:
1. Supercomputer: Supercomputer is the biggest and fastest computer, which is mainly

designed for complex scientific applications. It has many CPUs (Central Processing
Units - main part of computer) which operate in parallel to make it as a fastest computer.
It is typically used for the following applications:

Weather Forecasting
Petroleum Exploration and Production
Energy Management
Defense
Nuclear Energy Research
Structural Analysis
Electronic Design
Real-time Animation
Medicine

Some of the examples of supercomputers are CRAY3, CRAY-XMP-14, NEC500, P ARAM
9000 and P ARAM 10000.

2. Mainframe Computer: Mainframe computers are very large and fast computers but
smaller and slower than supercomputers. These are used in a centralized location
where many terminals (input/output devices) are connected with one CPU and thus,
allow different users to share the single CPU. They have a very high memory (several
hundred Megabytes) and can support thousands of users. They are mainly used for
following applications:

Railway and Airline Reservations
Banking Applications
Commercial Applications of Large Industries/Companies

Some of the examples of mainframe computers are IBM 3090, IBM 4381, IBM 4300 and IBM
ES-9000.
3. Minicomputer: Minicomputers are medium-scale, smaller and generally slower than

mainframe computers. Like mainframes, they have many terminals which are connected
with one CPU and can support many users. The cost of minicomputer is very less as
compared to mainframe. Therefore, it is mainly used in applications where processing
can be distributed among several minicomputers rather than using a mainframe
computer.
Some of the examples of minicomputers are PDP-1, IBM AS/400 and DEC Micro VAX.
IBM AS/400, which is actually a midicomputer (computer with performance between a
mainframe and minicomputer) is becoming very popular among minicomputers.

4. Microcomputer: A microcomputer is the smallest digital computer, which uses a microprocessor
as its CPU. Microprocessor is a single chip (Integrated Circuit) CPU. Microcomputer is popularly
called as Personal Computer (PC). It can be used both as a stand-alone machine and a terminal
in a multi-user environment. Microcomputers are becoming very popular nowadays due to
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Computer – An Introductionvery high processing power and memory. Today, a powerful microcomputer may be used as a
substitute for mini or mainframe computer.

Microcomputers are either of desktop or portable model. Portable computers can be
carried from one place to another. Some of the models are called as laptops while others
as notebook computers. Notebook computers are smaller, lighter and costlier than laptops.
Desktop computers fit on a desktop and are used widely in offices and homes. The
pictures of some of the desktop and portable computers are shown in Figure 1.2.

There are many types and models of microcomputers, which are summarized in Table 1.2.

1.5 POPULARITY OF PERSONAL COMPUTERS (IBM
PC VS. APPLE MAC PC)

IBM PC is the first personal computer, introduced in 1981 by the world's largest computer
company - IBM (International Business Machines Corp., New York). This computer was
based on Intel's 8088 microprocessor or chip. It became a success almost overnight. In later
years, IBM manufactured 80286, 80386, 80486 and recently the Pentium PCs. Although IBM
is still the largest supplier of PCs, the majority of PCs are manufactured by other companies
as per the standards set by IBM. This whole family of PCs is known as IBM-compatible PCs.

*XT stands for Extended Technology
**AT stands for Advanced Technology

Figure 1.2: Some Desktop and Portable Computers

Table 1.2: Different Types of Microcomputers along with the Technical Specifications of CPU

CPU Model Clock Date Regis ter Max. C o m m e n t s
(MHz) B u s (BIT) Memory

(RAM)

8088 8 8 16 1 MB First 8 bit microprocessor
(Original PC)

8086 8 16 16 1 MB First 16 bit CPU on a chip
(PC/XT)*

80286 20 16 16 16 MB 5 times faster than PC/XT
(PC/AT)**

80386 SX 33 16 32 16MB 80386 with an 80286 bus

80386 DX 40 32 32 4 GB True 32 bit CPU on a chip

80486 SX 40 32 32 4 GB Math co-processor disabled

80486DX2 66 32 32 4 GB More speed with Math
co-processor enabled

80486 DX4 1 0 0 32 32 4 GB More speed than 486 DX2

Pentium Pro 2 0 0 64 32 4 GB Superscope architecture
(P5) Able to execute 2 instructions

simultaneously

Pentium II (P6) 2 6 6 64 32 64 GB Faster than Pentium Pro
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So, whenever we talk about a Pc, it usually means one of the IBM-compatible PCs. PS/2 and
PS/1 (PS stands for Personal System) are IBM computer series introduced in 1987 and 1990
respectively.
Apple Macintosh PC (popularly called as Mac) is another series of 32-bit personal computers,
introduced in 1984 by one of the first microcomputer manufacturing company - Apple (Apple
Computer, Inc.). Apple is the largest independent manufacturer of non-IBM-compatible PCs.
Apple Mac PC uses the Motorola (a leading manufacturer of semiconductor devices) 68000
processor family and a proprietary operating system. As this PC comes with its own operating
system, there is no need of DOS or other operating system for operating it. The method of
operating a Mac PC is known as Macintosh user interface. All Mac PCs have graphics displays,
as their operating systems provide Graphical User Interface (GUI). The Mac PC always displays
a row of menu titles at the top of the screen, from which options are selected.
Although the first Mac PC was praised by many users due to its ease of use and low-cost system, it
was not exciting for most corporate buyers due to its slow speed, small screen and closed architecture
(a system whose technical specifications are not made public). In 1987, Apple manufactured Mac II,
which offers full-size screens, high-speed and open architecture (a system whose technical
specifications are made public). In 1991, IBM formed an alliance with Apple to fully integrate Macs
into IBM enterprise networks for developing PowerPC with Motorola.
IBM-compatible PCs are used as stand-alone machines or as workstations/ file servers in a
local area network (we will discuss about local area network in later part of this unit). These
PCs are very popular as stand-alone systems, which run under DOS. IBM-compatible PCs
(80486 & above) are also popular for using as client/server systems (we will also discuss
about client/server systems in later part of this unit). On the other hand, Apple/Macintosh
PCs are rarely used as the primary client computers in client/server systems. Macintosh PCs
are useful mainly for desktop publishing systems, due to graphical user interface. IBM
compatible PCs, on the other hand, are useful for any kind of business applications. They
have become very popular among all users in India and abroad.

Student Activity 2
1. What are super computers?
2. What is the difference between mainframes and mini computers?
3. What are micro computers?

1.6 ARCHITECTURE OF A COMPUTER SYSTEM
In last section, we discussed that there are many types of computers. The internal
architectural design of computers differ from one model to another, however the basic
components of a computer remains the same for all models. The diagram of a generalized
architecture of a computer system is shown in Figure 1.3. Before discussing the details of
computer architecture, we would define the computer system as follows:
Definition
A complete computer installation including the central processing unit, the peripherals
such as hard disk drives, floppy disk drives, monitor, printer, mouse and operating system
which are designed to work and interact with each other and with the user is called a
computer system.

Figure 1.3: Functional Diagram of a Generalised Architecture of a Computer System
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Computer – An IntroductionA computer system has following three main components:

(a) Input/Output Unit

(b) Central Processing Unit

(c) Memory Unit

Input/Output Unit

We know that the computer is a machine that processes the input data according to given
set of instructions and gives the output. Before a computer does processing, it must be
given data and instructions. After processing, the output must be displayed or printed by
the computer. The unit used for getting the data and instructions into the computer and
displaying or printing output is known as an Input/Output Unit (I/O Unit).

The Input Unit is used to enter data and instructions into a computer. There are many
peripheral devices which are used as input/output units for the computer. The most common
form of input device is known as a terminal. A terminal has a electronic typewriter like
device, called keyboard along with a display screen, called Visual Display Unit (VDU) or
monitor. Keyboard is the main input device while monitor can be considered both as an
input as well as an output device. There are some other common input devices like mouse,
punched card, tape, joystick, scanner, modem etc., which are explained in later part of this
unit. Monitor, printer and plotter are the main peripheral devices used as output units for
the computer.

Central Processing Unit

Central Processing Unit (CPU) is the main component or "brain" of a computer, which
performs all the processing of input data. Its function is to fetch, examine and then execute
the instructions stored in main memory of computer. In microcomputers, the CPU is built on
a single chip or Integrated Circuit (IC) and is called as Microprocessor. The CPU consists of
following distinct parts:

1. Arithmetic Logic Unit (ALU): The arithmetic and logic unit of CPU is responsible for
all arithmetic operations like addition, subtraction, multiplication and division as well
as logical operations such as less than, equal to and greater than. Actually, all
calculations and comparisons are performed in the arithmetic logic unit.

2. Control Unit (CU): The control unit is responsible for controlling the transfer of data
and instructions among other units of computer. It is considered as a "Central Nervous
System" of computer, as it manages and coordinates all the units of computer. It
obtains the instructions from the memory, interprets them and directs the operation of
the computer. It also performs the physical data transfer between memory and the
peripheral device.

3. Registers: Registers are the small high speed circuits (memory locations) which are
used to store data, instructions and memory addresses (memory location numbers),
when ALU performs arithmetic and logical operations. Registers can store one word
of data (1 word = 2 bytes & 1 byte = 8 bit; details of BITS and BYTES are discussed in
later part of this unit) until it is overwritten by another word. Depending on the
processor's capability, the number and type of registers vary from one CPU to another.
Registers can be divided into six categories viz. General Purpose Registers, Pointer
Registers, Segment Registers, Index Registers, Flags Registers and Instruction. Pointer
Registers, depending upon their function. The detailed functions of each and every
register is beyond the scope of this book.

4. Buses: Data is stored as a unit of eight bits (BIT stands for Binary Digit i.e. (0 or 1) in
a register. Each bit is transferred from one register to another by means of a separate
wire. This group of eight wires, which is used as a common way to transfer data
between registers is known as a bus. In general terms, bus is a connection between
two components to transmit signal between them. Bus can be of three major types viz.
Data Bus, Control Bus and Address Bus. The data bus is used to move data, address
bus to move address or memory location and control bus to send control signals
between various components of a computer.
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5. Clock: Clock is another important component of CPU, which measures and allocates
a fixed time slot for processing each and every micro-operation (smallest functional
operation). In simple terms, CPU is allocated one or more clock cycles to complete a
micro-operation. CPU executes the instructions in synchronization with the clock pulse.

The clock speed of CPU is measured in terms of Mega Hertz (MHz) or Millions of
Cycles per second. The clock speed of CPU varies from one model to another in the
range 4.77 MHZ (in 8088 processor) to 66 MHz (in Pentium) CPU speed is also specified
in terms of Millions of Instructions Per Second (MIPS) or Million of Floating Point
Operations Per Second (MFLOPS).

Memory Unit

Memory Unit is that component of a computer system, which is used to store the data,
instructions and information before, during and after the processing by ALU. It is actually
a work area (physically a collection of integrated circuits) within the computer, where the
CPU stores the data and instructions. It is also known as a Main/Primary/Internal Memory.
It is of following three types:

(a) Read Only Memory (ROM pronounced as “Ra-om”)

(b) Random Access Memory (RAM pronounced as "R-aem")

(c) Complementary Metal Oxide Semiconductor Memory (CMOS)

(a) Read Only Memory: Read Only Memory is an essential component of the memory
unit. We know that the computer, being a machine, itself has no intelligence or memory
and requires the instructions which are given by man. Whenever the computer is
switched on, it searches for the required instructions. The memory, which has these
essential instructions, is known as Read Only Memory (ROM). This memory is
permanent and is not erased when system is switched off. As appears with its name, it
is read type of memory i.e. it can be read only and not be written by user/programmer.
The memory capacity of ROM varies from 64 KB to 256 KB (1 Kilobyte = 1024 bytes)
depending on the model of computer.

ROM contains a number of programs (set of instructions). The most important program
of ROM is the Basic Input Output System (BIOS, pronounced as "bye-os") which
activates the hardware (physical components of computer) such as keyboard, monitor,
floppy disk etc. in communicating with the system and application software (set of
instructions or programs).

Types of ROM: There are many types of ROM available for microcomputers like Mask
ROM, PROM, EPROM, EEPROM and EAPROM.

(b) Random Access Memory: Random Access Memory (RAM) is another important
component of Memory Unit. It is used to store the data and instructions during the

Def in i t ions

Mask ROM: Mask ROM is the basic ROM chip. In this type of ROM, the information is stored
at the time of its manufacturing. So, it cannot be altered or erased later on.

PROM: PROM stands for Programmable Read Only Memory. In this type of ROM, the information
is stored by programmers after its manufacturing. It cannot be altered or erased later on.

EPROM: EPROM stands for Erasable Programmable Read Only Memory. It is similar to PROM,
but its information can be erased later on by ultra violet light and it can be reprogrammed.

EEPROM: EEPROM stands for Electrically Erasable Programmable Read Only Memory. It is
similar to EPROM, but its information can be erased by using a high voltage current.

EAPROM: EAPROM stands for Electrically Alterable Read Only Memory. As compared to EPROM
and EEPROM, the information stored in EAPROM can be altered later.
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Computer – An Introductionexecution of programme. Contrary to ROM, RAM is temporary and is erased when
computer is switched off. RAM is a read/write type of memory and, thus can be read
and written by user/programmer. As it is possible to randomly use any location of this
memory, therefore, this memory is known as random access memory. The memory
capacity of RAM varies from 640 KB to several megabytes (1 Megabyte = 1024 KB)
with different models of Pc.
Types of RAM: There are two types of RAM used in PCs - Dynamic and Static RAM.

(c) Complementary Metal Oxide Semiconductor Memory: Complementary Metal Oxide
Semiconductor (CMOS) memory is used to store the system configuration, date, time
and other important data. When computer is switched on, BIOS matches the information
of CMOS with the peripheral devices and displays error in case of mismatching.

Student Activity 3

1. State the basic units of a computer.
2. What are the various parts of CPU?
3. What is the function of ALU and CU?
4. What are registers?
5. What is the function of clock in CPU?
6. Define memory. Describe its various types.
7. Define CMOS.

1.7 COMPUTERS IN BUSINESS
Computers can process vast quantities of business data at enormous speed with unfailing
consistency and unimaginable flexibility.

These capabilities of computers open new approaches to problem solving and data
processing.

Following six characteristics of computers make them indispensable for use in business:
(a) Speed: Computers speed up data processing by many orders of magnitude as compared

to the manual system.
(b) Data Volume: Vast amount of data can be stored and processed very quickly.
(c) Repetitiveness: The more repetitive the task, the more profitable it is to automate it.
(d) Complexity: Problems with several interacting variables can be solved quickly and

accurately.
(e) Accurate Output: As high accuracy can be obtained as needed; also accuracy is not

affected by boredom and fatigue and is not Subjective. '
(f) Declining Costs: There has been a steady decline in the cost of per unit of data

processed.

1.8 FACILITIES AVAILABLE IN COMPUTERISED
SYSTEM

For Data Capture

Data capture is the identification of new data to be input. It is always best to capture the
data as soon as possible after it is originated.

Def in i t ions

Dynamic RAM (DRAM): The information stored in Dynamic RAM has to be refreshed after
every few milliseconds, otherwise it is erased. DRAM has higher storage capacity and is cheaper
than Static RAM.

Static RAM (SRAM): The information stored in Static RAM need not be refreshed, but it
remains stable as long as power supply is provided. SRAM is costlier but has higher speed than
DRAM.
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The commonly used input device is a keyboard. Mouse, joy stick, light pen, touch screen,
and trackballs are some of the devices which do not require typing of input information.

On-line Mode

Following devices are used to capture data on-line.

Keyboard
A computer keyboard is a sophisticated electromechanical component designed to
create special standardized electronic codes when a key is pressed.
The codes are transmitted along the cable that connects the keyboard to the computer
system unit or terminal, where the incoming code is analyzed and converted into the
appropriate computer usable code.

Light Pen
It is a pointing device, used to select a displayed menu option on the CRT. Light pens
are frequently used by graphics designers, illustrators, and drafting engineers.
It is capable of sensing a position on the CRT screen when its tip touches the screen.
A user can draw directly on the CRT screen with the light pen if the computer system
is provided with Computer Aided Design (CAD) package such as AutoCad 14.

Mouse
A mouse is also a pointing device.
As the mouse is rolled across the desktop, the cursor moves across the screen.
The user can select menu or command by pushing a button on the mouse once or
twice.

Scanners

Scanners are a kind of input device. They are capable of entering information directly into
the computer.

The main advantage of direct entry of information is that users do not have to key in the
information.

This provides faster and more accurate data entry.

Important types of scanners are:

(i) Optical scanners

(ii) Magnetic ink character readers

Optical Scanners

The following are the commonly used optical scanners:

Optical Character Readers (OCR)

Optical .Mark Readers (OMR)

Optical Bar-Code Readers

Terminals

Terminals can be "dumb", "smart", or "intelligent", and are used mainly by those who do
their work on mini or mainframe computers (or supercomputers).

A variety of computer terminals are used to enter data, including the following popular
types:

Point-of-Sale (POS) terminals
Financial transaction terminals
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Portable terminals
Microcomputers used as terminals

Smart Cards

It contains a build-in microcomputer chip.

In case of smart cards, there are less chances of fraud.

How much cash a customer has to his credit is stored in the chip before it is issued to
him.

When the customer uses the card to make purchases, the required amount is deducted
from the balance by a special electronic machine used by merchants.

The electronic machine used by merchants communicates with the card issuing
company's computer from time to time for money transactions. Thus, a card holder has
the facility of keeping electronic money with him.

When his electronic money is used up, he can replenish electronic money by depositing
money at automated banking machine of card-issuing company.

A record of purchases made by the customer can also be stored in a smart card.

Off-line Mode

Off-line data entry involves devices through which data are recorded on some media and
then into the computer later.

In almost 90% of the applications, data entry is done off-line. This saves the precious
computer processing time.

The following devices are used to capture data off-line.

Key-to-tape

A Key-to-tape device, also known as magnetic tape encoder, is designed to record keyed
data directly onto magnetic tape.

Key-to-floppy

These data entry machines are used to store data directly on flexible disks, called diskettes
or floppies.

Key-to-disk

Used as data recording stations in systems where data from different points has to be
recorded for processing at one point.

For Data Validation

The accuracy of input data should either be verified manually or by a computer program.
Some of the techniques used for this purpose are described below:

Using Control Totals

In this technique, the verification program verifies the total.

When business transaction occurs, it is noted down and calculated at the point of transaction
(by clerk) and the same transaction data is entered by the computer operator in the computer
system.

The data entered by the operator are totalled by the computer. If the two entries do not
match, then it is a clear indication that there is a mistake.
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In this manner only correct data will be passed to the machine before processing is done.

Using Built-in Checks by the Computer Program

There should be some control to make sure that no data are entered which is beyond a
certain value.

For example, the salary cheques for a particular organization may not exceed Rs. 20,000.
If so, then if a cheque is made for an amount more than Rs. 20,000, then computer will point
an error.

For Storage and Retrieval
Once the valid data has been entered in the system, it is essential that this data is stored
securely for future use.
Major types of external storage devices used in computerised systems are:

Magnetic tapes or cartridge
Hard disks
Floppy disks
Compact Disk (CD)

For Output
There are two basic categories of computer-produced output:

Output for immediate use by people, and
Output that is stored in computer-usable form for later use by the computer. Output
can be in either hardcopy or softcopy form.

(a) Hardcopy Output Devices
The commonly used hardcopy output devices are:
(i) Printers
(ii) Plotter
(iii) Microfilm/microfiche

Printers
These are the most popular commonly used output devices.

Capable of printing characters, symbols, and sometimes graphics on paper.
Printers are categorized according to whether the image produced is formed by physical
contact (impact printers) or not (non-impact printers) of the print mechanism with the
paper.

Plotters
A plotter is a specialized output device designed to produce high-quality graphics in
a variety of colors.
There are two basic types of plotters: those that use pens and those that do not.
Drum plotters and flatbed plotters both uses pens. Electrostatic plotters do not.

Microfilm and Microfiche
In this technique the output from the computer is recorded on a microfilm as microscopic
film images. The information recorded on the microfilm can be read with the help of a
microfilm reader.
A microfiche (pronounced as fish, French word, which means card) is a 4 x 6 inch film
sheet.
It can store up to 270 pages of information.
It is easier to read a microfiche as compared to a microfilm.

(b) Softcopy Output Devices

Cathode Ray Tube (CRT)

Probably, the most popular softcopy output device.
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microcomputer system.
The CRT's screen display is made up of small picture elements, called pixels for short.
The smaller the pixels, the better the image clarity, or resolution.

Voice Output Systems
Relatively new and can be used in some situations where traditional display screen
softcopy output is inappropriate.
Two different approaches to voice output have evolved, speech coding and speech
synthesis.
Used in applications such as automobiles, toys, and games.

For Transmission
The most exciting developments in data processing today is data communication.

Communications, the transfer of information is the basis of office automation.

Some examples of everyday data communication are:

Airline Reservation

Computer is usually located far from the agent; data communication must be used to relay
data from the terminal to the computer and back.

Automated Banking

ATMs are now widely used in most banks for better customer services. The user can make
deposits and withdrawals, check balances, and even pay utility bills through the machines.

Point-of-Sale Terminals

Used in retail stores, instead of cash registers. These terminals send records of sales to a
central computer, which maintains accounting and inventory records.

Data communication takes on several forms. These are given below:
(a) Data can be transferred between two geographically distant personal computers by

using modems, the dial-up telephone system, and a communications program in each
computer.

(b) Data can be transferred between two side-by-side computers by hooking up a cable
from one computer's serial port to the other computer's serial port.

(c) PC can act like a remote terminal to a mini or mainframe computer.
(d) PC can be part of a local area network, in which software and hardware resources can

be shared among many user.

Student Activity 4
1. What are the characteristics of computer?
2. What do you mean by data capture?
3. List some commonly used input devices.
4. Define scanners.
5. Define smart cards.
6. Define plotters.
7. What are softcopy output devices? Give examples.
8. Define printers.
9. How are computers useful for Airline Reservation and Automated Banking?

1.9 INDIAN COMPUTING ENVIRONMENT

Office work includes many administrative and management activities. The preparation,
distribution, processing and review of documents are the common activities of an
organization. Prior to the advent-of computers, these office activities were either performed
manually or with the help of mechanical and electrical machines. During the past few decades,
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the basic nature of office has changed remarkably. Office automation deals in application of
latest technologies in improving the overall proficiency of the office. We may define office
automation as follows:

Office automation does not mean just to install computers and communication devices in an
office, but it is much more than that. We will discuss in later part of this unit, how an office
can be automated in a real sense.

1.10 OFFICE AUTOMATION

Needs for Office Automation

Although all the work of a small or big office can be performed manually, but it is very
difficult or even impossible today for an organization to compete in the market without
office automation. There are many essential requirements of today's office environment,
which are listed below:

To reduce cost of administrative overhead;
To increase the efficiency of office tasks;
To provide better service to the customers;
To provide accurate information to the management;
To provide best and fastest way of communication.

The above requirements cannot be achieved without using latest technologies and therefore,
office automation is needed for an organization.

Office Functions Needed to be Automated
Many types of functions are performed in an office. The basic functions, which are needed
to be automated in any office are
1. Document Generation: In all offices, many documents are needed to be prepared,

typed and printed. Typewriters, computers and printers are widely used in automating
this routine task of offices.

2. Document Processing: Documents are also needed to be processed in order to extract
useful information required for MIS and other official purposes. Many office automation
tools like word processing, desktop publishing etc. are used to perform this task.

3. Document Distribution: All offices require an electronic distribution system for
transferring documents and data within and outside the organization. The main office
automation tools for distribution of documents are Photocopiers, Teletax and Fax
machines.

4. Archival Storage: The office documents are also needed to be stored for a long
period, so that they can be retrieved when required. This task is achieved  by the use
of different storage devices like tapes, disks etc.

Office Automation Systems
For achieving the basic functions of an office, different types of office automation systems
are used. These systems can be broadly classified into following four types:
1. Document Management Systems: These systems include computerised tools for

generation, storage, processing and distribution of documents.
2. Communication Systems: These systems are used for sending messages, documents

and data within and outside the organization.
3. Teleconferencing Systems: An electronic means of communication for conducting

seminars and training programmes in an organization is achieved through various
teleconferencing systems.

Def in i t ion

Office automation is the application of computer and related technologies like communication
and networking to integrate the general office tasks so that the efficiency of office work is
improved.
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systems for managing the activities of work groups are also used in some offices.

1.11 COMPONENTS OF A COMPUTER SYSTEM
Computer components can be broadly divided into two categories - Hardware and Software.
Hardware refers to any physical component of a computer. For example, CPU, Monitor,
Keyboard, Hard Disk, Floppy Disk etc. are physical components and thus, are hardware.
Software refers to the programmes which are required to operate the computer. For example,
DOS (Disk Operating System), BASIC, COBOL, dBASE, An Accounting Software etc. are all
software. An analogy of hardware can be the book which you are reading and then software
would be the text written on this book. Another analogy could be - 'brain' is a hardware but
'memory stored in brain' is a software.

Both hardware and software are dependent on each other. CPU, Memory Unit, Hard Disk
etc. are useless until they are provided instructions and data for storage and processing.
Similarly, BASIC or COBOL language has no use until it is stored and processed by hardware
components of computer.

1.12 HARDWARE COMPONENTS OF MICRO COMPUTER
In today's computer industry, a wide variety of hardware components are available for
microcomputers. Managers must be aware of the working and uses of different hardware
components, so that they can make good decisions about purchase of computer systems.
The hardware components of microcomputer can be classified into following types:
(A) Motherboard
(B) Input Devices
(C) Output Devices
(D) Storage Devices
(E) Cards
(F) Ports and Cords
(G) Power Supply

All these hardware devices except motherboard are called peripheral devices, as they are
connected to the motherboard.

Motherboard

Motherboard, also called as System Board, is the most important hardware component of a
microcomputer. Motherboard is so called as all the other boards (printed circuit boards
having chips or other electronic components) of the computer are connected to this board,
hence it is like mother of all other boards.

Notes

Components of Motherboard

A motherboard contains the CPU chip, Memory chip (ROM and RAM chips), I/O interface,
expansion slots and many other logic circuits. It may also contain a maths co-processor chip. CPU
or processor chip is the main component of motherboard. The types of CPU chip (8088/80286/
80386/80486 etc.) vary from one model of PC to another. The function of maths coprocessor
chip (8088/80287 etc.) is to support the CPU chip in processing of mathematical calculations.
Memory chips are physically installed on the motherboard by different packing methods. There
are three different types of packing of RAM chips DIP, SIMM and SIPP. DIP (Dual Inline Package)
is the most common packing, having a small rectangle box with leads on both sides. SIMM (Single
Inline Memory Module) packing contains a number of chips soldered on an expansion board
having an edge connector. SIPP (Single Inline Pin Package) is similar to SIMM, but uses pin rather
than an edge connector. Expansion slots are connectors on motherboard where expansion cards
like display card, hard disk controller card etc. can be connected. I/O interface is the channel
between the CPU and a peripheral devices (keyboard, monitor etc.).
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Input Devices
Input devices are used to input data, information and instructions into the RAM, The
common input devices of a PC are described below and shown in Figure 1.4.

Keyboard: Keyboard (similar to a typewriter) is the main input device of computer. It contains
3 types of keys - alphanumeric keys, special keys and function keys. When a key is pressed,
an electronic signal is produced. This signal is detected by a keyboard encoder that sends
a binary code corresponding to the key pressed to the Cpu. There are many types of
keyboards but 101 Keys Keyboard is the most popular one.

Mouse: Mouse (similar to a mouse) is another important input device. It is a pointing device used to
move cursor, draw sketches/diagrams, selecting a text/object/menu item etc. on monitor screen while
working on windows (graphics based operating environment of computer). Mouse is a small, palm
size box containing 3 buttons and a ball underneath, which senses the movement of the mouse and
sends the corresponding signals to CPU on pressing the buttons.

Trackball: A trackball looks like a mouse, as the roller is on the top with selection buttons
on the side. It is again a pointing device used to move the cursor and works like a mouse.

Light Pen: Light pen (similar to a pen) is a pointing device which is used to select a displayed
menu item or draw pictures on the monitor screen. It consists of a photocell and an optical
system placed in a small tube. When its tip is moved over the monitor screen and pen button
is pressed, its photocell sensing element detects the screen location and sends the
corresponding signal to the CPU.

Touch Screen: Touch screen is sensitive to human fingers. Using this device, the user can
point to a selection on the screen instead of pressing keys.

Joystick: Joystick is also a pointing device which is used to move cursor position on a monitor
screen. It is mainly used in Computer Aided Designing (CAD) and playing computer games.

Figure 1.4: Common Input Devices of a PC

Mouse
A 101 keys keyboard
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process called digitising. Digitising is a process by which graphic representations are
converted into digital data. The user makes contact with the flat digitiser tablet with a pen-
like stylus. As the stylus is connected to the tablet by a wire, the traced image is stored in
RAM and displayed on monitor.

Scanner: Scanner is mainly used in Desktop Publishing (DTP) applications. Scanner is
used for digitising images such as photographs, forms, documents etc. into computer memory.
Some scanners can also read text by converting them to digital code. These scanners are
very useful for converting the typed pages into word-processing files. Graphics scanners
convert a printed image into video image without converting it to digital code.

Optical Mark Reader (OMR): It is a special type of optical scanner used to recognize the
type of mark made by pen or pencil. It is used where one out of a few alternatives is to be
selected and marked. It is specially used for checking the answer sheets of examination
having multiple choice questions.

Optical Character Reader (OCR): It is also an optical scanner, which is capable of detecting
alphanumeric characters typed or printed on paper using an OCR font. OCR devices are
used for large volume applications like reading of passenger tickets, computer printed bills
of credit card companies and reading of ZIP codes in postal services.

Bar Code Reader: This device is an optical scanner used for reading bar-coded data (data in
form of light and dark lines). Bar-coded data is generally used in labelling goods, numbering
the books or encoding ID or A/c numbers.

Magnetic Ink Character Recognition (MICR): MICR is used to recognize the magnetically-
charged characters, mainly found on bank cheques. MICR is used by the banking industry
for the processing of cheques. A special equipment is used to encode, decode and process
the cheques.

Voice-Input Devices: These devices can recognize the human voice. They seem to be very
useful but are not popular due to storage of limited vocabularies and variations in way of
pronouncing words by different persons.

Student Activity 5

1. What do you mean by office automation?
2. List various office functions needed to be automated.
3. Describe Teleconferencing Systems.
4. Define hardware and software.
5. Define : (a) Motherboard (b) Input device (c) Output device.
6. Describe any five input devices.
7. What is a Digitiser?
8. Define OMR and OCR.

Output Devices

Output devices are hardware components which are used to display or print the processed
information. The common output devices are described below and shown in Figure 1.5.

Monitor: Visual Display Unit (VDU), commonly called as monitor is the main output device
of computer. It consists of a Cathode Ray Tube (CRT), which displays characters as an
output. It forms images from tiny dots, called pixels, that are arranged in a rectangular form.
The sharpness of the image (screen resolution) depends upon the number of the pixels.

Types of Monitors: There are different kinds of monitors depending upon the number of
pixels. Depending upon the resolution, monitors can be classified as follows:

(a) CGA (Color Graphics Adapter) .

(b) MDA (Monochrome Display Adapter).
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(c) HGA (Hercules Graphics Adapter)

(d) EGA (Enhanced Graphics Adapter)

(e) VGA (Video Graphics Adapter)

(f) SVGA (Super VGA)

Figure 1.5: Common Output Devices of a PC

Depending upon color of display, monitors can be classified as Monochrome (with single
color black/white display) and Color (with all colors display) Monitors.

Printer: Printer is the most important output device, which is used to print information on
papers. Printers are essential for getting output of any computer based application.

Types of Printers: There are many types of printers which are classified on various criteria
as illustrated in Figure 1.5 Printers can be broadly categorized into two types.

 Passbook Printer

 Dot Matrix Printer

 Portable Inkjet Printer
 Inkjet Printer

 Window Laser Printer

 Line Printer

 Laser Printer

 A3 Laser Printer

Drum Plotter

Pen

Controls

Drum

Paper

Flatbed

Flatbed Plotter

20" Color Monitor
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(a) Impact Printers: The printers that print the characters by striking against the ribbon
and onto the paper, are called Impact Printers. These printers are of two types

(i) Character Printers: These printers print one character at a time. These printers
are again of two types Daisy Wheel and Dot Matrix Printers. Daisy Wheel Printers
these printers print the characters by a mechanism that uses a plastic or metal hub
with spokes, called daisy wheel. The characters are embossed on the radiating
spokes and printed by striking these spokes against the ribbon and paper. Daisy
Wheel printers give a good quality but they are expensive than Dot Matrix printers.
Dot Matrix Printers these printers print the characters by putting dots onto the
paper. They do not give better printing quality than daisy wheel printers, but are
faster in speed. The printing speed of a dot matrix printer can be upto 360 cps
(characters per second). They are widely used with microcomputers in most of the
offices.

(ii) Line Printers: These printers print one line at a time. Their printing speed is
much more than character printers. They are again of two types Drum Printers and
Chain Printers. Drum Printers these printers print the line by a rotating drum
having a ring of characters for each print position. The hammers strike each
character of the drum simultaneously, so that entire line is printed for one full
rotation of the drum. These printers are also called as Barrel Printers. The printouts
obtained from these printers, have even character spacing but uneven line height.
Chain Printers these printers print the line by a rotating chain having ring characters
for each print position. Their printing mechanism is similar to drum printers. The
printouts obtained from these printers, have uneven character spacing but even
line height.

(b) Non-Impact Printers: The printers that print the characters without striking against
the ribbon and onto the paper, are called Non-Impact Printers. These printers print a
complete page at a time, therefore, also called as Page Printers. Page printers are of
three types

(i) Laser Printers: These printers look and work like photocopiers. They are based
on laser technology, which is the latest development in high speed and best
quality printing. In these printers, a laser beam is used to write the image on a
paper. First, the image is formed by electrically charged thousands of dots on a
paper by laser beam. Then, the paper is sprayed with a toner having the opposite

Figure 1.6: Classification of Printers
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charge and is passed over a heated roller to make the image permanent. Laser
printers are very popular and have become an essential part of Desk Top Publishing
(DTP). Although laser printers are costlier than dot matrix, they are generally
preferred in all offices due to their best quality of printing. There are many models
of laser printers depending upon the speed and number of dots printed. The latest
model of laser printer is 1200 DPI (Dots Per Inch), which can print 10 pages/
minute. Some high speed laser printers give a speed of upto 100 pages/minute.

(ii) Inkjet Printers: These printers print the characters by spraying the paper with
electrically charged ink. These printers give better quality than character printers
but not better than laser printers. They are cheaper than laser printers, hence
used widely in many offices. They also offer an option of using color cartridges
for multi-color printing.

(iii) Thermal Printers: These printers print the characters by melting a waxbased ink
off a ribbon onto a special heat sensitive paper. They give letter-quality printing
but are relatively expensive in maintenance than other printers.

Plotter: Plotter is an important output device, used to print high quality graphics and
drawings. Although the graphics can be printed on printers, the resolution of such printing
is limited on printers. Plotters are generally used for printing/drawing graphical images such
as charts, drawings, maps etc. of engineering and scientific applications. Some important
types of plotters are discussed below:
(i) Flatbed Plotters: These plotters print the graphical images by moving the pen on

stationary flat surface material. They produce very accurate drawings.
 (ii) Drum Plotters: These plotters print the graphical images by moving both the pen and

the drum having paper. They do not produce as accurate drawings as printed by flat
bed plotters.

(iii) Inkjet Plotters: These plotters use inkjets in place of pens. They are faster than
flatbed plotters and can print multi-colored large drawings.

Computer Output Microfilm: Computer Output Microfilm (COM) is a technique to produce
output on a microfilm media (microfilm reel or microfiche card) as illustrated in Figure 1.7. A
microfilm is a continuous film strip that can store several thousands miniaturized document
pages. A microfiche card is a 4 by 6 inch film sheet, which can store several hundred pages.

The process of producing microfilm or microfiche takes place on a special COM unit. The
information recorded on the microfilm is read with the help of a microfilm viewing system. It
is generally easier to read a microfiche than microfilm. Computer Output Microfilm is
particularly useful for organizations which need to store and manipulate large amount of
data. It helps them in tremendous savings in paper and document handling costs.

Student Activity 6
1. What are output devices? Give examples.
2. Write the full form of the following:

(a) CGA (b) MDA (c) HGA (d) EGA (e) VGA (f) SVGA
3. What is the difference between character printers and line printers?
4. Describe laser printer.
5. What are plotters? Describe its various types.

Figure 1.7: Computer Output/Microfilm
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Figure 1.8: Common Storage Devices

Storage Devices
In preceding part of this unit, we have discussed about the primary memory of computer. Primary
memory (especially RAM) stores the data, instructions and informations temporarily during processing
by CPU. When computer is switched off, this memory gets erased. How does a computer store the
data, information and software permanently, so that they can be retrieved whenever required? Certainly,
there must be some storage devices in computer. Now, we will discuss about different Storage
Devices, sometimes also called as Secondary Memory Devices.

There are many storage devices used with microcomputers. Some of the common storage
devices are explained below and shown in Figure 1.8.
(i) Winchester Disk (Hard Disk): Winchester Disk is the most common storage device

of present day microcomputers. It is popularly called as Hard Disk Drive (HDD) or
sometimes as Fixed Disk Drive. It is fixed inside the computer and is not easily
removable. It is used for storing the software and data inside computer. It is known as
'Winchester Disk', probably because this drive was first made by IBM at Hursley
Laboratory, located near Winchester in England.
Winchester Disk consists of one or more disk platters, an access mechanism and read/
write heads which are sealed in a case. Hard disk size depends upon the disk platter's
diameter. There are many different platter sizes (such as 51/2, 31/2 , 21/2 inch etc.). The
31/2 inch size platter is common with PCs and 21/2 inch with laptop/ portable computers.
Read/ write head is used to write any information on the disk surface or to read it back.
There are different types of hard disks depending upon their storage capacities. Storage
capacities of hard disks range from 10 MB to 6.3 GB, but 4.3 GB are nowadays a
common part of Pentium computers

(ii) Floppy Disk: Floppy Disk (FD) is another common storage device which is small,
flexible and easily removable. It is made of a plastic disk coated with magnetic material,
which is sealed inside a square plastic jacket. It is called as 'Floppy' because it is soft
having flexible physical property. Data can be written on or read from this floppy by a
drive, called Floppy Disk Drive (FDD), which is fixed inside the computer.

* DS stands for Double Sided, LD for Low Density and HD for High Density

Table 1.3: Comparison among Different Types of Floppies
Type of Floppy S i z e Dens i ty Sectors Tracks Storage Capacity

DSDD* 5.25 inch Double 9 40 360 K

DSLD* 3.5 inch Low 9 8 0 720K

DSHD* Big 5.25 inch High 15 80 1.2MB

DSHD Small 3.5 inch High 1 8 80 1 .44 MB

Floppy Disk Drives (3.5" & 5.25")
Hard Disk Drive

CD ROM Drive

Magneto Optical
(MO) Disk.

DVD RAM Disk
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There are many types of floppies depending upon their sizes and storage capacities as
illustrated in Table 1.3. The original floppy, developed by IBM, is an 8" floppy, but the
most popular sizes available for present day PCs are 51/4" and 31/2". The storage
capacity of floppies vary from 360 KB to 1.44 MB. The floppies can store data on both
sides (Double-sided Floppies) or on single side (Single-sided Floppies) depending
upon the floppy drive. Double sided floppy drives are most frequently used in present
day PCs. The latest floppy drive, that packs two high density floppy drives (5.25 & 3.5
inch) into a single package, is known as Combo Drive.

(iii) Compact Disk: Compact Disk (CD) is the latest storage device, used to store data,
information and software, which can be read only and not be changed or erased. It is
an optical read only memory, made up of a resin. Therefore, it is actually called as
Compact Disk Read Only Memory (CD-ROM). However, the information is stored on
CDs by using an expensive drive, called CD-ROM drive.
Nowadays compact disks are very popular storage devices for microcomputers because
a large number of software including multimedia, audio and graphics software are
available only on these disks. Compact Disks can store a large volume of data (upto
680 MB), which is almost same a storage capacity of 630 MB Hard Disk.
WORM (Write Once Read Many) is a type of compact disk which can be recorded
only once and not erased. It can store more data than CD-ROM, generally measured in
gigabytes.

(iv) Magnetic Tape: Magnetic tape is the oldest storage device available for
microcomputers. It is generally used to store a large volume of data that is needed to
be sequentially accessed and processed. The tape is made up of a plastic ribbon
coated with an iron-oxide material, which can be magnetized. The data stored on tape
can be read as well as erased and written again.
Magnetic tape is a sequential access storage device, hence it is not possible to read
the data randomly or directly. Therefore, magnetic tapes are suitable only for storing
data for backups and batch mode applications and not for on-line applications. On the
other hand, magnetic disks (floppy and hard disks), which are discussed above, are
considered best storage devices for on-line applications.

(v) Video Disk: Video disk is used to store text, video and audio data. It is widely used for
training applications as it can be played like a phonograph record.

(vi) Magneto Optical Drive: Magneto Optical (MO) drive is the latest of all storage devices.
This drive uses both a laser and an electromagnet to record data on a removable
cartridge. The surface of the cartridge contains tiny embedded magnets The unique
feature of MO drive is that it has a very high storage capacity. Although MO drive is
costlier and slower than HDD, it has a long life and is more reliable.

 (vii) DVD ROM/RAM Disk: DVD ROM and DVD RAM disks are optical disks having a
storage capacity of 4.7 GB and 5.2 GB respectively. These disks are becoming the next
generation's new standard for higher capacity removable media. They are ideal for
storage of huge amount of information required for multimedia applications. One can
put 133 minutes of high quality of video with digital sound on a DVD RAM Disk.

Cards
Cards are the printed circuit boards used to hold the chips (integrated circuits). There are
many types of cards used in PC, the important ones are Video Card, Sound Card, I/O Card,
Controller Card and Memory Card. Video card (Display Card) generates the text and graphic
images for monitor while sound card generates the sound. Pentium computers, generally,
use a PCI (Peripheral Component Interconnect) video card to speed up graphics. I/O Card
provides a place for connecting mouse and printer. Cables of hard disk and floppy disk are
connected to controller cards. Memory Card provides a place for memory chips.

Ports and Cords
Besides the important hardware discussed above, the computer has several components
which are used as pathway for flow of data. The rear of a PC has many empty holes or
external sockets called ports or connectors. There are many types of ports in a PC, the most
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connect a mouse, modem or scanner. Parallel Port is generally used to connect a printer.
Game Port is used to connect the joystick while Video Port is a connector for monitor.

Cords are the cables used to plug into the ports. There are different types of cables for
connecting different types of input, output and storage devices. The important cords used
in a PC are keyboard cords, power cords, monitor cords and printer cords.

Power Supply

Power supply is considered as the 'Heart' of a Pc. Computer requires a clean and steady
power source for working properly. Power supply is that important hardware, which provides
the power source to a computer. It provides a voltage range of 4.95 to 5.25 volts for the
highest performance of the system. Power supplies vary in size and power (in watt).

Student Activity 7

1. Define Winchester Disk.
2. Define floppy disk.
3. Define CD-ROM and WORM.
4. What is the function of magnetic tape?
5. What is magneto optical drive?
6. Define cards.

1.13 CLASSIFICATION OF SOFTWARE

Software are broadly classified into following two types:

(a) System Software

(b) Application Software

System Software

Software, which are required to control the working of hardware and aid in effective execution
of a general user's applications are called system software. These software perform a variety
of functions like file editing, storage management, resource accounting, I/O management,
database management, etc. Some of the examples of system software are DOS (Disk Operating
System), Windows, BASIC, COBOL and PC TOOLS. These software are developed by System
Programmers.

Types of System Software

System software can be further categorized into following three types:
(i) System Management Software

(Operating Systems, DBMS, Operating Environments)
(ii) System Development Software

(Language Translators, Application Generators, CASE Tools)
(iii) System Software Utilities

Application Software

Software which are required for general and special purpose applications like database
management, word processing, accounting etc. are called as application software. Some of
the examples of application software are dBASE, Word Star, Tally etc. Application software
are developed using system software by Application Programmers.

Notes: An Uninterrupted Power Supply (UPS) keeps the computer running for few minutes even
when the electricity supply goes off. UPS is not a part of computer and is purchased separately.
It is optional but mostly preferred to CVT (Constant Voltage Transformer) and is always
recommended for computerised applications like MIS.
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(i) General Purpose Application Software

(Database Management Packages, Word Processors, Spreadsheets, Office Automation
Packages)

(ii) Special Purpose Application Software

(Desktop Publishing, Multimedia, Business Applications)

1.14 GENERATION OF COMPUTERS

The computer evolved as a result of man's search for a fast and accurate calculating device.
Abacus was the first manual calculating device, which was invented in Asia many centuries
ago. In 1617, John Napier, a scottish mathematician invented a mechanical calculator called
the 'Napier's bones'. Thereafter, many kinds of computers have been designed and built
during the evolution of the modern digital computer. In order to provide a framework for the
growth of computer industry, the computer era has been referred in terms of generations.
Computers are classified into following six types based on their historical advancement and
electronic components used.

Zeroth Generation Computers

The zeroth generation of computers (1642-1946) was marked by the invention of mainly
mechanical computers. Pascaline was the first mechanical device, invented by Blaise Pascal,
a French mathematician in 1642. In 1822, Charles Babbage, an English mathematician, designed
a machine called Difference Engine to compute tables of numbers for naval navigation. Later
on, in the year 1834, Babbage attempted to build a digital computer, called Analytical Engine.
The analytical engine had all the parts of a modern computer, i.e.; it had four components
the store (memory unit), the mill (computation unit), the punched card reader (input unit)
and the punched/printed output (output unit). As all basic parts of modern computers were
thought out by Charles Babbage, he is known as Father of Computers. In later years, Herman
Hollerith invented a machine for doing counting for 1880 US census, which was called the
Tabulating Machine. In 1944, Howard A. Eiken invented first American general purpose
electro-mechanical computer, called Mark I and later on its successor, Mark II. The Zeroth
generation of computers or the era of mechanical computers ended in 1946 when vacuum
tubes were invented.

First Generation Computers

The first generation of computers (1946-1954) was marked by the use of vacuum tubes or
valves for their basic electronic component. Although these computers were faster than
earlier mechanical devices, they had many disadvantages. First of all, they were very large
in size. They consumed too much power and generated too much heat, when used for even
short duration of time. They were very unreliable and broke down frequently. They required
regular maintenance and their components had also to be assembled manually. The first
generation of computers became out-dated, when in 1954, the Philco Corporation developed
transistors that can be used in place of vacuum tubes.

Examples:

ENIAC (Electronic Numerical Integrator and Calculator) It was the first electronic
computer using vacuum tubes.                           - 1946

EDSAC (Electronic Delay Storage Automatic Calculator) It was the first stored-program
computer.                          -  1949

EDVAC (Electronic Discrete Variable Automatic Computer) It was successor of EDSAC.
            - 1951

IAS machine (Princeton's Institute of Advanced Studies) It was a new version of the
EDVAC, built by von Neumann.             - 1952
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basic parts the memory, the arithmetic logic unit, the program control unit, the input and the
output unit.

Second Generation Computers

The second generation of computers (1954-64) was marked by the use of transistors in place
of vacuum tubes. Transistors had a number of advantages over the vacuum tubes. As
transistors were made from pieces of silicon, they were more compact than vacuum tubes.
The second generation computers, therefore, were smaller in size and less heat generated
than first generation computers. Although they were slightly faster and more reliable than
earlier computers, they also had many disadvantages. They had limited storage capacity,
consumed more power and were also relatively slow in performance. Like first generation
computers, they also required regular maintenance and their components had also to be
assembled manually. Manual assembly of components was very expensive and later many
attempts were made to reduce such manual assembly. It was in 1964, when it was discovered
that a number of transistors could be sealed up into a tiny package, called an Integrated
Circuit (IC) or a Chip. Second generation computers became out-dated after the invention of
ICs.

Examples:

PDP-l, developed by DEC was the first minicomputer.

NCR 304 (National Cash Register), was first all-transistorized computer.

Third Generation Computers

The third generation of computers (1964-1980) was marked by the use of Integrated Circuits
(ICs) in place of transistors. ICs were more compact than transistors, as hundreds of transistors
could be put on a single small circuit. These computers removed many drawbacks of second
generation computers. The third generation computers were even smaller in size which
generated less heat and required very less power as compared to earlier two generation of
computers. These computers required less human labor at the assembly stage. Although,
third generation computers were faster and more reliable, they also had a few disadvantages.

They still had less storage capacity, relatively slower performance and thus could not fulfil
the requirements of the users and programmers. The third generation computers became
out-dated around the year 1978 when it was found that thousands of ICs could be integrated
onto a single chip, called LSI (Large Scale Integration).

Examples:

IBM 360, developed by IBM in 1964 was the first product line designed as a family.

PDP-8, developed by DEC in 1965 was the first mass-market minicomputer.

PDP-ll, developed by DEC in 1970 was the first highly successful minicomputer.

CRAY-l, developed by Cray in 1974 was the first supercomputer.

VAX, developed by DEC in 1978 was the first super minicomputer.

Fourth Generation Computers

The fourth generation of computers (1978-till date) was marked by use of Large Scale Integrated (LSI)
circuits in place of ICs. As thousands of ICs could be put onto a single circuit, so LSI circuits are still
more compact than ICs. In 1978, it was found that millions of components could be packed onto a
single circuit known as Very Large Scale Integration (VLSI). VLSI is the latest technology of computer
that led to the development of the popular Personal Computers (PCs), also called as Microcomputers.
All present day computers belong to the fourth generation of computers. These computers are very
powerful having a high memory and a fast processing speed. Today's PCs are even more powerful
than mainframe computers. Although fourth generation computers offer too many advantages to
users, the major drawback of these computers is that they have no intelligence on their own. Scientists
are now trying to remove this drawback by making computers which would have artificial intelligence.
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Examples:

IBM PC, developed in 1981 was the first industry standard personal computer, having
Intel 8088 memory chip.

IBM PC/AT, developed in 1982 was the first advanced technology PC, having Intel
80286 memory chip.

386, developed in 1985, had Intel 80386 memory chip.

CRAY-2, developed in 1985, was the fourth generation supercomputer.

486, developed in 1989, had Intel 80486 memory chip.

Pentium, developed in 1995, has pentium (80586) memory chip.

Fifth Generation Computers

The fifth generation computers (Tomorrow's computers) are still under research and
development stage. These computers would have artificial intelligence. They will use ULSI
(Ultra Large Scale Integration) chips in place of VLSI chips. One ULSI chip contains millions
of components on a single IC. The most important feature of fifth generation computers is
that they will use an intelligent software. This software will enable the user to tell computer
'What to do' and not 'How to do' by using intelligent programming and knowledge-based
problem solving techniques. So, the programmers or users would not be required to give
each and every instruction to the computer for solving a problem. These computers will also
have user interface in form of speech in natural languages.

Example:

Yet to develop but ROBOTS have few features of fifth generation computers.

Student Activity 8

1. What are system software? Give example.

2. What are application software? Give example.

3. What are first generation computers?

4. What are the limitations of third generation computers?

5. Describe fourth generation computers.

1.15 COMPUTER LANGUAGES

One man communicates with another in a language, which another man can understand.
Similarly, man communicates with computer in a language, which machine can understand.
This language which consists of a set of commands, understandable by computer directly
or after translating, is known as Computer Programming Language. There are many types of
computer languages, which can be categorized into following four types

(a) Low-level Languages (First and Second Generation Languages);

(b) High-level Languages (Third Generation Languages);

(c) User-Friendly Languages (Fourth Generation Languages);

(d) Object Oriented Languages (Fifth Generation Languages).

(a) Low-level Languages: In early days of computers, only those languages were used
for programming, which could be directly executed on computer. Languages, which
computer can understand directly and are machine dependent, are called low-level
languages. For example, Machine Language and Assembly Language are two important
low-level languages. Machine language is the oldest and most difficult of all the
languages. It is also known as First Generation Language. In machine language, all the
instructions are given to computer in binary digits, and hence are directly understood
by the computer. On the other hand, assembly language is easier than machine
language, and is known as Second Generation Language. In assembly language,



33

Computer – An Introductioninstructions are given using mnemonic operation codes (such as ADD, MUL etc.)
instead of binary digits.

Low-level languages are used for development of system software. As they are not
used for applications development, managers or application programmers do not need
to learn these languages.

(b) High-level Languages: Development of applications using low level languages requires
a deep understanding of the hardware. In order to facilitate the programmers to write
programs without knowing the internal details of computer components, many
languages were developed. These languages use common English words and are
translated into low-level languages before processing by the computer. These
languages which computer cannot understand directly and are not machine dependent,
are called High-Level Languages (HLL). These languages are also known as Third
Generation Languages. Some of the common high-level languages are

(i) BASIC (Beginners All Purpose Symbolic Instruction Code);

(ii) COBOL (Common Business Oriented Language);

(iii) FORTRAN (Formula Translator);

(iv) PASCAL (Name of a Scientist);

(v) C (it does not stand for anything).

These languages were widely used for applications development, but most of them are
outdated nowadays due to popularization of 4GLs. The uses of different 3GLs are summarized
in Table 1.4.

(c) User-friendly Languages: Although high-level languages are simpler to codify than
low-level languages, they still require a lot of time to learn their programming syntax.
Hence, these languages are beyond the reach of many computer users (including MIS
professionals), who do not want expertise in programming. Therefore, a new category
of languages have been developed which are user-friendly, very easy to codify and
simplest to learn. These languages are called as User-friendly Languages and popularly
known as 4GLs (Fourth Generation Languages). Some of the common 4GLs are dBASE,
Foxbase, Foxpro, MS Access, Oracle, Sybase and Ingres. The uses of different 4GLs
are summarized in Table 1.5.

(d) Object-oriented Languages: We have discussed that the object-oriented programming
is the latest approach in programming. The languages which are based on Object-
Oriented Programming (OOP) approach, are called as Object Oriented Languages.
They may be classified into Fifth Generation Languages. Object Oriented Languages
are specially useful for development of GUI (Graphical User Interface) applications.
These languages also offer a unique feature of Reusable Code. Some of the popular
object-oriented languages are Smalltalk, C++ and Object COBOL, Object Pascal, Simula,
Eiffel, Java & Visual J++. C++ and Visual J++ are widely used nowadays for development
of windows-based applications. The uses of different object-oriented languages are
summarized in Table 1.6.

Table 1.4: Uses of 3GLs (Third Generation Languages)

Language U s e s

BASIC (Beginner's All Purpose Used for all purposes (Commercial, Scientific, Educational,
Graphics Symbolic etc.) by beginners.
Instruction Code)

COBOL (Common Business Mainly .used for development of commercial
Oriented Language) applications on all types Computers.

FORTRAN (Formula Translator) Used for development of scientific (mathematical) applications.

PASCAL (Name of a Scientist) Used for both commercial and scientific applications.

C (No full form) Very powerful language for development of both system
and application software.
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Table 1.5: Uses of 4GLs (Fourth Generation Languages)

Language Uses

dBASE Used for development of mainly single user DOS based database appliactions.

Foxbase Used for development of both single and multiuser DOS based database applications.

Foxpro Used for development of both DOS and Windows based database opplications.

Oracle Used for development of relational database applications on any operating environment.

Sybase Mainly used for development of on-line applications such as Decision Support Systems
and Transaction Processing.

Ingres Used for development of relational database applications of VAX/UNIX operating
System.

Table 1.6: Uses of Object Oriented Languages (Fifth Generation Languages)

Language Uses

Smalltalk Used for development of mainly graphical applications.

C++ Used for development of all types of object oriented applications.

Object COBOL Used for development of object oriented applications on mainframe computer.

Object PASCAL Used for general object oriented applications.

Simula Mainly used in research environment.

Eiffel Used for general object oriented applications.

Visual J++ Very popular for development of Windows based applications.

Notes: There are certain languages which support most of the features of object-oriented programming
except inheritance. These languages are not pure object-oriented languages and are known as object-
based languages. For example, Ada, a high level language designed for process control, is an object-based
language.

1.16 LANGUAGE TRANSLATORS

Regardless of the programming language used (except machine language), the symbolic
instructions have to be translated into a form, that can be executed by computer. The software,
which convert the codes of other languages into machine code, are collectively called as
Language Translators.

Types of Language Translators

Language Translators are categorized into three types

(a) Assemblers: Assemblers translate the assembly language code (source program) into
machine language code (object program). After assembling, a linker program is used
to convert the object program into an executable program. The Microsoft Assembler
Program (MASM) and Borland Turbo Assembler Program (TASM) are two popular
assemblers. Assemblers are used mainly in development of system software.

(b) Interpreters: Instructions of a high-level language are coded in many statements. At
the time of their execution, they are converted into machine code statement by
statement, by using system software, called Interpreters. For example, programs written
in BASIC language are executed by using BASIC A or GWBASIC interpreters. Programs
written in some fourth generation languages, like dBASE III plus are also executed
using dBASE interpreter. There are certain disadvantages of interpreters. As
instructions are translated and executed simultaneously using interpreters, they are
very slow for executing large programs. Hence, interpreters are not suitable for most
of applications development.
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Compilers do not translate and execute the instructions at the same Time. They translate
the entire program (source code) into machine code (object code). Using linker, the
object code is converted into executable code. Compilers are widely used in translating
codes of high level languages (e.g. COBOL, FORTRAN, PASCAL, Turbo/ Quick BASIC,
Turbo/ Microsoft C etc.) and fourth generation languages (dBASE IV, Foxpro etc.). As
compared to interpreters or assemblers, they are preferred in development of application
software.

Student Activity 9

1. Which language is understandable by computer?

2. What are high-level languages?

3. What are object-oriented languages?

4. What is the function of language translators?

5. Describe the following:

(a) Assembler (b) Interpreter (c) Compiler.

1.17 SUMMARY

A computer is an electronic device that can perform a variety of operations according to the
instructions given by the programmer/user and provides the desired information as an
output. Computers are fast, accurate, diligent, having high memory, but no intelligence.

Computer are classified as general purpose or special purpose computers according to the
purpose of their requirement. According to the technology used, computers are classified
as analog which are used for scientific and engineering application, digital which are
considered as general purpose computers or hybrid computers. Which incorporate the
technology of both analog and digital computers. According to their size, computer can be
classified as super computer, mainframe computer, minicomputer and micro computer.

The main components of computer are input/output units central processing unit and memory
unit. Input unit is used to enter data and instructions into a computer. CPU performs all the
processing of input data: Memory is used to store the data, instructions and information
before during and after the processing by ALU. Output unit makes available output to the
users.

CPU consists of ALU (Arithmetic Logic Unit) which is responsible for all arithmetic and
logical operations, CU (Control Unit) which controls the transfer of data and instructions
among other units of computer Registers, which are used to store data, instructions and
memory addresses when ALU performs arithmetic and logical operations, Buses which are
used to transfer data between registers and clock which measures and allocates a fixed time
slot for processing each and every micro operation.

Memory is the internal storage area, which holds the data and instructions during processing.
The three types of main memory or Internal memory are RAM (Random Access Memory),
ROM (Read Only Memory) and CMOS (Complementary Metal Oxide Semiconductor
Memory).

Computers are used in business for data capturing in on-line as well as off-line mode, for
storage and retrieval of information, for output and for transmission. Offices are needed to
be automated to reduce cost of administrative overhead and to increase efficiency of office
tasks and staff. The hardware components of microcomputer can be classified into
motherboard, Input devices, output devices, storage devices, cards, ports and cords and
power supply. Various Input devices are keyboard, mouse back ball, light pen, touch screen,
Joy stick, digitizer, Scanner, Optical Mark Reader (OMR), Optical Character Reader (OCR)
Bar Code Reader (BCR), Magnetic Ink Character Recognition (MICR) and voice input devices
various output devices include monitor printer plotter and computer output micro file. Storage
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devices include hard disk, floppy disk, compact disk, Magnetic tape, video disk, Magneto
optical drive, DVD ROM/RAM disk, etc.

Computer software as classified as system software which are required to control the working
of hardware, and software which are required for general and special purpose applications.

Computers are classified into six types based on their historical advancement and electronic
components used, from fourth generation to fifth generation computers. Computers languages
are categorized into four types, low level, high-lever, user friendly and object oriented
language.

Language translators are used to convert are codes of other languages into machine code.
Various categories of language translators include Assemblers, compilers and Interpreters.

1.18 KEYWORDS
ALU: Arithmetic Logic Unit of a computer which is used to perform arithmetic and
logic operations.

Assembler: A program which translates an assembly language program to its machine
language equivalent.

Assembly Language: A low-level language for programming a computer in which
mnemonics are used to code operations and alphanumeric symbols are used for
addresses.

Cache Memory: A small high speed memory which is used to temporarily store a
portion of a program or data from the main memory. The processor retrieves instructions
or data from the cache memory. Instruction and data caching speeds up computation.

Chain Printer: A printer in which the characters to be printed are embossed on a
chain or a band. The chain is fashioned as a loop and print heads are activated to print
specified characters.

Communication Channel: A medium through which (electric) signal are transmitted
and received.

Compiler: A system program to translate a high level language program to machine
language.

Computer: This is a machine which executes an algorithm stored in its memory to
process data fed to it and produces the required results.

Control Bus: A set of wires used to transmit signals to control the operation of
various units of a computer.

CPU: Central processing unit of a computer. It consists of circuits to perform arithmetic
and logic and also has circuits to control and co-ordinate the functioning of the
memory and I/O units of a computer.

Data Entry Unit: A system which a keyboard to enter data and a magnetic medium
such as a floppy disk to store the entered data.

Data  (Digital Audio Tape): User 4 mm wide magnetic tape in a cartridge to store
around 4 GB of data (1994).

Digital Channel: A communication medium through which information in binary
(digital) form is transmitted.

Disk  Memory: A back up or peripheral memory in which information is stored as
magnetized spots on the surface of disks coated with magnetic material. In hard disks
the disks are not flexible. In floppy disks the disks is a circular platter made of flexible
magnetic coated plastic sheet.

Floppy Disk: A circular magnetic disk made of flexible plastic sheet coated with magnetic
material.
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and now. They use large scale integrated circuits, semiconductor memories and powerful
high level languages and operating systems.
High Level Languages: Computer language in which each statement is translated into
many machine language statements.
I C: Integrated circuit. An electronic circuit fabricated on a single chip of silicon.
Input Unit: A part of a computer used to feed programs and data.
Joy Stick: A stick mounted on a spherical ball which moves in a socket. Used to more
the cursor on the screen of a display device.
Laptop: A portable computer which weighs around 2 kg and runs all PC applications.
It used a liquid crystal display and is usable by the person while traveling.
Light Pen: A pen shaped devices which has a lens assembly. It is pointed towards an
image displayed on a cathode ray screen. It picks up the right and determines the
position of the picture element picked up.
Machine Language: A language which users numeric codes to represent operations
and numeric addresses of operands. Each model of a computer has a unique machine
language.
Memory: An organized collection of cells used and programs in a computer.
Microcomputer: A computer which is fabricated using a microprocessor, and other
integrated circuits, namely, a ROM, RAM and I/O interface chips.
Output Unit: A unit of a computer used to print or display computed results.
Printer: An output unit to print the results of computation. Line printers print one full
line at a time using a character, chain or drum. Character printer print one character at
a time serially.
Processor: A unit of a computer which interprets instructions, executes them using
arithmetic and logic circuits and controls the operation of all the other units of the
computer (also known as CPU).
RAM: Random Access memory. A memory used as the main memory of a computer in
which the time to retrieve stored information is independent of the address where it is
stored.
ROM: Read only Memory. A memory in which information is permanently written. The
information can be read quickly but not change.
Second Generation Computer: Computer built during the period 1956-65 which used
transistors in CPU, magnetic core main memories and high level language FORTRAN
and COBOL for programming.
Software: Programs for a computer.
System Software: General programs written for a computer. These programs written
for a computer. These programs provide the environment to facilitate the writing of
application programs.
Third-generation Computer-Computer built between 1966 and 1975 which used
integrated circuits in CPU, high speed magnetic core main memories, powerful high
level languages and saw the advent of time sharing operating system.
VDU: A Video Display Unit. An I/O device which consists of a television tube for
presenting outputs and a keyboard for entering inputs.
Volatile Memory: A memory in which the information stored is lost unless energy is
continuously fed to it.

1.19 REVIEW QUESTIONS

Unsolved Questions
1. Fill in the blanks:

(a) Computers can be classified according to _________and________
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(b) _______computers incorporate the technology of both analog and digital
computers.

(c) CPU consists of ———, ———and ——.

(d) ——is volatile in nature.

(e) A plotter is a specialized output device designed to produce high-quality——.

(f) ———is also called as system board.

(g) Joystick is mainly used in ——and ——.

(h) ———printers print the characters without striking against the and onto the
paper.

(i) ———and ——are first program into machine code.

(j) ——translate the entire programs into machine code.

2. State: True or False:

(a) Mainframe computers are the biggest and the fastest computers.

(b) Registers are small high speed circuits used to store data, instructions and memory
addresses.

(c) CMOS memory is used to store the system configuration, data time and other
important data.

(d) Lightpen is rolled across the desktop to move the pointer on the screen.

(e) A microfiche is a 4x6 inch film sheet.

(f) Office automation deals in application of latest technologies in improving the
overall proficiency of the office.

(g) CPU is called the heart of the computer.

(h) OCR is used for reading bar codes.

(i) Laser printers look and work like photocopiers .

(j) High level languages are widely used for applications development.

Answers (Unsolved Questions)
1. (a) Purpose, technology used, size and capacity.  (b) Hybrid (c) ALU, CU, registers

(d) RAM (e) graphics (f) motherboard (g) CAD, playing computer games. (h) Non-
Impact (i) ENIAC, EDSAC (j) compiler.

2. (a) False (b) True (c) True, (d) False (e) True (f) True (g) False (h) False (i) True (j) True.

Detailed Questions
1. What is the difference between general purpose and special purpose computers?

2. What is the difference between analog and digital computers?

3. Classify computers on the basic of their technology.

4. What do you mean by the term diligence' respect to computers?

5. List some application areas of super computers.

6. What is the difference between minicomputer and microcomputer?

7. Write a short note on personal computer?

8. Describe the architectural of computer system.

9. State the basic units of computer. Name the submits that make up the CPU, and give
the function of each of the units.

10. What is the function of memory? What are its measuring units?

11. What are the major strengths and weaknesses of computer?
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13. What is the function of bus in CPU?

14. Define the following:

(i) PROM

(ii) EPROM

(iii) EEPROM

(iv) DRAM

(v) SRAM

15. What are optical scanners? Give example:

16. Name some devices used to capture data of line.

17. Differentiate between microfilm and Microfiche.

18. Define point-of-sale terminals.

19. Why do we need office automation?

20. Describe various types of office automation system.

21. List some basic hardware components of Micro computer.

22. What are various components of Mother board?

23. Define the following:

(i) Mouse

(ii) Joystick

(iii) Touch screen

(iv) Bar code

(v) MICR

24. What are voice input devices?

25. What are Monitors? Describe its various types.

26. What are printers? Describe its various types.

27. What is the difference between Impact and non-impact printers?

28. Describe computer output Microfilm.

29. What are storage devices? Give examples.

30. What is function of Video disc.

31. What are computer software? Describe its various types.

32. Name some general purpose application software.

33. What are characteristics of second generation computer?

34. Describe fifth generation computers?

35. What are computer language? Describe its various types.

36. What is the difference complier and Interpreter?

1.20 FURTHER READINGS

Peter C. Jurs, Computer Software Applications in Chemistry; Wiley-IEEE.

Manoj Kumar, M. Shamir Bhudookan, Information Technology for ‘O’ Level, Editions De
L’Ocean Indien.
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2
PC-SOFTWARE PACKAGES

L E A R N I N G  O B J E C T I V E S

After studying this unit, you should be able to understand:

Disk operating system, its internal and external commands.

Windows, its working and windows accessories.

MS-Word as a word processor.

MS-Access a data base management package.

MS-Excel as a spread sheet package.

U N I T  S T R U C T U R E
2.1 Introduction
2.2 Disk Operating System (DOS)
2.3 Windows
2.4 Word Processor
2.5 Starting Word 2000
2.6 Editing Documents in Word 2000
2.7 Formatting Documents
2.8 Clip Gallery
2.9 Page Setting
2.10 Application of a Word Processor in Corporate Sector
2.11 Database Management Packages
2.12 Starting Access 2000
2.13 Working with Tables
2.14 Working with Forms
2.15 Working with Reports
2.16 Spreadsheet Packages
2.17 Starting Excel 2000
2.18 Working with Documents
2.19 Data Entry and Editing
2.20 Types of Cell Entries
2.21 Commonly Used Functions
2.22 Absolute and Relative Cell Referencing
2.23 Number Format
2.24 Charting with Excel
2.25 Macros
2.26 Importing and Exporting Files
2.27 Printing a Workbook
2.28 Application of a Spreadsheet in Corporate Sector
2.29 Summary
2.30 Keywords
2.31 Review Questions
2.32 Further Readings

2.1 INTRODUCTION

In this unit, we are discussing all the important software concepts and providing you the latest
knowledge of all the software available in the market. Many types of software are available for
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software are becoming outdated and new software are coming in the market. So we must get aware
of the latest developments in the software industry.

Here, we discuss following software packages which are required for general and special purpose:

Disk Operating System

Windows

Word Processor

Database Management Packages

Spreadsheet Packages

2.2 DISK OPERATING SYSTEM (DOS)
An Operating System (OS) is an integrated set of specialized programs that is used to control and
manage the resources and overall operation of a computer system. It is a class of software, which
controls the execution of other programs.

DOS is the most commonly used operating system. The full form of DOS is Disk Operating
System. It is a single user operating system which means that only one application can be made
to run at one time. DOS provides a 'Platform' or an 'Environment' which lets the application
program to interact with CPU and I/O devices. Many application software requires DOS for
running. The common among these are word processors like Wordstar, Professional write;
spreadsheet programs like Lotus 123, VP Planner Plus; accounting software like Tally, EX, etc.
Each software package has a specific command to get itself running on DOS. For example, in order
to run the spreadsheet program, Lotus 123, you will have to enter 123 at the DOS prompt, DOS will
run Lotus 123 for you. On any application software shuts down, the control again has to come
back to DOS and the DOS prompt can be seen again on the screen. Now, DOS is ready to accept
more commands from you.

MS DOS (Microsoft Disk Operating System), a product of Microsoft Corporation of  USA, is the
most popular operating system for PCs. Another operating system available in the market is the
PC DOS, a product of IBM, which is almost similar to MS DOS. Whether you use MS DOS or PC
DOS, the basic commands of  DOS remains the same.

Loading DOS
The booting happens automatically when the computer is switched on, provided DOS is available
to it. DOS can be present on both hard disk as well as the floppy disk. So, when the system is
turned on, a search for DOS is done on floppy drive first. If it is not present on the floppy drive,
the DOS is searched for on the hard disk. Thus, for booting to happen, the DOS must be present
either on the floppy or on the hard disk. So, if DOS is not present on the hard disk, insert the
floppy carrying DOS software in the A drive before switching on the system. If the system boots
from floppy, the following prompt comes on the screen:

A:\>

where underscore character '- ' indicates the cursor (blinking mark) of the screen. However, if
booting has been done from the hard disk, then the following prompt will come:

C:\>

C:\> or A:\> is the DOS Prompt. Looking at DOS Prompt, you can easily make out the currently
active drive. If you want to switch yourself over to the another drive, then simply type its drive
letter after the prompt and hit the <Enter> key as shown below:

C:\>A: <Enter>

A:\>

Now again if you want to go back to the C drive, then type in C: and hit the <Enter> key.
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Files and Directories in DOS

File is a collection of related information. Any kind of text, data or program that is entered, is
stored in a file. Now, it is very essential to organize your files in an ordered manner. This makes file
search easier otherwise, it can really be a difficult and time consuming job to search for a particular
file out of the whole lot of files stored on the disk. An example of library can make the explanation
of the concept more clear. As you must have already observed, the books in a library are put in big
cabinets. Each cabinet is divided into many shelves and sub-shelves. Each shelve or sub-shelve
contains books on a particular subject. So, the required book on a particular subject can be found
out very easily without wasting much time and effort.

On similar grounds, all the files that are related to each other are clubbed at one place. This is
known as a Directory Structure or simply a Directory. A directory structure resembles an inverted
tree. The main directory becomes the Root directory. The directories and files become the branches
of this directory tree. Any number of files and directories can be added to it thus, making the tree
grow big downwards. Let us take an example:

Suppose we wish to store two kinds of files on our disk: ACCOUNT and EXPENSE. Further, we
wish to keep two more kinds of files (say CASHSALE and CREDSALE) under ACCOUNT sub-
directory. DOS can very much help you in organizing your files through directory structure which
is shown in Figure 2.1.

It is clear from the figure that:

1. On the top of the directory structure, there is a Root directory. This directory is always
present and is shown by \(backslash) for referencing. Any file or directory that is created is
always under the Root directory.

2. EXPENSE is the sub-directory of the Root Directory.

3. ACCOUNT is the parent directory of the directories CASHSALE and CREDSALE. It can
also be said that the CASHSALE and CREDSALE are the sub-directories of the ACCOUNT
directory. Thus, a directory under a directory is called a sub-directory.

It can be clearly seen that the files relating to a particular subject can be put under a directory. For
example, all the files relating to expenses can be put under EXPENSE sub-directory whereas all the
files relating to cash sales can be stored under the sub-directory CASHSALE.

Referencing Files

It's time to learn, as to how to locate a file? The directory structure shown in Figure 2.2 has two
sub-directories under the Root directory. The sub-directory EXPENSE has two files under it.

Figure 2.1: Example of Directory Structure
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DOS allows you to go from one directory to another by following a certain path. In the beginning,
the user is always resident in the Root directory. While travelling from one directory to another,
certain rules have to be followed. A user cannot go directly from ACCOUNT sub-directory to
EXPENSE sub-directory. To go from one sub-directory to another, you have to first go to its
parent directory or the Root directory. Thus, for going from ACCOUNT sub-directory to EXPENSE
subdirectory, you first have to go to Root directory. Similarly, for going from the file EAST.TXT to
WEST.TXT, you have to go to the EXPENSE sub-directory first. Thus, in other words, while
moving from one directory to another, you have to go to its parent directory first.

Now, in order to reach out to the file WEST.TXT the following path has to be followed:

C:\>Expense\ West.txt

1      3  4 5

   2

Here,

   1 is the drive name where the file is resident in;
   2 is the path which DOS takes to reach for a file;
   3 is the directory under the Root;
   4 is the primary name of the file that is to be accessed; and
   5 is the extension name of the same file.

The  backslash (\) has to be used for tracing out the path. The first backslash takes you to the
Root directory. The subsequent backslashes separate the directories, sub-directories and the
filename that are given in the whole path.

File Naming Conventions

There are certain rules that have to be followed while giving names to your files. A file name has
two parts Primary Name and Extension (Secondary Name). A dot (.) separates a primary name from
an extension. Let as see the two parts of the file named DRAGON.TXT.

DRAGON.TXT

   Primary         Extension
     Name

A primary name cannot have more than eight characters and an extension cannot have more than
three characters. A file name having only the primary name and no extension is absolutely valid
because it is optional to give an extension to a file name. An extension is generally given by the
language or software used. For example, if you are entering a BASIC or PASCAL program, its file
name would have extension BAS or PAS respectively. A file name can contain the following
characters:

1. An Alphabet (A-Z) or (a-z)

Figure 2.2: Referencing Files
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2. A number (0-9)

3. Special characters such as: $, #, &, @, !, %, (, ), -, { , }, " A, etc.

except *, ?, full stop (.) and space ( ).

It is a good practice to give meaningful names to your files. However, no two files can have exactly
the same name on the disk. Thus, a name given to a file on a disk has to be unique.

A look at a few valid and invalid file names:

VALID INVALID

MYHUNT MY BOOK.DOC

Dragon.Txt B.R. Arora

Uphill.up S?JAIN.BAS

VIJAYA EXCELBOOKS

Employee.Emp ANARAG.**

157.IN VICKY.MEHTA

The rules for naming a directory are the same as that of naming files.

Student Activity 1

1. What is an operating system?

2. Define MS-DOS.

3. What is booting?

4. What is a file and a directory?

5. Describe the file naming conventions in MS-Dos.

DOS Commands

DOS offers a variety of commands to perform various functions. With the help of DOS commands,
you can display the list of files and directories that are present on the disk, create new files and
directories, remove unwanted files and directories and much more. DOS commands can be entered
either in uppercase or lowercase letters. The format of a DOS command is called syntax. All DOS
commands begin with command name. When DOS carries out the instructions given by you, it is
called the execution of DOS command. Let us discuss some of the DOS commands in detail. (The
commands which you should issue, are written as bold letters throughout this unit).

Directory Commands of DOS

The directory commands help you to create new directories and remove existing ones. They also
allow you to travel from one directory to another. You can also view the listing of files and
directories that are present on the disk.

1. Displaying a List of Files on the Disk: DIR command

This particular DOS command helps you in displaying a list of files or directories that are present
on hard disk as well as floppy disk. Thus, to see the contents of your hard disk, issue the
following command:

C\>DIR <Enter>

The above command displays the primary name, extension and size of files in bytes. It also
displays the date and time when the file was created or modified last. If you wish to view the
contents of the floppy drive, then you first switch yourself to the floppy drive and then issue the
DIR command as shown below:

C\> A: <Enter>

A:\>DIR <Enter>
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of the sub-directory EXPENSE, then issue the following command:

C\>DIR \EXPENSE <Enter>

Let us assume that there is one more sub-directory by the name BUSINESS existing under EXPENSE.
To view the contents of this sub-directory, issue the following command:

C:\>DIR \EXPENSE\BUSINESS <Enter>

 If you have a large number of files on the disk, then on issuing, DIR command, the screen scrolls
up and only a few file names are shown. In such a case, issue the following command:

C:\>DIR/P <Enter>

The above command will show the contents of the disk pagewise or screenwise. Now, if you are
interested only in seeing the file names, then issue the following command:

C:\>DIR/W <Enter>

The above command shows the names of files and directories widthwise. So, in one line only five
names of files and directories are shown. The other details like the size of file, the date and time of
each file creation are not shown. The directories are shown in square ([]) brackets.

2. Making a Directory: MD Command

In the earlier part of this unit, we discussed that all the related files should be clubbed at one place,
called a directory or sub-directory. So, to club all the related files under one head, new directories
and sub-directories have to be created. Let us create a new sub-directory by the name INCOME
under the Root directory.

The following command can achieve this:

C:\>MD INCOME <Enter>

where MD stands for Make Directory. Further, let us create another sub-directory by the name
HOSPITAL under the sub-directory Income.

C:\>MD INCOME\HOSPITAL <Enter>

3. Removing a Directory: RD command

With time, certain directories grow old and are no more needed. It is better to delete such directories
because they can save us many precious bytes on the disk. So, let us delete the sub-directory
HOSPITAL with the following command:

C:\>RD INCOME\HOSPITAL <Enter>

where RD stands for Remove Directory

A directory or a sub-directory has to be essentially empty before removing it. For example, in
order to remove the sub-directory HOSPITAL, there should not be any directories and files under
it. So, you must first delete all the files and remove all the sub-directories present under the sub-
directory HOSPITAL before removing it. We will discuss the method for deleting files in subsequent
part of this unit.

4. Changing Directory: CD command

Let us again refer to the Figure 2.2. Suppose you are under the EXPENSE sub-directory and you
want to access the files or directories in the ACCOUNT sub-directory. This would involve the
changing of directory from EXPENSE to ACCOUNT. This will make the ACCOUNT directory
active. The task of changing directories can be accomplished with the help of CD command.
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Look at the following example:

C:\>CD ACCOUNT <Enter>

where CD stands for Change Directory

The above command will take you to the sub-directory ACCOUNT as shown by the following
prompt:

C: \ACCOUNT>

If you want to go to the sub-directory CASHSALE straight from the sub-directory EXPENSE,
issue the following command:

C:\>CD ACCOUNT\CASHSALE <Enter>

After the above command, the following prompt will come:
C:\ACCOUNT\CASHSALE>

The command for going to the root directory from the above prompt is:
C:\ACCOUNT\CASHSALE>CD\ <Enter>

But, the command for going to the parent or previous directory (whether it is root or sub-directory)
is:

C: \ACCOUNT\ CASHSALE>CD.. <Enter>

If you are in the sub-directory CASHSALE, the above command will take you to ACCOUNT sub-
directory as shown below:

C: \ACCOUNT>

File Commands of DOS

DOS offers a number of file commands for performing various operations on your file like copying,
deleting and renaming the files.

1. Copying Files: The COPY Command

At times, you may have to work on some other machine. So, this involves copying files from one
disk to another. Copying of files can happen from hard disk to floppy or vice-versa. Files can also
be copied onto the same disk with a different name. The COPY command helps us to accomplish
all these tasks.

The syntax of the copy command is:
COPY <Source drive>: (File spec 1) <Target drive>: (File spec 2)
Where
Source drive refers to the drive from where the file has to be copied. It can be

A, B or C.
'File Spec l' refers to the path from where the file that has to be copied.
'Target drive' refers to the drive where the file is going to be copied.
'File Spec 2' refers to the destination where the file is going to be copied.

(i) Copying a file to another drive under the same name: A file can have the same name if it is
stored on different disks. Thus, to copy a file by the name SCENE from hard disk to floppy
disk, issue the following command:
C: \> COPY C:SCENE A:SCENE <Enter>
As the file is copied from the active drive, then there is no need to specify the source drive
in the above command. On similar grounds, if the file name remains unchanged then there
is no need specify it after the target drive. Thus, the above command can also be given in
the following way:
C:\>COPY SCENE A: <Enter>

(ii) Copying a file to another disk under a different name: The name of the file can be changed
very easily while copying. The following command copies the file SCENE from the hard disk
onto floppy disk by the name SERENE.

C: \>COPY SCENE A:SERENE <Enter>
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name and stored on the same disk. Proceeding with the above example, let us save the file
SCENE with a new name, SERENE and copy it onto the same disk.

C:\>COPY SCENE SERENE <Enter>

Once this command is executed, we have the same file under two different names, stored on
the same disk.

(iv) Copying files from one directory to another: Suppose you have placed all your files under
the root directory. Now, at later point of time, you wish to club all the related files at one
place. This can be easily done. Create a directory and copy the required files from the root
directory to this newly created directory. DOS allows you to copy files from one directory
to another.

Let us assume that you have a file by the name NORTH.TXT in the root directory and you wish
to copy this file in the newly created Area sub-directory. The following command will do this:

C:\>COPY NORTH.TXT \AREA <Enter>

Similarly, you can copy files from any directory to any other directory. DOS only needs the
specification of full path from you. Let us copy a file OLD.TXT which exists under the sub-
directory DATA to the sub-directory INFO which is resident in the floppy disk.

C:\>COPY DATA \OLD.TXT A:\INFO <Enter>

2. Deleting Files: DEL Command

With time, certain files grow old which are no longer required. So, it is desirable to delete such files
because unwanted files occupy precious space on the disk. Suppose there is a file on the hard
disk by the name TRYPRG which is no longer required. The following command deletes this file:

C:\> DEL TRYPRG <Enter>

If the file SALE.PRG exists on the floppy disk, first you go to the A: prompt and then delete the file
as shown below:

C:\>A: <Enter>

A:\>DEL TRYPRG <Enter>

While deleting any file of a sub-directory, its full path should be given as illustrated in the
following example. Let us assume that the TRY.PRG file exists under a subdirectory MANAGE on
the hard disk. To delete this file-issue one of the following commands:

C:\>DEL C:\MANAGE\ TRYPRG <Enter>

OR

C:\>DEL MANAGE\TRYPRG <Enter>

You can also delete the IMT.PRG file by first changing to that sub-directory and then issuing the
DEL command as given below:

C:\>CD\MANAGE <Enter> C:\MANAGE>DEL TRY.PRG <Enter>

3.  Renaming Files: REN Command

DOS allows you to give new names to your files. Assume that there is a file by the name OLD.TXT
and now you wish to give a new name NEW.TXT to it. Carry out one of the following commands
to get your work done.

C:\>REN OLD.TXT NEW.TXT <Enter>

OR

C:\>REN DATA \OLD.TXT NEW.TXT <Enter>

The file OLD.TXT which resides under the sub-directory DATA now has a new name
NEW.TXT.
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Wildcards

Often you may need to do a similar kind of job on a number of files. If these files have something
in common, then we can save the effort of performing repetitive job. So, these files can be referred
collectively by using the wildcard facility provided by DOS. The use of wildcards in a DOS
command gives greater flexibility when using similar type of file names. DOS offers two wildcards
: ? and *. Each? can be replaced by exactly one character or none, if it is given at the end of the
filename. As and when the? wildcard is specified in the middle of a filename, it has to necessarily
match one character. The * wildcard can match eight or less characters in the primary name and
three or less characters in the extension part.

Let us take an example to make the concept of wildcards clear. Suppose the following files are
present onto your disk:

Old.Txt INCOME. pro Alpha Page.in
Go.Exe OLDl Dragon.Exe KOMAL
Expense.prg. OLD20.bas Over.prg Annual. doc
New. doc Zee.com Old.doc Paper. com

The following commands illustrate the concept of wildcards:

(i)  If you wish to see all the files that start with the letter 0 and any extension, then give the
following command:

C:\>DIR 0 *.* <Enter>

The above command will list the files OLD.TXT, OLDl, OVER.PRG, OLD20 and OLD.DOC

(ii) Now, let us copy all the files with any number of characters in the primary name and the
extension EXE with the following command.

C:\>COPY *.EXE A: <Enter>

The above command will copy the files GO.EXE and DRAGON.EXE onto the floppy disk.

(iii) To delete all the files beginning with OL, having two more characters in the primary name
and any extension, issue the following command.

C:\>DEL OL??* <Enter>

With this command, the files OLD.TXT, OLD.DOC and OLDl are going to be deleted because
these are the only files present on the disk which match the given wildcard pattern. The
above command will not delete the files OVER.PRG and OLD20, because the former does
not start with OL and the latter has 5 characters primary name.

(iv) Similarly, to copy all files starting with P and an extension comprising of two characters
ending with N issue the following command:

C:\>DEL P*.?N <Enter>

This will delete the file P AGE.IN because this is the only file matching the given wildcard
pattern.

(v) For copying all the files having primary name OLD and any extension from floppy to
EXPENSE sub-directory of hard disk, issue the following command:

A:\>COPY OLD.* C:\EXPENSE <Enter>

The above command will copy only two files OLD.DOC and OLD.TXT.

(vi) To copy all the files with primary name anything and no extension from EXPENSE sub-
directory of hard disk to floppy, issue the following command:

C:\>COPY \EXPENSE\*. A: <Enter>

The above command will copy .the files ALPHA, OLDl and KOMAL.

(vii) To delete all the files of floppy, issue the following command:

A:\>DEL *.* <Enter>
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screen:

     Are you Sure (Y /N)? _

Press 'Y' if you really want to delete all files otherwise press any key. Never try the above command
on root directory of hard disk, otherwise your most important DOS file COMMAND. COM will
also be deleted and thereafter you will not be able to boot the system from the hard disk. Therefore,
wildcards with DEL command should be used with great caution.

Student Activity 2

1. List some directory commands of DOS.

2. What is the difference between RD  and MD command?

3. What is the function of CD Command?

4. How will you copy files in Ms-Dos?

5. How will you rename a file in MS-Dos?

6. What is the advantage of wild cards?

Some More DOS Commands
You have already been introduced to the directory and file commands of-DOS. Now, let us make
ourselves familiar with other commonly used commands.

(A) Displaying and/or changing date: The DATE Command
DOS allows you to show as well as change the current date once you are on the DOS prompt.
Issue the following command to see or change the today's date:

C:\>DATE <Enter>

After issuing the above command the following screen appears:

Current date is Thu 11-12-

Enter new date (mm-dd-yy):_

So, key in the new date in 'month-date-year' format. However if you do not want to change this
date simply hit the <Enter> key. The current date will be taken as new date.

(B) Displaying and/or changing the current time: The TIME Command
The TIME command is used to display and change the current time.

C: \> TIME <Enter>

On issuing this command, the following screen appears:

Current time is 11:05:10:01

Enter new time:

Enter the new time in hours: minutes: seconds format. Hit the <Enter> key if you do not want to
change the time. The new time can also be specified along with TIME command.

(C) Clearing screen: The CLS Command
In order to clear the cluttered and clumsy screen, issue the CLS command. This will remove the
contents shown on your screen thus making it look neater and cleaner. The CLS command is
given in the following manner.

C:\>CLS <Enter>

(D) Creation 01 a new file: The COPY CON Command
Text Files can be created by COPY CON command. Look at the following example:

C:\>COPY CON HELLO.TXT <Enter>
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This command tells DOS to copy the information from the keyboard or Console and put it in the
file HELLO.TXT. On issuing the command the following screen appears:

C:\>COPY CON HELLO.TXT
_

You will find a blinking cursor in the second line. Enter the text and terminate : each line by
pressing <Enter> key as illustrated below:

My first DOS file. The name given to this file is Hello.Txt.<Enter>

It is very easy to create files in DOS. <Enter>

Once all the required text is entered, hit the <Ctrl+Z> keys together to mark the end of Text.
<Ctrl+Z> keys tell DOS that no more text is going to be entered now. Again hit the <Enter> key.

(E) Displaying contents of files: The TYPE Command

The contents of any file can be viewed very easily by giving the TYPE command followed by the
file name. Let us see the contents of file HELLO.TXT that we have just created by issuing the
following command.

C:\>TYPE HELLO.TXT <Enter>

You can also send the output of a file to the printer. The following command starts the printing job
provided the printer is on.

C:\>TYPE HELLO.TXT >PRN <Enter>

(F) Displaying a message on the screen: The ECHO Command

At times, you may require to display a text on the screen while executing a set of commands. The
ECHO command helps you to display a meaningful message on the screen. This command is
issued as illustrated below:

C:\>ECHO Please insert floppy in drive A: <Enter>

The ECHO command is a special DOS command used exclusively in batch files (the files containing
a set of DOS commands). There is one more form of ECHO command i.e., ECHO OFF as shown
below:

C:\>ECHO OFF <Enter>

The above command tells DOS not to display other commands in the batch file.

(G) Displaying the currently logged sub-directory: The PROMPT Command

Users always prefer to see the prompt for currently logged sub-directory. The PROMPT command
tells DOS to include the sub-directory, greater than (>) sign or any text as a part of the prompt. The
various forms of PROMPT command are discussed below:

(i) To display the path designation (e.g., \ACCOUNT\EXPENSE) and the greater than sign as
a DOS prompt, issue the following command:

C:\> PROMPT $p$g <Enter>

After giving the above command, if you are logged to EXPENSE sub-directory of ACCOUNT
sub-directory in the root directory, then the following prompt will come on the screen:

C: \ACCOUNT\EXPENSE>_

(ii) To display a text “1 Love India” along with path designation and greater than prompt, issue
the following command:
C:\>PROMPT  I Love India $p$g <Enter>
The above command will display the following prompt:
I Love India C: \>_
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command:

C:\>PROMPT <Enter>

The command will display the following prompt:

C >_

(H) Specifying a sub-directory PATH: The PATH Command

By this time, you must be familiar with the directory structure of DOS. Suppose your program (say
PRINCE.COM file) lies on the GAME sub-directory of the root directory and you want to execute
it from any other sub-directory (say WINDOWS). To execute PRINCE.COM file, first you will
have to make GAME as the currently active sub-directory and then issue the following command:

C:\GAME>PRINCE <Enter>

DOS provides a shortcut way to locate and run the above program from any other sub-directory
by specifying the path as illustrated below:

C:\ WINDOWS> PATH C:\GAME <Enter>

The above command tells DOS that GAME sub-directory is in the current search path of DOS.
DOS will first search the required program file in the currently logged drive and then GAME sub-
directory. Thus, the PRINCE.COM file can be executed directly from WINDOWS or any sub-
directory as shown below:

C:\WINDOWS>PRINCE <Enter>

The PATH command is generally used in batch files.

Student Activity 3
1. How will you set date and time of system in Ms-Dos?
2. What is the function of CLS command?
3. How will you create a new file in MS-Dos?
4. What is the function of Type command?
5. What is the function of path command?

Internal and External Commands

All DOS commands can be classified into two categories: Internal Commands and External
Commands.

Internal Commands

The commands which are a part of the main files of DOS (i.e., COMMAND. COM and two hidden
files) are known as Internal Commands. They are loaded in the RAM as soon as the computer is
switched on. The important internal commands are: DIR, COPY, DEL, REN, MD, CD, RD, TYPE,
COPY CON, DATE, TIME, CLS, ECHO, PROMPT and PATH. We have already discussed all these
commands quite in detail. These commands are very frequently used.

External Commands

External commands are those commands which are stored on disks as separate program files.
These files have the same primary name as the command name. The extension of these files is
either COM or EXE. So, at the time of execution of these commands, the corresponding program
file should be present in the DOS sub-directory of the harddisk and DOS sub-directory should
also be in the path search. The commonly used external commands are: FORMAT, DISKCOPY,
CHKDSK, XCOPY and LABEL. Let us learn about these commands.
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1. Making the disk usable: FORMAT Command

Before discussing the format command in detail, let us first see what is meant by the term 'Formatting'.
Generally when you purchase a diskette from the market, it is unformatted. It can be compared
with a notebook which has blank pages without any ruler lines. You would prefer to put lines,
write page numbers and categories the pages into equal parts so that an index can be made and
the required topic can be searched very easily. Similarly, DOS organizes the disk into concentric
circles which are called tracks. Tracks are further divided into triangular regions. Each such region
is called a sector. The organization of disk into tracks and sectors is called Formatting. The Figure
2.3 makes the formatting concept more clear.

FORMAT command is used for formatting a hard disk or floppy disk. As FORMAT is an external
command, a file by the name FORMAT. COM should be present on your disk. In order to format
the floppy disk, issue the following command:

C: \> FORMAT A: <Enter>

Once the above command is executed, the following message appears:

Insert new diskette in drive A:

and strike ENTER when ready

Insert a floppy disk in drive A and hit the <Enter> key. When the formatting of the disk is done,
the following message appears on the screen.

Enter Volume Label (upto 11 characters):_

Here, you can give a name to the disk for its easy identification. A label upto 11 characters can be
given to the disk after it is formatted. If you don't want that your disk should carry any label,
simply press <Enter> key. Now, the following  message will come:

Format Another (Y/N)?_

Now, if you want to format another disk, then hit 'Y' (for Yes) and insert that disk in the drive
otherwise type in 'N' (for No) or press any key to end the format program.

New disks should always be formatted for using them. But old disks can also be formatted.
Formatting will make the disk blank by erasing all its data. You may require to format an old disk
if it has bad sectors and is needed again for usage. However, the FORMAT command should be
used with extreme caution. Any disk whether hard disk or floppy disk will lose all data stored on
it once the formatting operation is done. Therefore, you should not try the FORMAT command
for formatting the hard disk. If you format the hard disk, all the contents stored on it are going to
be removed permanently and new tracks and sectors will be created.

FORMAT command also provides a method for making your disk bootable. The following command
is used for this purpose:

C:\>FORMAT A:/S <Enter>

With the help of above command, all the operating system files (COMMAND. COM and two
hidden files) are copied from the hard disk to the floppy disk. This floppy can now be used to load

Figure 2.3: Process of Formatting



53

PC-Software PackagesDOS in the computer's memory if you are unable to boot the system from the hard disk. The COPY
command cannot serve the above purpose because it cannot copy the two hidden files of DOS in
the boot sector.

2. Checking a disk: The CHKDSK Command

The command CHKDSK helps to check the status of the disk. After checking the disk, CHKDSK
displays several items of information. However to get executed, this command needs the program
file CHKDSK.COM. Let's check the status of the disk in drive A through the following command:

C:\>CHKDSK A: <Enter>

On successfully checking the disk, the following status is shown on the screen:

If no drive letter is specified with CHKDSK command, then the currently active drive is checked
for.

3. Giving volume label to disk: The LABEL Command

Although, you have seen that a volume label to the disk is given at the time of formatting the disk,
DOS also provides LABEL command to change, delete or give new label. This command needs a
program file LABEL.COM. Let us give a label to the floppy disk by the following command:

C:\>LABEL A: <Enter>

Once the above command is executed the following screen appears:

Volume label in drive A has no label

Volume label (11 characters, ENTER for none) _

So hit the <Enter>key if you want to delete the volume label without typing in anything. You can
also provide volume label directly with the following command.

C:\>LABEL A:MANOJ <Enter>

4.  Copying contents of one the floppy disk to another: The DISKCOPY Command

The DISKCOPY command helps you to copy all the contents of one disk onto the other in such
a way that both disks become identical. It copies the contents of the floppy disk present in source
drive onto the disk present in the destination drive. If you have a single drive on your computer,
then the same drive can act as source as well as the destination drive. The command to copy the
contents of one floppy onto the other is given here:

C:\>DISKCOPY A: A: <Enter>

When you issue the above command a screen like the one shown below appears:

Insert SOURCE diskette in Drive A

Press any key to continue
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At this point, insert the diskette whose contents are to be copied and then hit any key. Another
message appears on the screen as shown below:

Insert TARGET diskette in drive A

Press any key to continue

So, after this message appears, insert the diskette into which the files are to be copied. Thereafter,
press any key to continue the process. Once the process of copying is completed, the following
screen appears:

Copy Complete

Copy Another (Y/N)?_

Press the 'Y' (for Yes) key if you want to copy the contents of some other diskette. DOS will again
prompt you to enter the source diskette. However, if you want to stop the DISKCOPY process,
press 'N' (for No). DISKCOPY command first formats the target diskette if it is unformatted and
then copies files onto it. So, if any contents exist on the target diskette, they are all going to be
removed. The DISKCOPY command needs the program file DISKCOPY.COM for execution.

5. Copying files and directories: XCOPY Command

The XCOPY command is used to copy the files present in sub-directories. The command 'COPY
*.*' copies the files of the currently working directory and DISKCOPY command copies the entire
contents from one floppy to another. So, they are not helpful in copying files selectively. The
XCOPY command offers three special advantages:

a) It prompts you to specify the files that you want to copy.

b) It can also copy directories and other lower level directories.

c) It can be used to copy files from the hard disk to the floppy disk.

Now, let us explore the XCOPY command. If you wish that DOS should ask for your confirmation
for copying a file, then use the /P option along with the XCOPY command. Consider the following
example:

C:\>XCOPY C:ACCOUNT A:ACCOUNT /P <Enter>

If you want to copy the directories and lower level directories, then use the /S option alongwith
the XCOPY command. Look at ,the following example:

C:\>XCOPY C: ACCOUNT A:ACCOUNT /S <Enter>

This command will copy the directory and all the sub-directories onto the A disk. However, if the
/S option is not specified, then the XCOPY command works within the single directory. You can
also use /P and /S option simultaneously with the XCOPY command as shown below:

C:\>XCOPY C:ACCOUNT A:ACCOUNT /P/S <Enter>

The whole path can be specified with the XCOPY command. This command again needs the
program file XCOPY.EXE in order to get executed.

BATCH Files

Very often, you keep keying in the same sequence of commands to do a repetitive job. For
example, everyday, when you start your work on the computer, you first see the listing of files
present on the hard disk. Then, you copy all the files with extension EXE and TXT from the floppy
disk to hard disk. Thus, for achieving your task, you have to issue the following commands
everyday.

C:\>DIR/P <Enter>

C:\>COPY A: *.EXE C: <Enter>

C:\>COPY A: *.TXT C: <Enter>
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called a batch file. This file offers a great advantage. Any number of commands given in a batch
file can be executed by just giving a single command at the DOS prompt. DOS executes all these
commands one by one. All the batch files can have any primary name but the extension given to
these kinds of files is BAT. The method of creating a batch file is exactly similar to that of creating
any other file on DOS. Let us see it, through an example:

C: \>COPY CON MY. BAT <Enter>

DIR/P <Enter>

COPY A: *.EXE C: <Enter>

COPY A: *.TXT C: <Enter>

<CTRL+Z>  <Enter>

In the above example, a batch file by the name MY.BAT has been created. If you want to execute
this file, simplify type in the name of the file at the DOS prompt as shown below:

C:\>MY.BAT <Enter>

   or C:\>MY <Enter>

The commands given in this batch file are going to be executed one by one in the sequence
specified.

The AUTOEXEC. BAT File

The AUTOEXEC.BAT is an autoexecutable batch file. It is a special kind of a batch file. This file
is executed as soon as the operating system is loaded in the computer's memory. The
AUTOEXEC.BAT file is needed when you want it to be executed automatically each time the
system is switched on. Now, as soon as the computer is switched on, DOS searches for the
AUTOEXEC.BAT file in the Root directory of the bootable disk. If the system finds this file, then
all the commands given in it are executed one by one instantly without even asking for date and
time. The AUTOEXEC.BAT file is created like any other batch file. Look at the following example:

A:\>COPY CON AUTOEXEC.BAT <Enter>

ECHO OFF <Enter>

CLS <Enter>

ECHO My first Autoexec.bat file successfully executed <Enter>

PROMPT $P$G <Enter>

PATH C:\DOS;C:\ WINDOWS <Enter>

<CTRL+Z>  <Enter>

Enter the above commands on the root directory of bootable floppy disk. Reset your system. You
will notice the above created batch file being executed automatically.

Student Activity 4
1. What are Internal and external DOS commands?
2. What is the function of FORMAT commands?
3. What is the function of CHKDISK command?
4. What is the difference between DISKCOPY and XCOPY?
5. What are batch files?
6. Describe AUTOEXEC.BAT file.

2.3 WINDOWS
Windows is an another popular software. Windows 98, a product of Microsoft is the latest upgrade
of its earlier versions (Windows 3.0, 3.1, 3.11 and 95). It is a Graphical User Interface (GUI) which has
been designed to make your work more intuitive and easy. There is no more need of remembering the
exact syntax of commands to get your work done. Everything is provided in the form of pictures and
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graphics. Windows 98 is a full fledged operating system. The program files and other resources are
generally accessed with the help of mouse. The Windows 98 desktop acts as the primary media for
organizing your programs, files and resources.

Hardware Requirements

The minimum hardware configuration required to run Windows 98 is given below:
486 or Pentium CPU
At least 4 MB of RAM
10 MB to 40 MB of free disk space
SVGA monitor
Mouse
Keyboard

Features of Windows 98

We will briefly discuss some of the features of Windows 98:
1. It provides a graphical operating environment. All the programs and other resources are

provided in the form of Icons.
2. It is a full fledged operating system with an in-built copy of DOS. DOS programs can be

safely run on Windows 98.
3. It is a multi-threaded and preemptive multi-tasking operating system which means that

more than one application can be made to run simultaneously and more smoothly.
4. It supports long file names upto 255 characters, thus, breaking the DOS naming convention

where you can give primary file name upto 8 characters.
5. The plug and play feature of Windows 98 automatically adapts itself to the hardware it is

running on. It can detect hardware and then install all the proper drivers without taking any
help from you.

6. It gets you organize all your work on the desktop or in folders. You can safely click at any
folder to open it up.

7. It is more effective in cleaning up after crash of a faulty application. At any time, if a program
crashes, you can remove it safely from the tasklist without disturbing other running
application. The memory and other resources that the application was using are altogether
freed.

8. It contains a disk compression program which can essentially double your hard disk space,
thus, preventing you from buying a new hard disk.

The Windows 98 Desktop
So, as and when you switch on your computer, Windows 98 is loaded in the RAM and a desktop
appears on the screen as shown in Figure 2.4. This desktop contains folders, files, applications,
taskbar and shortcuts.
The objects labelled 'My Computer', 'My Briefcase' and 'Network Neighbourhood' are examples
of folders. A folder is similar to a directory in DOS. A folder can contain other folders and

Figure 2.4: The Windows Desktop
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shown graphically. Looking at the filename icon, you can easily make out the application to which
it is associated. In order to open a file within a folder, simply double-click it. It will open the file
with the correct application. Multiple objects can be selected by clicking at the object and then
holding down the <Ctrl> key on the keyboard and clicking on another object. You can select as
many files and folders as you want.

Now, to open the folder 'My Computer' just double-click it. All the resources on your computer are
shown in it as can be seen in Figure 2.5. Now, if you want to see the files and folders present on
your floppy disk, click the object 3 1/2 Floppy (A:) Icon.

The Taskbar

Taskbar is located at the bottom of the Windows 95 desktop. It contains a start button on the left
side. On the extreme right side, the taskbar shows the current time. The taskbar also shows all the
applications that are currently opened. You can switch between applications using the taskbar.
The Figure 2.6 shows that Paint and Aldus Pagemaker 5.0 are the applications that are currently
running, The button of the application that is running in the foreground appears depressed. The
button that appears raised tells us that the application is running in the background. However, if
you want to run any particular application in the foreground, then simply click at that button
appearing on the taskbar.

The Start Button

The Start Button is a new and much useful feature of Windows 95. Click on it once to display the
start menu. From the start menu many other menus can be seen. You can select any of the menu
option by taking your mouse pointer on that particular menu can be seen in Figure 2.7.

Figure  2.5: The ‘My Computer’ Window

Figure 2.6: The Taskbar

Figure 2.7: The Start Menu
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1.  The Program Menu

The program menu of Windows 95 as shown in Figure 2.8 is exactly similar to the program group
found in Windows 3.1. It contains program groups and individual programs. Thus, to launch any
program, simply take your mouse pointer at that particular program and click it. In order to open
'Accessories' program group, move the mouse pointer to that group and a cascading menu will
appear on the screen. It contains Windows 98 accessory programs such as WordPad, Paint,
Notepad, etc.

2. The Document Menu

This menu shows you the document that you recently opened or worked upon. This offers a
short way of opening a document. It launches the application in which the document was created.
The document menu keeps tracks of the latest fifteen documents that you have used and it puts
them in an alphabetical order.

3. The Setting Menu

This menu is used for changing the default system setting. You can fiddle with the control panel,
printer folder and taskbar setting from here.

4. The Find Command

The Find option of the start menu helps in locating a particular file or a folder. It offers a quick way
of finding a file. In the 'Named' box type in the file name you want to search. Accordingly,
Windows 98 will return you the full details about the file.

5. The Help Command

Windows 98 has got very smart help to offer. In case you find yourself stuck on any issue simply
select the Help option from the Start Menu. Above all, you can type in your query in your own
words. Windows 98 will display you the related information.

6. The Run Command

The Run option of the Start Menu helps you to run your file or application straightway. Simply
type in the full path and the filename in the 'Open' box and click at 'OK' button. You can also make
use of the 'Browse' button in order to locate appropriate files.

Figure 2.8: The Accessories Group
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This command is used for shutting down the system. It offers three options. You can shut down
your system, restart your system in windows mode itself or you can switch yourself to DOS mode
temporarily. Select appropriate option depending upon your requirement.

Student Activity 5

1. Why is windows called GUI based operating system?

2. What are the minimum hardware requirements to run windows 98?

3. What are the features of windows 98?

4. What is a desktop?

5. What is the taskbar? What does it hold?

Windows Explorer

The File Manager of Windows 3.x is replaced with Windows 95 explorer. It helps you to manage
and organize your files and folders. In order to start explorer click at the start menu. Select
Programs and then the Windows Explorer option. The 'Windows Explorer' windows comes up on
the screen as shown in Figure 2.9. This screen lets you to explore anything on your desktop. The
left part of the explorer screen shows the desktop at the highest level. All the components of the
desktop like 'My Computer' ,'Network Neighbourhood', 'Recycle Bin', etc., are shown under it. You
must have observed that some components of the desktop have a plus sign (+) before them. It
shows that there are deeper level of components under it. On clicking at the plus sign, the next
level of the hierarchy is shown.

Figure 2.9: The Windows Explorer

This layering of components continues as long as there is deeper level of folders or components
underneath. The right side of the Explorer Screen shows the contents of the folder or the
components that are selected in the left part of the explorer window. In the right part of window
only, the major actions are performed. Now, we will learn some of the important functions that are
performed frequently.

(A) Renaming a file or a folder

In order to rename a file or a folder, follow the steps given below:

1. Select the file or the folder that has to be renamed.

2. Right click the mouse button and select the Rename option.

3. Type in the new name that you wish to give to the file.

(B) Deleting a file or folder

A file or a folder can be safely deleted by following the steps given below:

1. Select the file or folder that has to be deleted.
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2. Hit the <Del> key or from the File menu, select the Delete option.

3. Windows 98 will confirm before deleting the file.

(C) Moving a file

Windows 98 allows you to move files from one place to another. A file can be moved from one
folder to another by simply performing the following drag and drop procedure:

1. Select the file that you want to move from the right pane.

2 Click the file or the folder on the left pane and drag it in the new destination.

(D) Copying a file to a floppy

In order to copy a file to the floppy disk, follow the steps mentioned below:

1. Select the file that has to be copied to the floppy disk.

2. Right click the mouse button and select the Send To option.

3. Select the floppy disk to which the file has to be copied.

(E) Creating a new folder

A new folder can be created by following the steps given below:

1. Select the parent folder that will contain the new folder.

2. From the File menu, select the New option. From the cascading menu, select the Folder
option.

3.  Windows 98 will ask you the name that has to be given to the new folder.

(F) Restoring from the Recycle Bin

In Windows 98, deleting a file is a two step process. Once the file is deleted, it is put in the 'Recycle
Bin'. The 'Recycle Bin' appears on the desktop. It is of immense use if you have accidently deleted
your files. The files once deleted can be restored from the 'Recycle Bin'. However, if the file is
deleted from the 'Recycle Bin' also, then you cannot in any case recover your file. So, the Recycle
Bin helps you to retrieve deleted files. In order to restore a file from the 'Recycle Bin', follow the
steps given below:

1. Double Click the 'Recycle Bin' icon available on the desktop. A dialog box opens up as
shown in Figure 2.10.

2. This window shows all the files that have been deleted. Select the file that you wish to
restore.

3. From the File menu, select Restore option.

Figure 2.10: The Recycle Bin
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If you wish to delete all the files from the Recycle Bin also, then follow the steps given below:

1. Double-click the 'Recycle Bin' icon on the desktop.

2. From the File menu, select the Empty Recycle Bin option.

3. Windows 98 will ask you to confirm before deleting all the files.

Windows 98 Accessories

Windows 98, like its predecessors, contains several built-in accessories which make your computer
easier and more convenient to use. In order to access Windows 98 accessories, click on the Start
button, move the mouse cursor to programs and then click at the Accessories option of the
cascading menu. We will learn a few of the commonly used built-in accessories of Windows 98.

(A) WordPad

Microsoft WordPad for Windows 98 is a very simple word processing program which allows you
to create, read and modify simple documents. It is more or less similar to Windows 3.x Notepad
program but contains more features and is capable of opening a wider variety of documents. It
contains basic file manipulation, editing, viewing and formatting tools that are essential for creating
simple documents. It contains standard menu items. The Wordpad can be seen in Figure 2.11.

(B) Microsoft Fax

The Microsoft Fax program of Windows 98 helps you to send and receive faxes. It can help you
to send the documents that have been created on your computer. You can also send documents
directly from compatible applications without ever leaving the application e.g., using Word for
Windows, you can use the File menu's Send command to direct the output of that application
directly to a fax telephone number rather than a printer.

(C) System Tools

Windows 98 contains a number of useful system tools to help you see and configure your
system. Let us briefly discuss a few system tools.

Backup: This program helps you to perform backups of your computer system.

Disk Difragmenter: This system tool reconfigures files on your hard disk so as to speed up disk
access times.

Scan Disk: This utility is more or less similar to the old DOS checkdisk utility. It scans your disk
and gives you the disk status by finding out the used, unused and bad sectors.

Figure 2.11 : The WordPad Application Window
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Drive Space: This utility is a disk compression program that can double up the space on a disk
drive. If you need some extra space on your disk, you can use this facility.

(D) Multimedia

Windows 98 contains utilities that can control your CD-ROM player and multimedia abilities. You
can use it to control various aspects of your multimedia system.

(E) Calculator

Windows 98 has a desktop calculator that can perform simple calculations. It contains both the
standard as well as the scientific calculator. The calculator has been shown in Figure 2.12.

(F) Paint

If you are a graphics lover, Windows 98 can fulfil your desire. It contains 'Paint' utility which can
create simple graphics. You can create, open, view and edit graphics files such as bitmaps, PC
Paintbrush files, etc. A typical Paint can be seen in Figure 2.13.

Figure 2.12: The Standard Calculator

Figure 2.13: The Paint Application Window
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1. What is the function of windows Explorer?

2. How will you rename a File or a folders?

3. How will you delete a file or folder?

4. How will you copy a file to a floppy in windows?

5. What is the function of Recycle bin?

6. How will you restore a file from recycle bin?

7. List some windows 98 accessories.

2.4 WORD PROCESSOR

Word processing includes typing in text and manipulating it so as to give a very systematic and
organized look to your document, which enables easy reading. The application software or program
which helps us in processing the text is called a 'Word Processing Software, or simply a 'Word
Processor'. So, you can say that a word processor is nothing but a computer program that helps
you to:

type your text

correct spelling mistakes and grammatical errors

align text within margins

offer a variety of font styles and font sizes

see a preview of the text that you have typed in.

Popular Word Processing Packages

The commonly used word processing packages are:

MS-WORD

Word Star

Word Perfect

Professional Write

Uses of Word Processing

Normally, a word processor can accomplish the following tasks:

Brochures

Newsletters

Reports

Advertisement

Resumes and Cover letters

Books

Directories

World Wide Web Pages

There is absolutely no end to what a word processor can do. By now you must have realized that
the word processing applications have become much more sophisticated than before.

2.5 STARTING WORD 2000

To startup Word in Windows 95 or Windows 98, do the following steps:

1. Click at the Start button which lies at the bottom left corner of the screen.
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Figure 2.14: Showing How to Start Word 2000

 2. Click at the 'Programs' option. A cascading menu appears on the screen.

3. Click at 'Office 2000' option. Again, a cascading menu appears. Select 'Microsoft Word'
option of the cascading menu. Word will be loaded in the computer's memory.

You will find that the above menu options are more or less similar to Figure 2.14.

The menu options shown in Figure 2.14 might not exactly resemble with those seen on your
computer. So, in that case you might need search where actually MS-Word is installed on your
computer.

Alternatively, you can start MS-Word in the steps given below:
1. Click at the START button.

2. Select 'New Office Document' as shown in Figure 2.15.

Figure 2.15: Alternative Method to Start Word 2000

This would bring up Word with a new document opened up for you. Your computer screen will
match closely to the Figure 2.16. This blank page is nothing but an empty file created automatically
by WORD. This file by default gets the name - Document l. The extension given to a Word
document is 'doc'.
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When Word opens up, you will notice two windows on the screen, one nested closely within the
other. The larger among these is called the Application Window, which frames the entire screen. The
smaller window is called the Document Window, which fits in the application window. Both these
windows serve a different purpose. The application window helps the user to communicate with the
Word program, whereas, the document window is used for creating as well as modifying the Word
documents. So, as you keep typing, the words displayed on the monitor or screen, are actually shown
in the document window. The different elements of the screen are shown in Figure 2.16. The different
elements of this screen are outlined in Table 2.1.

Figure 2.16: Screen Elements of Word

Table 2.1: Description of Screen Elements
Screen Element Description

Title Bar Located at the top of the screen; it displays the name of the application (here
'Microsoft Word') and the active document name (here 'Document l ').

Menu Bar It shows menu options of Word and is located under title bar.

Standard Located exactly below the menu bar and gives access to WORD's most
Toolbar frequently used commands and utilities.

Formatting Lies below the standard toolbar; it offers commonly used formatting
Toolbar commands.

Ruler Line Located below the formatting toolbar and provides ongoing page measurement
and quick access to margins, tabs and indents.

Status bar Located at the bottom of the screen; it displays important and varied
information about the currently opened document like page number, column
number, line number, etc.

View Buttons Located towards the left side of the horizontal scroll bars(above status bar);
they show the documents in different views like normal view, page layout view,
outline view etc.

Horizontal Help the user to move in the left or right side of the document.
Scroll Bars

Vertical  Help the user to go up or down in the same document.
Scroll Bars

Maximise Located in the upper right corner of the screen; it controls the size of the
Button application window.

Minimise Located in the upper right corner of the screen, towards left of maximise
Button button; it helps to mini mise the whole application and show it in the reduced

form on the taskbar.

Close Button Located in the upper right corner of the screen, towards right of maxi mise
button; it helps to shut down the opened application; it also allows the user to
save the opened files before quitting Word.

Text Area
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Contents of Menu Bar

All the menu pads located on the menu bar can be pulled down by clicking at them or by pressing
<Alt + key> where 'key' is the underlined character of the menu name. At one time only one menu
pad can be activated and pulled down. From the pull down list, any entry can be selected with the
help of mouse. In all the pull down menus, you would find that a few entries are shown in light
color. These entries are called 'ghosted' entries and are inaccessible, These ghosted entries
become solid only when the features they support become accessible. For example, the cut, copy,
paste entries become active from the 'Edit' menu only when some text is selected and is made
available on the clipboard. When the text is no more selected, these entries again become inactive.

Now, we will explore the contents of different menu pads briefly.

1. File: Pull down the 'File' menu by pressing either <Alt + F> keys together or by clicking it with
the help of mouse. This menu is used for performing file operations like creating a new file,
opening an existing file and then closing it. The 'Save' options help to save the files. The
'Properties' option gives information about the current document. The 'Page Setup' option
allows to set page size, margins and paper orientation etc. Document can be previewed with the
'Print Preview' option. The printing operations can be carried out using 'Print'. 'Exit' option
closes the Word application. At the bottom of 'File' menu, the names of all recently saved files
are displayed. The 'File' menu has been shown in Figure 2.17.

2. Edit: The 'Edit' menu helps you to delete, copy and move chunks of text. The 'Paste Special'
option helps you to link your text with other applications. 'Find' option tries to help you by
searching a particular word or phrase. In case you want to replace the selected word with
some other word or phrase, then use the 'Replace' option. The 'Edit' menu can be seen in
Figure 2.18.

Figure 2.17: The File Menu

Figure 2.18: The Edit Menu
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Outline, Page Layout, Master Document and Full Screen. Through the 'Toolbars' option,
you can also decide the toolbars that you want to see on your screen. 'Ruler' option turns
on or off the ruler line. Headers and footers are added to the document through 'Header and
Footer' option. You can see the 'View' menu in Figure 2.19.

4. Insert: The 'Insert' menu helps to insert page numbers, the current date and time, symbols,
footnotes, cross-references, tables, section-breaks, files, bookmarks, pictures, objects
including equations, databases and different varieties of captions. The 'Insert' menu has
been shown in Figure 2.20.

5. Format: The 'Format' menu is basically used for enhancing the look of the document. It can
make your document’s look beautiful by adding a variety of font types and sizes, paragraph
formats, tabs, borders and columns, drop caps, bulleted and numbered lists and style
settings. The 'Format' menu can be seen in Figure 2.21.

Figure 2.19: The View Menu

Figure 2.20: The Insert Menu

Figure 2.21: The Format Menu
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6. Tools: The 'Tools' menu can be used to check for spelling and grammatical errors through
the 'Spelling and Grammar' option. The 'Word count' option tells you the number of words,
characters, lines, etc., in the whole document. Envelopes and labels can be prepared using
'Envelopes and Labels' option. 'Macros' option is used to create and run macros. The 'Tools'
menu can be seen in Figure 2.22.

7. Table: The 'Table' menu adds and edits the tables in your document. A row and a column
can be safely selected using the 'Select Row' and 'Select Column' options respectively.
'Select Table' option selects the whole table. The table entries can be sorted using the 'Sort'
option. 'Gridlines' option turns on or off the gridlines of the table. The 'Table' menu can be
seen in Figure 2.23.

8. Window: The 'Window' menu allows you to add, arrange and select document windows in
a case where more than one document is open. The 'Window menu can be seen in Figure
2.24.

9. Help: The 'Help' menu can be used to look for specific information. It also gives some
knowledge about Microsoft Word itself. If you find yourself in a difficult situation anytime,
then do not hesitate taking help from Word through this particular menu. The ‘Help’ menu
has been shown in Figure 2.25.

Figure 2.22: The Tools Menu

Figure 2.23: The Table Menu

Figure 2.24: The Window Menu
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Figure 2.25: The Help Menu

Student Activity 7
1. List some Windows 98 accessories.
2. What is a word processor? Name some words processing packages.
3. What is the use of word processing?
4. How will you start MS-Word?
5. Describe various screen elements of MS-Word.
6. Describe various menus available on Menu bar.

Enhancements in Word 2000

Word 2000 has come up in a new loop before us. It has not many new tools and features with
which it is fastly gaining popularity among users. Each kind of user can get some new spice of his
taste added to the new Word 2000. Let us make ourselves acquainted with some of the new in-
things of World 2000.

1. The animated paperclip on the screen always keeps smiling at you as shown in Figure 2.26.
Clippit is a new office assistant, which is there on the screen the first time you start Word
2000. It tried to help you in every way whenever and wherever you are stuck, It can also be
customized according to your special needs and requirements.

2. Some new dimensions are added to the intelligent features of Word 2000. When you are
working in Word, it tries to figure out what it can do more easily and efficiently than you.
Many of the intellisense options start with the word 'Auto' like Autocomplete, Autocorrect,
Autoformat, Autotext and Autosummary.

Figure 2.26: Paperclip
3. Word 2000 offers the facility of 'Document Map' with the help of which you can move easily

from one place to another in your document. One clicking at the 'Document Map' icon on the
standard toolbar, a sidebar to the left of the screen is seen. It shows major headers in the
document. Click at any of headers and Word will take you there instantly.

4. Word 2000 has also made a mark in offering shortcuts to Web Browser such as Microsoft
Internet Explorer or Netscape Navigator. With the help of Web Browser, connectivity to the
world wide web has been made possible. You can also create your own documents that can
be seen on Web. Regular Word documents have to be converted into a format called HTML
which is done automatically by Word 2000.

5. The new Word 2000 can be seen with expanded graphic capabilities. It has the ability to act
as a full fledged desktop publishing program. Advancements like text rotation tool, special
photoshop-type effects, 3D objects etc., have been made to it. Tables can be very easily
made with the 'Draw Table' option of Word 2000.

This is not end of the road. The enhancements done to Word 2000 as discussed above are just a
small chunk.



70

Computer Application
in Management

Working with Documents

It's time to familiarize ourselves with the various important concepts like creation of new files,
opening existing files, saving and finally closing them.

Creation of a New Document

At times, you might need create a new document from scratch. So, for creating a new document,
click at the 'File' menu and then select the 'New' option as shown in Figure 2.27. Now, Word is
ready to accept text as well as other related commands from you.

You can also open a new document by clicking at the 'New' button available on the standard
toolbar. Look for the 'New' icon in Figure 2.29 shown on the next page. Remember to save your
document before quitting. ('Saving a Document' is being discussed in the subsequent part).

Opening a Document

If your document is stored on any of the storage devices like hard disk or floppy disk, then it
becomes possible to retrieve that document and the user can manipulate it the way he/she wants.
Word offers a variety of ways to open your document which are discussed below:

Method 1: Opening a document from desktop

Figure 2.27: The 'New' Option of File Menu

Figure 2.28: The 'Open Office Document' Option of Start Menu

Click here
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Click at the Start button. Point at 'Open Office Document' and click it as can be seen in
Figure 2.28. Alternatively, click at the option 'Open Office Document' of the Office shortcut bar
available on the desktop.

Method 2: Opening a document from Word's startup screen

Click at the 'File' menu and select the option 'Open' as can be seen in Figure 2.30.

Alternatively, for opening a document, just doubleclick at the 'Open' button from the standard
toolbar. This icon looks exactly similar to a file folder and has been shown in Figure 2.30.

One very important thing to observe here is that - an 'Open' dialog box appears on the screen after
employing any of the above mentioned methods of opening a document. The 'Open' dialog box
has been shown in Figure 2.31. In this 'Open' dialog box you would notice a 'look in' box which is
used for selecting the drive as well as the folder where your required document is resident in.
Then, there is 'Files of Type' box which helps you to select the kind of file that you want to open.
Suppose you want that only the Word documents should be shown in the file list, then click at the
pull down arrow and from the drop down list, select 'Word Documents' option. In case you want
to see all the files in the selected drive, then select' All Files' option from the drop down list. Finally
click the filename in the file list and click at the <Open> button or double click the filename to open
up the file.

Figure 2.30: The 'Open' Option of the File Menu

Figure 2.31: The 'Open' Dialog Box
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For future retrieval of the document, it needs to be saved on hard disk or floppy disk. Once all the
text is entered, save the document with any of the following methods:

Method 1

Click at the 'File' menu and then select 'Save' option. You would notice a screen that looks like the
Figure 2.32. When the file is being saved for the very first time, the 'Save as' dialog box comes up
because Word needs some additional information from you.

First, Word wants you to give a name to your file. This has to be given in the 'Filename 'box.
Secondly, the kind of file you are trying to save, should be given in the 'Save as type' box. Thirdly,
the place where you want to save your document should be given in the 'Save in' box. After giving
all this information, click at the <Save> button. Your file is finally saved onto the disk.

The 'Save as' dialog box is displayed only once till the time you don't give a name to your
document. Once the document has a name, next time if you try to save your file after making a few
changes in it, then the 'Save as' dialog box will not appear on the screen.

Method 2

The other way of saving your files is by clicking at the 'Save' button available on the standard
toolbar. You can see the 'Save' button in Figure 2.32.

It's a good idea to keep saving your documents after every few minutes. The reason is if the
computer goes down or a power failure occurs, then the chances of recovering some contents in
the document are high. Unsaved new documents are the most vulnerable.

Closing a Document

Word offers a very handy method of closing documents. Like, you would prefer to close and
remove the office files that are no more required on your table, in the similar manner you may want
to close Word documents too. So, for closing a file, click at the 'File' menu and select the 'Close'
option as shown in Figure 2.33. This will close the file that is recently opened. As many documents
are opened in WORD, you are required to issue 'File - Close' commands for those many times to
close all the files one by one.

Word will also prompt you to save your files before closing them as shown in Figure 2.34. If you
want that your file should be saved before it is closed, then click at <Yes> button otherwise hit the
<No> button. A case may arise when you want to continue working in the same document after

Figure 2.32: The 'Save As' Dialog Box

Save Button
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issuing 'File Close' command. Select the <Cancel> button. It will allow you to work again in your
document thus cancelling the issued command.

Figure 2.34: Word Prompts to Save Files before Closing them

Exiting Word 2000

To quit Word or to close the Word application program, click at 'File\Exit' options as shown in
Figure 2.35. With this command, all the currently opened documents are also closed automatically.
Word will again prompt you to save your files before quitting.

Student Activity 8

1. How will you create a new document in MS-Word?

2. How will you open a pre-exiting file in MS-Word?

3. How will you save a document in MS-Word?

4. How will you exit from MS-Word?

Figure 2.33: The 'Close' Option of File Menu
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Editing means modifying or making changes in your document. It would involve:

Inserting new text

Copying text from one part of the document to another part

Moving text from one part of the document to another part

Deleting unwanted text.

Before exploring all these editing features of Word 2000 in detail let us discuss the word-wrapping
feature first. Incomplete words or the words that exceed right margin look very clumsy. With the
help of word wrap feature, Word automatically wraps around the word in next line, when the
cursor reaches the right margin. So, every time when you reach at the end of line, you don't need
take care of hitting the <Enter> key. The only time, you need press the <Enter> key is, when you
want to end a paragraph or insert a blank line.

Selecting Text

Text needs be selected for performing various block operations (like Copying/ Moving/ Deleting)
on it and for easing our work. Selection of text can be done both by mouse as well as by keyboard.

Selecting Text by Mouse

First of all, let's learn how to select text using a mouse. The various methods of selecting text by
mouse are discussed below:

1. Hold your mouse button from where you want your selection to start and drag the mouse
either rightways or downwards. Release the mouse button at the place where you want
your selection to end up.

2. If you want to select a single word, then take your mouse pointer at that word and double
click it.

3. Paragraphs can be very easily selected by triple clicking anywhere within the paragraph.

Selecting Text by Keyboard

Keyboard can also be used to select text. The method of selecting text by keyboard is discussed
below:

1. Take the cursor at a place where you want your selection to start.

Figure 2.35: The 'Exit' Option of File Menu
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2. Hold down the <Shift> key and move the cursor with arrow keys in the direction required.
Release the keys at a place where you want your selection to end up. In this way, your text
would be highlighted.

Inserting Text

Generally, when you startup WORD, it is in the Insert Mode, which means as text is typed in, the
following text is pushed towards the right side. So, wherever you need  put in new text in your
document, take your cursor at that particular location and start typing in. The method is exactly
the same for inserting either a single character, word, line or a couple of lines.

At times, you also might need  overwrite the pre-written text. For that matter, press the <INS> key
from the keyboard once. This would put Word in overwrite mode and the word 'OVR' will be
displayed on the status bar at the bottom of the screen. Now, when the new text is typed in, the
existing contents at the current cursor location are going to be overwritten by the new text. If you
want to put yourself back in the insert mode, press the <INS> key once again.

Copying Text

Copying means duplicating the contents of the document at some other desired place. The
procedure for copying text is almost the same as that of moving text with a little difference which
is being discussed in the following steps:

1. Select the text that has to be copied.

2. Press <Ctrl + C> keys. Alternatively, select the 'Copy' option from the 'Edit' menu.

3. Take the cursor wherever you want the text to be pasted.

4. Hit <Ctrl + V> keys. Alternatively select the 'Paste' option from the 'Edit' menu.

You can also use the 'Copy' and 'Paste' button (shown in Figure 2.29) available on the standard
toolbar for copying and pasting text. With the above procedure, you would notice the same text
appearing at two places in the same document.

Moving Text

Moving text means removing text from one portion of the document and placing it at some other
location. For moving text, do the following steps:

1. First, select the text that you want to move.

2. Then, click at the 'Edit' menu and select the 'Cut' option. Alternatively you can also cut the
selected text by pressing <Ctrl + x> keys. Once the text is cut, you will notice that the marked
text disappears from the screen. Don't feel worried, your text is put on the windows clipboard
(temporary portion, of memory) from where it can be pasted anywhere.

3. Look for the place, where you want your text to be placed. Take the cursor at that location and
hit the <Ctrl + v> keys or alternatively select the 'Paste option from the Edit menu.

You can also make use of the 'Cut' and 'Paste' button (shown in Figure 2.29) from the standard
toolbar for cutting and pasting the selected text respectively.

Deleting Text

A passage of text can be very easily erased off by selecting it and pressing <Del> key on the
keyboard. A single character can also be deleted very easily by positioning the cursor at that
particular character and hitting the <Del> key.

If you want to scrap off only a single word from your document, select the word by double
clicking it and hit the <DEL> key. You can also delete words by following commands:

Press <Ctrl + Del> keys to delete next word

Press <Ctrl + Backspace> keys to delete previous word.
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1. What do you mean by editing a document?
2. How will you insert text in a document?
3. How will you make the duplicate of some portion of text in a document?
4. How will you delete text in a document?

2.7 FORMATTING DOCUMENTS
Each one of us has a hidden desire that the reader should feel interested in whatever we are trying
to convey. So, for achieving this, a special effort on our front is required. We must give a refined
look to the document. The formatting features like fonts, bullets and numbering, font type etc. can
be used very intelligently to create the whole impact. Now, let us proceed further learning about
these special features smartly.

Defining Font Type and Size of Text
A font can be defined as a set of letters that has a common or the same typeface. Different font
types and sizes can be applied using the formatting toolbar or the Format menu. Let's discuss
them one by one.
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Using Formatting Toolbar

The formatting toolbar is designed very artistically as shown in Figure 2.36. It contains most of
tools that need be used to give a complete and wholesome look to your document. The toolbar
also shows you the font type and size as applied to your text. It also displays the effects (Bold,
Italic or Underline) as given to the text. For applying a font type and size to your text, use the
formatting toolbar in following steps:

1. Select the text.

2. Click at the arrow beside the font type box and select a font type of your choice from the
drop down list.

3. Again, click at the arrow beside the font size box and select an appropriate font size from the
drop down list.

Using Format Menu

The required font type and size can also be applied to the text by using 'Formal menu as described
in following steps:

1. Select the text.

2. From the 'Format' menu, select the 'Font' option. The 'Font' dialog box appears on the screen
as shown in Figure 2.37.

3. Choose appropriate font type from the 'Font' box. You can move up or down in the 'Font' box
with the help of up and down arrow keys.

4. Similarly, choose the required font style and size for your text from the 'Font style' and 'Size'
boxes respectively.

5. The preview of the selected text can be seen in the 'Preview' window with the applied
formatting features.

6. Click <OK> button.

You will find the look of your text changing with the application of new font type, style and size.

Making Text Bold, Italic and Underlined

Using Formatting Toolbar

If you have given a keen look at the formatting toolbar: then you must have observed three
buttons showing the letters B, I and U. The letter 'B' stands for Bold, 'I' for Italic and 'U' for

Figure 2.37: The 'Font' Dialog Box
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document, concentrate on the following steps:

1. Select the text.

2. Click at the 'B' button.

On carrying out these steps, the 'B' button becomes depressed or lightened. If you do not want
the text to be bold select the text again and click at the 'B' button. This button on the toolbar again
becomes prominent and your text is not bold anymore.

At times you would like to see your text in italics or would like to underline it. To do this, do the
following steps:

1. Select the text.

2. Click at 'U' button to underline and 'I' button to italicise it.

Using Format Menu

Alternatively, the same work can also be done using the 'Format' menu by following steps:

1. Select the text.

2. Click at the 'Font' option of the 'Format' menu.

3. In the 'Font' dialog box, activate the 'Bold' option or 'Italic' option from the 'Font style' box
to show your text in bold or italics. (Refer Figure 2.37)

4. In order to underline the text, select the required option from the 'Underline' box drop down
list.

If you are a keyboard person, you can also use one or more of the following key sequences to
achieve the same, after selecting the text:

Press <Ctrl + B> keys to bold the text

Press <Ctrl + 1> keys to italics the text

Press <Ctrl + U> keys to underline the text

Changing Case of Text

Word offers a quick and handy way to change the case of your text. Lowercase characters can
easily be changed to uppercase by hitting <Shift + F3> keys. To achieve the contrary effect, press
the <Shift + F3> keys again. This would convert uppercase characters to lowercase.

Alignment of Text

Text alignment means placement of text between the margins. Your text can be left, right, centre
aligned or it can be justified within the margins. Left alignment of text would mean the arrangement
of text evenly in a straight line at the left side of the document but with uneven edges on the right
side. Right aligned text is just the opposite of left aligned text with text evenly arranged at the right
edge of the document but uneven from the left side. Justified text would involve even edges of
text along both margins. Centre aligned text means that the text is placed exactly in the centre of
the page. Centre aligned text is most suitable for giving titles, headings etc. Generally and most
frequently the text is left aligned because then the text becomes easily readable and understandable.
Now, let us find out how text can be aligned using the formatting toolbar.

1. Select the text (it could be a single line or a paragraph or the whole document).

2. Click at any of the alignment buttons from the formatting toolbar to get the desired result.
(Refer Figure 2.36).

If you are more in the habit of using keyboard, then give the following keyboard shortcuts after
selecting the text:

Press <Ctrl + L> keys to left align the text

Press <Ctrl + R> keys to right align the text
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Pres8 <Ctrl + J> keys to justify the text

Press <Ctrl + E> keys to show the text in the centre

Formatting Paragraphs

Formatting means deciding alignment of the paragraph. It also includes the spacing that is to be
put in between the lines. In order to carry out formatting on Paragraph, it needs be selected first.
Then go to the 'Format' menu and do the lowing steps:

1. From the 'Format' menu, select 'Paragraph' option. A 'Paragraph' dialog box shoots up on
the screen as shown in Figure 2.38.

Figure 2.38: The ‘Paragraph’ Dialog Box

2. You can set the alignment i.e. decide the placement of text on the screen by clicking on the
dropdown arrow of the ‘Alignment’ box. Your whole of the paragraph can be left, right or
centre aligned.

3. Go to the 'Line Spacing' box and click at the drop down arrow to make a choice. Finally click
at the <OK> button. In the 'Line Spacing' box there are many options that need a bit of
elaboration. Let us find them. For the options 'At least', 'Exactly' and 'Multiple', a number
has to be given in the 'At' box. In these cases, the space is measured (between the lines) in
terms of print size. The ‘At least’ option uses the space as given in point size but it can also
use some extra space in a case where it needs accommodate some text. 'Exactly' option gives
exactly the same space as defined in the ‘At’ box. If word needs extra space to adjust some
more text, then it cannot get it. 'Multiple' option allows you to specify the line spacing of
your own choice. If you want the lines to be triple spaced, then type '3' in the 'At' box.

Bullets and Numbering

It is always advisable to put the text entries which are separated by commas in the bulleted or the
numbered form. Adding bullets to the text makes it easy to read and understand. Major points can
be very well emphasized through this technique. Points put in the order of preference are long
remembered by the reader. Moreover, in our day to day life, we prefer to make our daily list in the
numbered manner rather than putting it in a paragraph. The only idea is that the chances of
forgetting are turned low and visibility of important points is clearer. You can put bullets or
numbers in an existing list by using either the formatting toolbar or the 'Format' menu.
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1. Select the text.

2. Click at either the 'Bullets' button or the 'Numbers' button on the formatting toolbar. (Refer
Figure 2.36).

In case you decide that you don't require 'numbers' or 'bullets', you can very easily put them off
by repeating the above steps.

Using Format Menu

This method perhaps offers a wider choice of symbols other than the typical black circle. Let us
discuss this method:

1. Select the text.

2. Select the 'Format Bullets and Numbering' option.

Figure 2.39: The 'Bullets and Numbering' Dialog Box

A 'Bullets and Numbering' dialog box appears on the screen as shown in Figure 2.39. Select the
'Bulleted' tab in case you want bullets in your document. If you wish to put numbers then select
the 'Numbered' tab. Choose any of the bullets or numbers and apply it onto your document by
clicking <OK> button. You see how easy it is to place bullets and numbers in your document.

Find and Replace Commands

'Find' and 'Replace' commands have been presented in a new and different look in Word 97. 'Find'
and 'Replace' do not have their own separate dialog boxes. Instead they have been presented in
the tab form in the same window. On finding a word, you can replace it with some other word using
'Replace' straightaway. Carry out the following steps for finding a word or group of words:

1. From the 'Edit' menu, select the 'Find' option. A 'Find and Replace' dialog box appears on the
screen as shown in Figure 2.40.

2. Enter the word or phrase you want to search for in the 'Find what' box.

3. Click at 'Find Next' button. It will show you the first appearance of word or phrase. Keep
hitting the 'Find Next' button until you find the required word or phrase in your document.
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Once your word is located, you may want to replace it with some other suitable word. At times,
global replacements of a word in the whole document has to be carried out. For example, you have
entered a word ‘component’ many a times in your document. Now at later point of time, you may
want to change it to 'part'. Replace can help you in making the required changes by carrying out
the following steps:
1. Select 'Edit - Replace' option. A 'Find and Replace' dialog box comes on the screen as shown

in Figure 2.41.
2. Enter the word 'component' in the 'Find what' box.
3. Enter 'part' in the 'Replace with' box.
4. Click 'Find Next' if you want to see the first occurrence of the word. Click the 'Replace'

button if you want to change it. In case you do not want to make the change, then click 'Find
Next' again to locate for the next appearance of the word.

5. The 'Replace All' button will change all the occurrences of the word 'component' to 'part' in
the whole document in a single command.

Numbering Pages

A long document certainly needs proper page numbering done for easy and quick reference.
Adding numbers to each and every page manually cannot only become tedious but also confusing
and time consuming work. Word can really automate your task. To add numbers to your document,
follow the steps given below:

1. Click at the 'Page Numbers' option of the 'Insert' menu. A 'Page Numbers' dialog box appears
on the screen. This dialog box resembles Figure 2.42.

Figure 2.40: The 'Find and Replace' Dialog Box

Figure 2.41: The 'Find and Replace' Dialog Box

Figure 2.42: The 'Page Numbers' Dialog Box
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your page number to appear. It can come either at the top or bottom of the page.

3. From the 'Alignment' box, decide the alignment of the page number. You can place your
page number either on the left, right or in the centre of the page.

4. If you want that the page number should be shown on the first page also then check the box
on. In case you check the box off, then the page number is only going to be hidden but is
certainly counted as 1.

5. Click at the 'Format' button. A 'Page Number Format' dialog box appears on the screen as
shown in Figure 2.43. Select the style of page numbers that you want for your document
from the 'Number Format' drop down list.

6. If you want to start your page number from some digit other than 1,2,3..., then you can very
well specify it in the 'Start at' button, Click at the 'Start at' radio button and type in the
desired number in the following box from where you want your, numbering to start.

7. Click <OK> button to apply the desired format. Again click at <OK> button to save the
changes and come out of the 'Page Number' dialog box.

2.8 CLIP GALLERY

Word 2000 has come up before us with enhanced graphic capabilities. There are many new clips
put in this latest version of WORD. Moreover, added multimedia effects such as sound and
videos in Word 2000 are getting a very friendly welcome from the users. Our old clipart gallery has
also got a new name in Word 2000. Now, it is called Clip Gallery.

Inserting Clips

To place clips in your document, go about performing the following steps:

1. Select Insert/Picture/Clipart'. A dialog box by the name 'Microsoft Clipart Gallery' is shown
on the screen as shown in Figure 2.44. Now, from this dialog box, select the 'Clipart' tab. You
will notice that your clipart gallery is indexed on major keywords. If you scroll down in the
window under the head 'All categories', you would find a fairly long list of clips. So, in order
to make our search easier, select any particular category in the category list. In the adjoining
window, you would find all the clips relating to that category together.

2. Search through the clips and decide an appropriate clip for your document. Select anyone
desired clip and click at the <Insert> button. You will find that particular picture placed in
your document at the current cursor position.

Figure 2.43: The 'Page Number Format' Dialog Box
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Resizing Clips

The clip that you have successfully placed in your document might not be of the exact size that
you want. It can either be too small or too big. So, to resize it:

1. Select the clip by clicking anywhere on it. Eight sizing handles appear on the boundary of
the clip as shown in Figure 2.45.

2. Take your pointer at any of these handles. The pointer will change into a double headed
arrow.

3. Click and drag the handle in the direction desired to make your clip big or small.

4. Release the mouse pointer when the required size of your clip is achieved.

2.9 PAGE SETTING

Page setting includes putting your text neatly between margins. Margins are nothing but an
invisible frame within which the whole text appears. When a blank new document is opened, a
default margin is always there. This margin is laid for sides, top and bottom of the page. You can

Figure 2.44: The 'Clip' Dialog Box

Figure 2.45: Resizing Clips
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will learn to set margins by two methods:

Margin Setting through File/Page Setup

The default setting of the top and bottom margin is 1 inch and in the sides, it is 1.25 inches. To
modify the default margin setting, follow the steps given below:

1. Select 'Page setup' option of 'File' menu. A 'Page Setup' dialog box appears on the screen as
shown in Figure 2.46.

2. Click in the 'Top' box and erase off the current setting by using either the <Del> key or the
<Backspace> key from the keyboard. Type in the desired number. Alternatively, you can
use the top arrow to increase the margin and down arrow to decrease it.

3. Similarly, change the settings in the Bottom, Left and Right boxes as well.

At times, you might want that the changes that have been made recently should apply to the
current document only, then click at <OK> button. But in case, you want that the current document
as well as any other new document that you open should have these page settings, then click at
the <Default> button. The next step would be to click at the <Yes> button in which case Word is
trying to seek your permission in changing the default settings for page setup.

Setting Margins using Ruler line

Ruler line is very frequently used to change margins. It is a quick and easy way to set margins but
needs some amount of practice also. To set margin using the ruler line, carry out the steps
discussed below:

1. Place your mouse pointer on the left side of the horizontal ruler line. Slowly, move the
mouse pointer towards your right side till the place where your mouse pointer acquires the
shape of a double-headed arrow. A 'Left Margin' tool tip appears on the screen as can be
clearly seen in Figure 2.47.

2. Click at that location and drag the mouse towards right side to increase the margin or on the
left side to reduce it.

3. Release the mouse button when suitable margin is attained.

Figure 2.46: The 'Page Set up' Dialog Box
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In order to set right margin, the method is just the same as discussed in the above three steps. If
you observe closely, you will find a thin gray line above the 'Right Indent' button which is in the
extreme right of the Ruler Line. This is the Right Margin Line. Place the mouse pointer at this line
and click on it. Drag the pointer in either direction to increase or decrease the right margin. Finally,
release your mouse button.

Now, let us learn how to set the top and bottom margins using the vertical ruler line. This vertical
ruler line appears only in the Page Layout view. So, in a case if your vertical ruler line is not
apparent on the screen, then first switch yourself to Page Layout view by selecting 'Page Layout'
option from the 'View' menu. To set the top margin:

1. Take your mouse pointer on the thin gray line that appears between the darkened and white
areas on the top side of the vertical ruler line.

2. As soon as your mouse pointer takes the shape of a double headed arrow, click and drag it
either upwards or downwards to attain the desired top margin.

3. Release the mouse button.

When you are trying to play with the margins, a line is shown across the page which keeps
moving up or down according to the movement of your mouse pointer. This gives you the exact
location of your margin on the page.

2.10 APPLICATION OF A WORD PROCESSOR IN
CORPORATE SECTOR

A word processor finds immense usage in the corporate sector. This is a software that is specially
designed to help the managers to design and prepare typed documents. It offers very handy tools for
managers to work upon. For instance, MS-Word offers many pre-designed professional letters which
can be used with little or no modification at all. Moreover, the overall impact of the document can be
enhanced by using the advanced features provided by MS-WORD.

Student Activity 10

1. What do you mean by formatting text?

2. How will you make the text bold and Italic?

3. What do you mean by text alignment? What are the various types of alignments available
in MS-word?

Figure 2.47: Figure Showing 'Left Margin Tool'
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5. How will you find a group of words in MS-Word? How will you replace them with some
other words?

6. How will you give numbers to you pages?

7. How will you insert clip-art in MS-word?

8. How will you set margins using ruler?

9. What is the application of MS-word in corporate sector?

2.11 DATABASE MANAGEMENT PACKAGES

Business processes are always associated with a huge amount of data. To store, manipulate and
processes such data, some software packages are needed, which are collectively known as
Database Management Packages/Software/Systems (DBMS). DBMS is defined as a software
that organizes and maintains the data in a database for providing the information.

Microsoft Access is a Windows based Relational Database Management System (RDBMS). It
has received huge acceptance by users because of its versatility and easy to use interface.
MS-Access is best suited for maintaining any type of information. It can keep huge records of
data ranging from keeping an address book to inventory details. Access finds its immense usage
in registering telephone numbers, expense details, store or warehouse information. Whatever
data is entered, it can be viewed from different angles using forms. Data can also be sieved and
extracted based on certain conditions using queries. Reports help in analyzing the data and help
you to come at certain meaningful inferences. The very frequently used operations can be
automated by creating and saving macros.

What is a Database

A database is a collection of related information. An example of a typical database is a private
telephone directory. It contains related information about each person like his name, address and
telephone number. Other examples of a database include list of customers and suppliers,
maintenance of stock in warehouses, collection of tapes in libraries, maintenance of members in a
country club, etc.

Components of a Database

All the information stored in an Access database is kept in tables as illustrated in Table 2.2.

Table: A table is a collection of some specific kind of data. It is the basic element of the database.
Data put in a table is organized in rows and columns.

Record: Each row is called a record and it contains the complete information about one particular
item, e.g., in a telephone directory all the essential details about a single person like his name,
address and city form one record.

Column: Each column is called a field. It holds information about a certain type for all records. A
field could be a name, address, telephone number, etc.

Table 2.2: An Example of a Typical Table
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In the example shown in Table 2.2, the table contains four records and five fields. Thus, each
record contains a complete and wholesome information about one item. Each column contains the
same type of information for all the records like S.No., Name, Address, etc. The field 'Name'
contains the information related to 'Name' for all records. So, you can have any number of records
as well as fields in your table. You can add more records to your table. In the similar manner, you
can also expand the field list. Your database can have any number of tables. The 'Relational'
concept allows to build relations between different tables.

2.12 STARTING ACCESS 2000

In order to startup Access in Windows 98, follow the steps given below:

1. Click at the Start button. Select the Programs option.

2. Select Microsoft Access option from the cascading menu. Access will be loaded in the
computer's memory. By default, the name given to an Access database is 'dbl'. The extension
given to a database in Access is 'mdb'.

Opening a Database

In order to access any table form or report created in a database, it has to be opened first. A
database can be opened by the following methods:

Follow the steps given below:

1. Select the 'Open an Existing Database' option from the opening Microsoft Access dialog
box as shown in Figure 2.49. Choose a database from the existing databases and click at the
<OK> button.

Figure 2.48:  Starting Access

Figure 2.49: Selecting the Type of Database to be Opened
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The different parts of an Access Window are shown in Figure 2.50. You are already familiar with
most of the components of this window. You have already been introduced to title bar, minimize
button, maximize button, close button, control menu button, menu bar, toolbars and status line.
The term 'Database Window' has been brought up for the very first time before us.

Figure 2.50: Different Parts of Access Window

The Database Window
The elements of an Access database are brought together in the database window. Everytime a
database is opened, the database window displays information about the database and all the
objects it contains. The database window comprises of three parts. You will find six object tabs at
the top of the horizontal bar. Each of these tabs help you select any particular object that has to
be worked with. By default, the table tab is always selected when the database window is opened.
It shows all the tables that have been created in that particular database. You can select any
object by taking your mouse pointer at that particular tab and clicking it. Then, you will find the
command buttons towards the right side of the window, These command buttons help you to
place the database object in a different view, The <Open> button helps you to open up and see
the selected object. The <Design> button shows the selected object with all the properties set for
that object. The <New> button helps you to create a new object from scratch. This newly created
object becomes a part of the current database. The features of a database window are as follows:
Table: It shows the list of all the tables created in the current database. You can create new tables
and modify the existing tables.
Queries: It shows a list of all the queries in the current database. A query is nothing but a
question about the data stored in the table. A query can be opened, modified as well as created
from here. A query is used to extract certain information from a database.
Forms: It displays the names of all the forms created in the current database. A form is used for
entering data in the table. Forms can show data in more meaningful and structured manner.
Reports: It shows the reports that have been created in the current database. A report is used for
showing the data put in the table in an organized manner.
Macros: A macro is a written set of instructions that does your work automatically. It helps to
automate repetitive tasks.

Modules: A module is a collection of programs which is written by the user.

Title bar Minimize button
Maximize button
Close buttonControl Menu buttonMenu bar

Toolbar

Database
window

Status
line
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Creating a Database

As we have already discussed, a database contains a large number of tables. The very first step
for working in Access is the creation of database. So, as and when Access is loaded in the
computer's memory, Figure 2.51 appears on the screen.

1. Click at the Blank Database option to create a new database. Finally, click at the <Ok>
button. The Figure 2.52 appears on the screen.

2. Access wants you to give a name to your database. So, in the 'Filename' box, type in the
name of the database. Here, the name given to an Access database is 'Ruby'. Then, click at
the <Create> button. Now, the Figure 2.53 appears on the screen.

Figure 2.51: Database Creation Window

Figure 2.52: 'File New Database' Dialog Box

ruby
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Figure 2.53: The Database Window

Creating a New Table

A table contains all the necessary information. We will learn how to create a table using a wizard.
A wizard takes you through a series of steps to accomplish your work. Thus, in order to create a
table, click at the <Table> tab and then at the <New> button as shown in Figure 2.53. Figure 2.54
appears on the screen. After clicking at the 'Table Wizard' option, click at the <Ok> button.

Figure 2.54: The 'New Table' Dialog Box

The 'Table Wizard' contains some sample tables as shown in Figure 2.55. Select the table in the
'Sample Tables' window according to your requirement. The corresponding fields of the table are
shown in the adjacent window. You can put all the fields from the sample table. You can also
decide and put a few fields in your table from the fieldlist. So, for putting the fields selectively,
select the field and click at the single arrow pointing towards the right side. However, if you wish
to put all the fields from the sample table into your table, click at the double arrow pointing
towards the right side. In case, if you have accidentally put a wrong field into your table, then
select that field and click at the single arrow pointing towards the left side. This will clear the field
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from your table. The double arrow facing towards the left side will remove all the fields from your
table. However, if you wish to give a new name to your field, then click at the <Rename> button.
A 'Rename' dialog box comes up on the screen. Simply, type in the new name. Finally, click at the
<Next> button.

Figure 2.55: The 'Table Wizard' Dialog Box

The Figure 2.56 appears on the screen. The 'Table Wizard' appears on the screen. You can give a
name to your table. The name given to the table in the example is 'Mailing List'.

Click at the <Next> button. Figure 2.57 appears on the screen. Access allows you to create a
temporary form for entering data through the 'Enter data directly into the table' option. However,
if you wish that the form should also be saved for future use, then click at the option <Enter data
directly into the table> using a form the wizard creates for me'. In the latter case, the wizard will
automatically create a new form for you according to the fields that you have decided to put in
your table. Finally, click at the <Finish> button. Figure 2.58 appears on the screen.

Figure 2.56: Figure Showing the Name given to a Table
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Figure 2.57: Create a Form for Data Entry

Click in the <First Name> box and enter the first name of the person. In a similar manner type in the
rest of the appropriate details by clicking in respective box. Once all the details of a single record
are entered, click at the <Next Record> button. It will take you to the next record and there you can
type in the details of the second record. The 'Next Record' button is also used for seeing the
contents of the next record of the table. The 'Last Record' button shows you the details of the last
record. The <Previous Record> button will take you to the previous record. The very first record
of the table can be seen with the help of the 'First Record' button. Once all the records are entered,
click at the Save As option of the File menu to save the form and give an appropriate name. Click
at the <Close> button appearing on the extreme right of the screen to get back to the Database
Window.

Figure 2.58: Form for Entering Data in the Table

Viewing the Contents of the Table

The contents of the table can be seen by going back to the 'Database Window'. Click at the
<Forms> tab and select the form name whose contents are to be seen. Lastly, click at the <Open>
button. You can navigate between different records to see their details.

Closing and Saving a Database

In order to close a database, click at the 'Close' option of the File menu. Alternatively, click every
<Close> button of the database window. It would automatically save your database and update
the changes done to it.
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Exiting ACCESS

To quit Access, click at the Exit option of the File menu.

Student Activity 11

1. Define DBMS.

2. What are the various components of a database?

3. How will you start MS-Access?

4. What are the features of a database window?

5. How will you create a table in MS-Access?

6. How will you view the contents of the table?

7. How will you exit from MS-Access?

2.13 WORKING WITH TABLES

We have already seen how to create a table. A table contains the basic data stored on a database.
A database can contain a single table as well as multiple tables. In order to open a table, go to
Database window and select the table tab by clicking it with the help of mouse pointer. Now, you
have to decide whether you want to see the table in the Datasheet view or the Design view. The
Datasheet view shows you all the data and records present in the table. The Design view, however,
shows you the properties that have been set for each field of the table.

Opening a Table in Datasheet View

To open the table 'Products' in the Datasheet view, click at the <Open> button. Figure 2.59
appears on the screen. It shows you the field names of the table at the top and the corresponding
data below it. Each horizontal line of the window forms a single record. So, as many lines are there
in the window, there are going to be those many records in it.

In order to move around the datasheet, you can make use of either the keyboard or the mouse.
You can select any data element by clicking it with the help of mouse pointer. Using the keyboard,
press the <Shift + Tab> keys together to move from one field to another. Once you have reached
the last field in the current row, press the <Tab> key again to go to the first field of the next record.
However, if you are in the first field, pressing the <Shift + Tab> keys will take you to the last field
of the preceding record. You can also use the up and down arrow keys to move from one record
to another. In order to select the entire record, click in the left most column of that particular
record's row.

Figure 2.59: The Products Table in Datasheet View
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in your data. However, you can also edit the data of the table. Simply, click in the cell (with the help
of mouse pointer) which has to be edited and then type in your contents.

Opening a Table in Design View

A table can be opened in a Design view by first of all selecting the table in the Database window
and then clicking at the <Design> button. Figure 2.60 shows the 'Product' table in the Design
view.

A table is opened in the Design view in order to examine its structure. It shows the fields present
in the table as well as the data type and properties for each field.

The grid at the top of the Design view window shows all the fields, their data types and some
description about the field. The lower part of the window shows the other properties of the field
that has been selected in the upper grid. At one time, the properties of only one field that is
selected is shown in the lower window.

You can very easily view the details of another field by simply clicking anywhere in the grid row
on which it appears. The information in the lower window changes to match the properties for the
newly selected field. Access shows the currently selected field by putting an arrow on the row in
the left most column of the upper window.

If the left most column of the grid displays. a key icon, then that field is being used as the primary
key for the table. This means that this particular field is being used as a unique field. This field can
never contain repetitive entry. All the data for this field is uniquely identifiable. Therefore, this
field is said to be the 'primary key' of the table. Now, let us study the basic structure of a table in
detail.

1. Field Name: The Field name column present in the upper window specifies a name for the
field. No two fields in the table can carry the same name. You can provide any name to your
field. However, the Field name cannot have more than 64 characters. It can contain any
combination of letters, numbers, spaces and special characters except periods, exclamation
marks or square brackets. Field names can never start with a space.

2. Data Types: The Data Type column is present next to the Field name column. It signifies the
type of information stored in the field. The edit box for this column is a drop-down list box

Figure 2.60: The Products Table in Design View
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which contains all the available data types. Let us briefly explore all the available data
types:

(a) Text: It stores the alphanumeric data which contains a string of characters.

(b) Number: Any kind of numeric data is held by this data type.

(c) Date/Time: It stores the date and time.

(d) Currency: It is a special numeric data type used for holding monetary values.

(e) Autonumber: This kind of data type is mostly used for primary key fields. Fields of this
data type are read only. Access automatically inserts the next number in the sequence.

(f) Yes/No: This data type can hold only one of the two values such as Yes/No or True/
False.

(g) Memo: This data type is used for storing long text fields upto a limit of 64,000 characters.
This data type is used, to store long comments or notes.

3. Description: The Description column is present adjacent to the Data type column. This is
used to give a short description about the field. The Description column provides complete
explanation of the purpose the field serves.

4. Properties: Each field has got its own set of properties. It further defines the fields and how
it is used in the database. So, as you move from one field to another in the upper window,
the corresponding properties in the lower window also change. Now, let us look at some of
these properties:

(a) Field Size: The Field size property appears only for the Text and Number data types.
This property specifies the maximum number of characters that can be stored in the
field for a single record for a text value. For Number fields, field size specifies the type
of number that will be stored in the field. The available choices are Byte (a. number from
0 to 255, whole numbers only), Integer (-32,768 to 32, 767, whole numbers only), Long
Integer (-21, 47, 483, 648 to 2147, 483, 647, whole numbers only), Single (can hold a very
large number and fractional numbers) and Double (stores numbers larger than single).
The choice made here does affect the amount of space Access uses to store the field.
Therefore, you should be very careful in deciding the field size.

(b) Caption: The Caption property specifies a string that has to be displayed as the column
heading whenever the field is displayed in the Datasheet view.

(c) Default Value: The Default value specifies a value that will be put into the field if it is
not given by the operator at the time of entering the record.

(d) Validation Rule and Validation Text: The Validation rule property specifies a test that
is performed on any data that is entered into the field. If the data does not pass the rule,
then a message is shown on the screen. However, if any message is typed in the
Validation text property, then that message is displayed, otherwise some system error
message is shown on the screen. For example, for a price field if you specify the
validation rule as '>100', then any data below 100 will not be accepted and the computer
will prompt you to re-enter.

(e) Required: The Required property forces you to enter a value if it has been set to 'Yes'.
You cannot leave that particular field empty at the time of entering record in your table.

2.14 WORKING WITH FORMS

All the data in your database is stored in tables. You can view as well as edit data in a table but
forms provide a much easier and flexible interface to view and edit data. Forms allow you that view
all or just a few record at once while also showing the field names. Forms provide an easy way to
enter, change and delete records.
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First of all, open the database that contains the required form. Now, in the database window, click
at the forms tab. All the forms of the currently active database are shown in the window. Select the
Form name with the help of the mouse pointer and finally click at the <Open> button. Figure 2.61
appears on the screen. Using the arrow keys, you can view the other records of the table.

Creating a Form

A form can be very easily created using the Form wizard. The form wizard is the quickest and the
easiest way to create a form that is bound to a table. You can use the form immediately or you can
make changes to get the form look exactly the way you want. Thus, in order to create a form using the
form wizard, first of all, select the Forms tab in the Database window. Finally, click at the <New>
button. A 'New form' dialog box appears on the screen as shown in Figure 2.62.

From the 'New Form' dialog box, select the Form wizard option. Then select the table from which
the information has to be displayed on the form. Click <OK> button to start the Form wizard. We
will create a form on the 'Products' table. So, select the Products table to create a form on it and
click at the <OK> button. You will see Figure 2.63 coming up on the screen.

Figure 2.61: An Open Form

Figure 2.62: The New Form Dialog Box
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This Form wizard dialog box wants you to select the fields from the table that need be added to the
form. By clicking the single arrow pointing towards the right side, you can add fields one by one
to your form. You can add all the fields into your form by clicking at the double-arrow pointing
towards the right side. After you have decided and put the fields, click at the <Next> button. You
will find Figure 2.64 coming up on the screen.

This dialog box asks you to decide and to choose the layout in which you want to see your new
form. By default, the layout of the form is columnar. Whichever form layout you choose, the left
side of the window shows the arrangement of fields on the table. Choose the layout and click at
the <Next> button. Figure 2.65 appears on the screen.

Figure 2.63: The First Step of Form Wizard

Figure 2.64: The Second Step of Form Wizard

Figure 2.65: The Third Step of Form Wizard
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controls the color and the font of the data that is to be displayed on the form. It also takes care of the
background color and picture of the form. By default, the 'clouds' option is active, choose the style
and click at the <Next> button. You will find Figure 2.66 coming up before you.

This is the last dialog box of the form wizard. Here, you are required to give a name to your form.
You can straight away start entering data into your form or you can modify the form design.
Hence, give a name to your form and open it up for viewing and entering data in it. Finally click at
the <Finish> button. Now, you can see your form already on the screen as shown in Figure 2.67.

Adding and Editing Records in a Form

To add a new record, click at the <New Record> button available in the form that you have
created. To edit or modify any of the field data, you are simply required to click that field with the
help of mouse pointer and then type in the new data. You can make use of the <Tab> key from the
keyboard to move around the form and then edit any field by simply typing in.

Figure 2.66: The Four Step of Wizard

Figure 2.67: The Form on Products Table
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Deleting Records in a Form

It is very easy to delete records. You can delete information in fields by selecting that field with
the help of mouse pointer and pressing the <Delete> key from the keyboard.

Saving and Closing Forms

Access, automatically saves each record as you move ahead. To close the form and return to the
Database window, choose File/Close option or Click the <close> box available in the upper right
comer of your screen.

2.15 WORKING WITH REPORTS

Reports provide information in a very systematic, organized and compact way. You can view and
print this information in any format and style. Reports help in taking managerial decisions effectively
and efficiently.

Opening and Viewing Reports

Opening a Report is very much similar to opening forms. First of all, go to the database window
and select the Reports tab. All the reports contained in the database will be shown on the screen.
Select the report that has to be opened and click at the <Preview> button. Figure 2.68 shows a
sample report formed on the Products table.

Creating a Report

A simple report can be created using the ‘Auto Report' feature of Access. ‘Auto Report’ creates
a report automatically containing all the fields and records from the selected table. Each field on
the report appears in a single line carrying a label on the left side of the page. You can create a
report by first going to the main window and then clicking at the Reports tab. Click at the <New>
button present on the main database window. Finally, click at the 'Auto Report' option. 'Auto
Report' creates a single-column or tabular reports. 'Auto Report' is the quickest and the easiest
way of creating reports.

Printing a Report

Most of the times, a hard copy of the report is taken out and put in record file. It helps in taking
very useful and quick decisions. To print a report select it from the Report tab in the main database
window and then choose 'File/Print' option from the Database window. A 'Print' dialog box appears
on the screen. Use this dialog box to choose the printer that will print the report, which pages to
print, what range of pages to print, how many copies and other print properties.

Figure 2.68: The Products Report
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A report can be saved by choosing the File/Save option. When the report is being saved for the
very fist time, a dialog box appears before you which asks you the name of the report. By default,
the name 'Report l' is given to your report. In order to close a report, click at the Close box available
at the right corner of the screen.

Application of a Database in Corporate Sector

The software packages called Database Management Systems provide a very high level language
interface which can be learned very easily by an end-user. The manager need not learn the
programming techniques at all. Moreover, small business information systems can be easily
implemented in a few days using this package.

Moreover, it becomes very handy for a manager to maintain data and prepare reports based on
these data. A variety of reports can be generated depending upon the precise and specific
requirements of the managers. It also allows you to create queries and provides you an answer to
the manager's most difficult decision  oriented questions.

Student Activity 12

1. What is the difference between design view and datasheet view?

2. What is a form? How will you create a form?

3. How will you edit records in a form?

4. What is a report? How will you open and view reports in MS-Access?

5. How will you print a report?

6. What are the application of a database in corporate sector?

2.16 SPREADSHEET PACKAGES

Business applications require a lot of calculation work. In manual system, it is done on a sheet of
paper with rows and columns, which is called a 'spreadsheet'. Spreadsheet packages use the
concept of an electronic spreadsheet. An electronic spreadsheet (or worksheet) is a very big
sheet consisting of thousands of rows and columns, which is used to store information in the
memory of a computer. Like databases, electronic spreadsheets have now become an essential
tool in developing a computerised management information system. Income statements, annual
reports, balance sheet, cost analysis and budgets are some of the applications where worksheets
are typically used.

EXCEL 97 is a very powerful and easy to use spreadsheet package which is being commonly used
these days. It is basically an end user application package. It works very well with numbers and
their complex calculations. EXCEL 97 helps to put and prepare your data in an organized, orderly
and meaningful fashion. EXCEL 97 finds its major contribution in creating reports, using formulas
and performing calculations. It is best suited for scientific and statistical analysis. EXCEL 97 can
also be used to prepare Profit and Loss accounts, Balance Sheet and other Tax statements. It
works well for both simple and complicated numbers. EXCEL 97 can do anything for you. Your
imagination can be the only limit. It can be used for preparing analytical reports including statistical
analysis, forecasting and regression analysis. Good looking and attractive charts can be created
which depict data in clearer and meaningful fashion. EXCEL 97 can also be used to create
relationships between different types of data. EXCEL 97 can do all the work of a full fledged word-
processor but it lacks the advanced features of desktop publishing. It also supports the high level
features of object linking and embedding which means data from Word can be safely and easily
put and linked with data in EXCEL and vice versa is also true.

What is an Electronic Spreadsheet

An Electronic Spreadsheet is a network of rows and columns. Each row is given a unique number
whereas each column is identified by a unique alphabet or pair of alphabets. So, it can be stated
that an electronic spreadsheet is a grid that contains cells.
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Popular Spreadsheet Packages

The popularly used spreadsheet packages are:
MS-EXCEL
Lotus 123
Supercalc
Framework
VP Planner Plus

Uses of Electronic Spreadsheets

Electronic Spreadsheets satisfy the needs of a large number of users and meet with their varied
requirements. Some of the things that can be easily done with the help of an Electronic Spreadsheet
are mentioned below:

Arithmetic and Statistical Calculations
Preparation of Profit and Loss Account
Preparation of Income Statements
Preparation of Tax Statements
Reports
Charts
Regression Analysis
Forecasting

An Electronic Spreadsheet can do a great job with mind crunching numbers. Any kind of complex
calculation can be done in a matter of few seconds.

2.17 STARTING EXCEL 2000

The biggest advantage offered by Microsoft Office products is the great similarity between its
applications with respect to the overall working, toolbars and menus. Since, we have already
made ourselves familiar with Word 2000, learning EXCEL 2000 will become easy and less time
consuming for us.

To startup EXCEL in Windows 98, the steps given below can be followed:

1. Click on the Start button at windows taskbar.

2. Select Programs option

3. Select Microsoft Excel option.

Figure 2.69: Starting Microsoft Excel
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previous lesson also, the menu options shown to find out in this figure might not exactly resemble
those seen on your computer. So, you need  do a bit of exploring job where actually MS-EXCEL
is installed on your computer.

Alternatively, MS-EXCEL can also be started up through the following steps:

1. Click at the Start button.

2. Select 'New Office Document'. A 'New Office Document' dialog box appears on the screen.
Double-click at the blank workbook option or select one of the other tabs, such as spreadsheet
to start EXCEL 2000.

Once EXCEL 2000 is loaded in the computer's memory, a blank workbook shoots up on the screen.
A typical name given to a file in EXCEL is Workbook. The terms Excel Document, Excel Workbook
and Excel File carry the same meaning and can be used interchangeably. This blank file by default
gets the name - Book l. The extension given to a file in Excel is 'XLS'. A typical Excel screen
resembles Figure 2.70.

Figure 2.70: EXCEL's Opening Screen
Screen Elements
Let us look at different parts of an EXCEL screen which are shown in Figure 2.71.

Figure 2.71: Screen Elements of Excel
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Table 2.3: Description of Screen Elements

A workbook has got three worksheets in it by default. New worksheets can be added to it. It is a
good idea to keep all the related work in different worksheets of the single workbook. So, it can be
safely said that a workbook is a binder and the worksheets are its sheets. A worksheet can be
moved from one workbook to another.

Student Activity 13

1. What is an electronic spreadsheet?

2. Name some popular spreadsheet packages.

3. How will you start MS-Excel?

4. Describe various screen elements of MS-Excel.

5. Differentiate between a workbook and a worksheet.

2.18 WORKING WITH DOCUMENTS

In order to work in EXCEL, you have to either open an existing file or create a new one. So let us
find out how to create, open, save and finally close files.

Creation of a New Workbook

EXCEL offers a variety of ways by which new workbooks can be created. So, for creating a new
workbook, you can follow anyone of the methods discussed below:

1. A new workbook can be created by clicking at the ' File' menu and then selecting the New'
option.

2. You can also open a new workbook by clicking at the 'New' button available on the standard
toolbar.

3. If you are a keyboard person, then don't feel disappointed. Pressing <Alt+F+N> keys
together will also achieve your work of creating a new workbook.
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If your document is stored on any of the storage device like hard disk or floppy disk, then it
becomes possible to retrieve that document. EXCEL offers a number of ways to open your
document which are discussed below:

1. Click at the 'File' menu and select the option 'Open'.

2. Alternatively, for opening a document, just double click at the 'Open' button available on
the standard toolbar.

An 'Open' dialog box appears on the screen as shown in Figure 2.72. In this 'Open' dialog box you
would notice a 'Look in' box which is used for selecting the drive as well as the folder where your
workbook has been stored. Double-click the folder to see the workbooks under it. From the 'Files
of type' box, select the kind of file that you want to open. Suppose you want that only the EXCEL
documents should be shown in the file list then click at the pull down arrow and from the drop
down list, select 'Microsoft Excel Files' option. Finally click the workbook name in the file list and
click at the <Open> button or double click the workbook name to open it up.

Saving a Workbook

A workbook should be saved properly before closing it or quitting EXCEL for its future retrieval.
Once all the text is entered, save the document with any of the following methods:

1. Click at the 'File' menu and then select 'Save' option.

2. The other way of saving your files is by clicking at the 'Save' button available on the
standard toolbar.

When the workbook is being saved for the very first time, the 'Save as' dialog box comes up
because EXCEL needs some additional information from you. EXCEL wants you to give a name to
your workbook. If you want to save your workbook with a name that is already given by EXCEL,
simply click at the <Save> button. However, if you want to give some other name, then erase off
the existing name from the 'Filename' box and give a new name to the workbook.

The 'Save as' dialog box is displayed only once till the time you don't give a name to your
workbook. Once the workbook has a name, next time if you try to save your file after making a few
changes in it, then the 'Save as' dialog box will not appear on the screen. So, if you intentionally
want to change the name of your workbook, select the Save as 'option from the File' menu.
Replace the name of the workbook with a new name in the 'Filename' box. It will create two copies
of the same workbook—one with an old name and the other with a new name that you have just
given. It's a good idea to keep saving your workbooks after every few minutes. The reason is if the

Figure 2.72: The ‘Open’ Dialog Box
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computer goes down or a power failure occurs, then the chances of recovering something in the
document are high. Unsaved new documents are the most vulnerable.

Closing a Workbook

It. is extremely easy to close workbooks in EXCEL. So, for closing a workbook, click at the File
'menu and select the Close' option. If you have made any changes in your workbook after saving
it, then EXCEL prompts you to save your workbook before closing it. Thus, if you want that your
workbook should be saved before it is closed, then click at <Yes> button otherwise hit the <No>
button in the dialog box that appears next. A case may arise when you want to continue working
in the same document after issuing 'File\Close' command. Select the <Cancel> button. It will allow
you to work again in your document thus cancelling the issued command.

Exiting Excel

EXCEL offers a large number of methods for shutting itself down. You can follow any of the below
mentioned approaches:

1. Click at 'Close' button present in the upper right corner of the title bar.

2. Select 'Exit' option from the 'File' menu.

3. Press <Ctrl + W> keys together.

EXCEL will close all the currently opened workbooks on its own. EXCEL wants you to play a safe
game. It will again prompt you to save your files before quitting like it did while closing your
workbook.

2.19 DATA ENTRY AND EDITING

A cell contains the data entered by you. At any time, one cell is always highlighted which is called
the currently active cell. The address of this currently active cell is shown in the 'Name' box which
lies in the upper left corner of the screen, exactly above the column letter A. You can place your
data in any portion of the worksheet. Take your cell pointer at a place wherever you want to put
your data with the help of either the mouse pointer or arrow keys. Enter the data. Once you have
finished typing in the current cell, press <Enter> key. Now, to go to the next cell, either click it with
the help of mouse pointer or move to that particular cell with the help of arrow keys. Similarly, in
order to select a group of continuous cells, take your mouse pointer at the cell from where you
want your range to start. Click at that cell and then drag your mouse pointer diagonally to the
opposite corner. Release the mouse pointer when the desired range is made. All the cells in the
range become highlighted.

Inserting Text

Generally, when you startup EXCEL, it is in the Insert Mode, which means as text is typed in, the
following text is pushed towards the right side. So, if you are only interested in putting new text in the
cell then, take your cursor at that particular location of the cell and start typing in.

Sometimes, old text has to be replaced with new text. Take your cursor at a place wherever any
change has to be effected. Type in the new contents and erase off the existing contents with the
help of <Del> key. However, if the EXCEL is in the 'Typeover' mode, then the old contents are
automatically replaced with the new contents. If you want to put yourself back to the insert mode,
press the <INS> key once from the keyboard.

Editing the Cell Entry

Many a times, the contents entered in a cell have to be modified and new contents are required to
be put in it. So, for making changes in the cell entry, first take your cell pointer to that particular
cell. Then, hit the <F2> key or double-click at that cell with the help of mouse pointer. Make the
necessary changes and press the <Enter> key again.
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The contents of a cell or range of cells can be moved as well as copied to some other location in
the worksheet. Copying cells mean duplicating the contents of a cell or range of cells at some
other desired place. Moving text means removing text from one portion of the worksheet and
placing it at some other location. The procedure for copying and moving text is almost the same
with a little difference. For copying cell contents, follow the steps given below:

1. Select a cell or range of cells.

2. Press <Ctrl + C> keys. Alternatively, select the 'Copy' option from the 'Edit' menu.

3. Take the cursor to the cell wherever you want the text to be pasted.

4. Hit <Ctrl + V> keys. Alternatively, select the 'Paste' option from the 'Edit' menu.

You can also use the 'Copy' and 'Paste' button available on the standard toolbar for copying and
pasting text. On similar grounds, for moving the cell contents, select the 'Cut' option instead of
'Copy' from the 'Edit 'menu. Rest of the steps are the same as that of copying cell contents.

Deleting Text

A passage of text can be very easily erased by selecting it and pressing <Del> key from the
keyboard. You can also delete a single character by positioning the cursor at that particular
character and hitting the <Del> key.

If you want to scrap off only a single word from your document, select the word by double
clicking it and hit the <Del> key. You can also delete words by following commands:

l Press <Ctrl + Del> keys to delete next word.

l Press <Ctrl + Backspace> keys to delete previous word.

Inserting a Row

In order to insert a new, blank row in between two rows, follow the steps given below:

1. Take the cursor where a new row has to be inserted.

2. Select ‘Rows’ option from the ‘Insert’ menu. A blank row will be inserted above the current
row.

Inserting a Column

To insert a blank column, the steps given below can be followed:

1. Take the cursor where a new column has to be inserted.

2. Select ‘Columns’ option from the Insert menu. You will find a new blank column inserted to
the left of the current column.

Deleting a Cell or Group of Cells

In order to delete a single cell or group of cells, follow the steps given below:

1. Select the cell or range of cells that is to be deleted.

2. Right click your mouse button.

3. Choose the 'Delete' option from the menu that appears.

Clearing the Contents of a Cell or Group of Cells

To clear or erase off the contents of a single cell or group of cells, carry out the steps given below:

1. Select the desired cell or range of cells from which the contents are required to be cleared.

2. Right click the mouse button.

3. Choose the 'Clear Contents' option from the popup menu that appears on the screen.
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Clearing the contents of a single cell or range of cells is different from deleting them. When you
clear a cell or range of cells, the contents are erased, leaving the cells blank. However, when a cell
or cell range is deleted, the other cells re-adjust themselves to fill in the empty space created by
deleting them.

Changing the Row Height

You can change the overall look of the whole workbook. You may require to change the height of
a row for adjusting text in case a larger font size than default is applied onto it. So, if the font size
is made larger than the cell height, then some part of the text might be hidden. Now, to change the
height of rows, the steps given below can be applied:

1. Select the row whose height has to be changed. This can be done by either clicking in any
cell of that particular row or by clicking at the row header.

2. From the ‘Format’ menu, select the 'Row' option. Then, choose 'Height’.

3. Enter the height of the cell that you want to achieve.

In order to change the height of a group of rows, select all those rows. From the 'Format' menu,
select the 'Rows' and then the 'Height' option. Key in the desired row height. All the selected rows
will have the same row size.

Changing the Column Width

On similar grounds, the width of a column can also be altered. Column width can be re-adjusted
according to your own special requirements. Thus, for changing the column width, carry out the
steps given below:

1. Select the whole column either by clicking at the column header or by clicking at any cell of
that particular column.

2. From the ‘Format’ menu, choose the 'Column' option. It will display a 'Column’ Width dialog
box on the screen.

3. Type in the new column width. Finally, click at the <OK> button.

2.20 TYPES OF CELL ENTRIES

EXCEL can very smartly make out the type of data as you type in. You can key in values and
formulae from the keyboard. Values can contain text, numbers or special characters. The formulae
can perform calculations based on the values present in other cells. You can apply any font type,
size .and alignment pattern on these values. Let us discuss the different types of cell entries in
detail:

Text Values

We can put both text and numbers in a cell. Any entry that contains text, numbers or any special
character is recognized as a text entry. A text purely in alphabets is mostly used for giving titles
and identifying information such as Salesman Name; Sales (pieces); etc. Generally, a text entry is
given at the top and left side of the worksheet. A number entry can be formatted to text in a case
when no mathematical calculation is required on it. By default, a text entry is left aligned. Looking
at the alignment of the entry, you can easily make out the category in which EXCEL has placed
your data. In order to apply any particular type of format on your data, select the cells and activate
"Cells" option from the "Format' menu. Choose any of the formats to apply it on the selected text.

Numeric Values

Any entry is treated as a numeric value if the first character entered, is a number or a mathematical
operator such as + or –. Numbers are typed directly. A numeric value can contain any of the
following characters:

0 1 2 3 4 5 6 7 8 9 + - (  ) ,  / $ % . E e
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upon the kind of presentation you require. EXCEL has some pre-defined formats for each kind of
numeric value.

Formulae

EXCEL offers a very powerful tool to use existing data values to calculate new values. Formulae
establish relationship between two or more cells. It performs a mathematical or arithmetical
operation on these data values. The formula can contain numbers as well as cell addresses and
can be created using the arithmetic operators like + (addition), – (subtraction), *(multiplication),
/ (division) and ̂  (exponent). The formula entry can be made by beginning the entry with a +, @
or = sign. While entering a formula, key in an opening bracket followed by cell address. It must
end with a closing bracket.

Let us now create a simple worksheet and learn how to put labels, values and formulae in it. Follow
the steps given below:

1. Take your mouse pointer to the cell C2 and type in "RUBY BAKERY PRODUCTS". Then,
press the <Enter> key.

2. Go to the cell D3 either with the help of arrow keys or by clicking it with the mouse pointer.
Thereafter, enter "Jun-98". Press the <Enter> key. Similarly, typein "Jul-98" in the cell E3 and
again hit the <Enter> key.

3. Similarly, enter all the data as shown in Figure 2.73.

4. Now, we want to find out the total sale for the month of Jun-98. This requires the entering
of a formula in the cell D9. So, take your cell pointer to the cell D9. The formula entry shall
begin with a + sign or an opening parenthesis.

Figure 2.73: An Example of a Single Worksheet

5. The formula can be entered by two methods:

(a) The first approach is to type in the cell addresses in the cell where you want to see the
result of the formula (like +D4+D5+D6+D7+D8) as shown in Figure 2.74 and then press
the <Enter> key. You will find the result of the formula at the cell address D9.
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Figure 2.74: Figure Showing the use of a Formula

b) The second way of entering a formula is by Pointing method. In this method, first of all,
enter a + sign in the cell where the formula is required (here, in our example the cell
address is D9). Then, move the cell pointer to the cell D4. You will find this cell address
appearing automatically at the cell D9. Thereafter, typein the + sign again. Move the
cell pointer to the next cell. Keep repeating it till the complete formula is keyed in.
Finally, hit the <Enter> key. Now, you will find the result of this formula at the cell D9 as
shown in Figure 2.75.

Figure 2.75: Figure Showing the Result of a Formula

2.21 COMMONLY USED FUNCTIONS
EXCEL offers a variety of in-built functions which are very easy to use. These functions simplify
operations like finding out sum, average, maximum, minimum, count and so on. All these functions
start with the @ sign. The syntax of a function is given below:

@FUNCTION-NAME<RANGE OF CELLS>

where,

FUNCTION-NAME is the name of the standard in-built function as offered by EXCEL and <range
of cells> specifies the cell range on which the action of the function has to be performed. Let us
discuss some of these functions one by one. We will take the example of the workbook as shown
in Figure 2.76 in explaining these functions.
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This function adds the values of the cells specified in the range. For example:

@SUM(D4:D8)

It would show the added up value of the cells D4,D5,D6,D7 and D8 as 210.

The @AVG( <range of cells> Function

The @AVG function finds out the average value of the cells given in the range of cells. For
example:

@AVG(D4:D8)

It would display the average value of the cells D4 through D8 as 42.

The @MAX( <range of cells> ) Function

The @MAX function determines the greatest value out of the specified range of cells. For
example:

@MAX(D4:D8)

It shows the highest value, 71, contained in cells D4 through D8.

The @MIN( <range of cells> Function

The @MIN function ascertains the smallest value amongst the range of cells provided to it. For
example:

@MIN(D4:D8)

It will give the result 13 because this is the smallest value contained in cells D4 through D8.

The @COUNT( < range of cells> ) Function

The @COUNT function counts the number of entries in the given range of cells. For example:

@COUNT(D4:D8)

It will give back the answer as 5 since there are five entries in the above specified range. This
function can be useful if you want to find out the number of entries made in a particular range
especially when the worksheet is very big.

2.22 ABSOLUTE AND RELATIVE CELL REFERENCING

You can very well copy formulas in EXCEL. As and when a formula is copied, the cell references
in the new formula are changed. The new formula corresponds to the position it was in relative to
the original formula cell. Let us once again concentrate ourselves on the Figure 2.74. Now, if we try
to copy the formula given in the cell address D9 to D10, then the formula is going to become
=E4+E5+E6+E7+E8. This is called Relative Referencing. In this case, since the references are
relative, the formula automatically adjusts with the new value. However, sometimes you may
require to make the reference absolute or fixed. This means that when the formula is copied to
some other destination, then the formula should not change. This is called Absolute Referencing.
Absolute Referencing can be enforced 'by preceding the row or the, column letter with a ($) dollar
sign like $D$5. Now, when you try to copy this reference ($D$5) to any place in your workbook,
then the reference is not going to change. An absolute reference works well for a constant that
can be used in a formula stored in a cell. If the row letter is preceded with a dollar sign, then only
the row is fixed e.g., D$5. When D$5 is copied to some other location then, the column letter is
going to take the new reference address but the row number would still remain 5. In the similar
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manner, column letter can also be preceded with a dollar sign e.g. $D5. This will make the column
fixed while copying but row is going to take the new reference.

2.23 NUMBER FORMAT

EXCEL has got some pre-defined formats that can be applied to numbers. These number formats
differ in terms of number alignment, placement and other accompanying symbols with it. When
the number format is applied to cells, the numbers are rounded off to the specified number of
decimal places. As and when the numbers are rounded off the change is reflected only on the
screen. However, in memory the actual form is stored. At the time of performing calculations, the
actual number stored in memory is used. For example, if you round off two numbers 5.6 and 3.2 in
two different cells, the display on the screen will be 6 and 3. However, if you try adding up these
two numbers, the sum that will be shown on the screen is 9. The Table 2.4 shows the different
types of formats that can be applied to numbers.

Table 2.4: Pre-defined Number Formats

Any of the above mentioned formats can be applied to either a single cell or range of cells before
or after typing in the value. In case, any specific format is applied to blank cells, then any entry
that is typed in those cells will be automatically converted to the selected format. Let us proceed
further and learn how to apply a few formats. In order to format numbers, follow the steps given
below:

1. Select the cells that need be formatted.

2. From the 'Format' menu, choose cells option. A 'Format Cells' dialog box appears on the
screen.

3. Click at the 'Number' tab.

4. Select the format that you want to apply.

5. Finally, click at the <OK> button.

Autofill

Autofill tool offered by EXCEL helps you to repeat a cell entry. It looks at the series entered by
you in adjacent cells and tries to complete it for you. For example, if you want to enter the labels
for all the twelve months of a year simply, type in first two entries, i.e., Jan. and Feb. in two
adjacent cells. Then, highlight both the cells by selecting them. Take your mouse pointer at the
bottom right corner of the selected cells. Your mouse pointer is going to take the shape of a +
(plus) sign. This plus sign is called Autofill handle. Drag your mouse pointer either across or
downwards for those many cells till you wish to continue the series. Autofill keeps filling the
series till the time the mouse pointer is dragged. So, you are saved the effort of keying in the labels
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Autofill, you can drag the mouse pointer up, down, right or left. Look at some of the examples of
sequences that the Autofill feature can identify:

Figure 2.76: The 'Autofill' Handle

(i) Monday, Tuesday.....
(ii) 10, 20, 30.....
(iii) 1, 2, 3.....
(iv) AI, A2, A3....
(v) 5:10, 5:20....

Figure 2.77: Figure Showing the Output given by 'Autofill' Handle

Student Activity 14
1. How will you create a new workbook in MS-Excel?
2. How will you save a workbook in MS-Excel?
3. How will you edit a cell entry?
4. How will you delete text from a cell?
5. How will you insert a row or a column in a worksheet?
6. Describe various types of cell entries.
7. List some commonly used functions in MS-Excel.
8. Describe absolute and relative cell referencing.
9. What is the function of Auto fill option in MS-Excel?
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As the common saying goes 'A picture is worth a thousand words' is found true by almost all of
us. Any kind of message can be best said and understood through its representation in pictorial
form. A chart or a picture gives a bird's eyeview of the entire scenario in a single look. So, let us
see how we can utilize the EXCEL's power of making charts. EXCEL supports many different
kinds of charts according to the vast and varied needs of the user. EXCEL also allows you to link
your charts with your data. So, as and when some changes are made to the data, these are
automatically reflected in your chart.

Figure 2.78: Figure Giving an Example of a Worksheet

A typical worksheet showing data arranged in rows and columns can be safely used for creating
charts. Thus, enter data in a tabular form with proper row and column headings. EXCEL is very
good at figuring out an appropriate chart on its own.

Let us first of all create a worksheet with the data given in Figure 2.78. This figure gives the
number of sales made by each salesman in a particular month.

To create a chart, select one of the cells in the table and press F11 key. EXCEL would automatically
create a chart for you as shown in Figure 2.78. This is the easiest way of creating a chart.

Let us find out how to create charts using Chart Wizard. A wizard is a tool offered by EXCEL
which takes you through a series of steps to complete a particular process. So, while working
through a wizard, it shows a dialog box which asks for more information. You can either accept the
default settings or you can give in your own information according to your requirement. Thus, to
create a chart using the data given in Figure 2.78, let us begin by selecting a cell within the table.

Step 1 of the Chart Wizard

Figure 2.79: Step 1 of the Chart Wizard
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on the standard toolbar. The second approach is to select the 'Chart' option from the Insert menu.
A dialog box shown in Figure 2.79 appears on the screen.

Select the 'Standard Types' tab. Now, select the kind and type of chart into which the data has to
be converted from the 'Chart Type' box. Then, select the chart sub-type from the adjacent window.
Finally, click at <Next> button.

Step 2 of the Chart Wizard

A dialog box as shown in Figure 2.80 appears on the screen. This dialog box gives you an
opportunity to decide the data orientation (i.e., which data label has to be shown on the bottom
axis of the chart). In our sample data, we have two labels ‘Salesman Name' and 'Sale'. If you want
that the 'Salesman Name' should come along the bottom axis and the 'Sales' along the left axis,
then click at 'Columns' radio button. However, if you want to change the orientation, click at the
'Rows,' radio button. This will make 'Sales' come along the bottom axis and the 'Salesman Name'
along the left axis.

Figure 2.80: The 'Source Data' Dialog Box

Data range included in the chart can be changed very easily. Click at the 'Collapse' dialog icon
which appears at the end of the 'Data Range' text box. A collapsed dialog box appears on the
screen as shown in Figure 2.81. This will make your worksheet apparent again. The data that has
been selected for creating a chart is shown by dashed lines. In case, you want to use a different
data range, then you can select that particular data from here. Click at the 'Expand' dialog icon
which is located at the right corner of the collapsed dialog box to go back. Now, you have the
desired range and orientation. Click at the <Next> button.

Figure 2.81: Step 2 of the Chart Wizard

Step 3 of the Chart Wizard

A dialog box as shown in Figure 2.82 appears on the screen. Click at the 'Titles' Tab. It will label
your chart and its axis. In the 'Chart Title' box, give any label. In our example, the appropriate label
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that can be given to our chart is 'Month-Wise Sales Report'. In the Category (X) axis, provide a
label for the X-axis. In the similar manner, issue a label for the Y-axis in the Value (Y) axis text box.

You can change the overall look of the chart by making other changes in the default settings. Hit
the 'Axes' tab to control the labels for the value on the axes. The 'Gridlines' tab can be used to get
rid of gridlines entirely. This will make your chart free from any gridlines. You can make the grid
look finer or show it in any one direction. The 'Legend' tab can help you in deciding the placement
of legend box on the screen. With the 'Data Labels' tab, you can decide whether the actual data
numbers (in our example Sept, Oct, Nov, ) and the corresponding data labels (like Salesman Name)
are to be displayed or not. The 'Data Table' tab helps you to specify whether or not a formatted
table of the data is to be included along with the actual chart or not. Finally, click at the <Next>
button after making all those desired changes.

Figure 2.82: Step 3 of the Chart Wizard

Step 4 of the Chart Wizard
This is the last step in the process of chart creation. All the necessary details required by the chart
are given in Step 1 through Step 3. The fourth and the final step asks you whether the chart is
going to be displayed in the worksheet where the data is located or in a separate worksheet. So,
in this last step as shown in Figure 2.83, you have to decide whether the chart is to be embedded
as an object in a worksheet or it is to be placed in a separate worksheet. Let us find out the
difference between these two types of charts:

Figure 2.83: Step 4 of the Chart Wizard
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Figure 2.84: Different Components of a Chart

1. Embedded Charts: These charts can be linked to the data based on which the chart is
created. So, if any changes are made to the data, the corresponding chart also changes.

2. Chart Sheets: These charts can also be linked to the data. The only difference is that these
charts are placed in separate worksheets. The chart is put in the middle of the new worksheet.
It leaves very little scope of moving the chart.

Finally, click at the Finish.

The different components of a chart are shown in Figure 2.84.

2.25 MACROS

The very word 'Macro' gives the impression of a huge big giant. Macro is not the hero of a horror
movie but a small program that carries out pre-defined and prerecorded series of steps by giving
a few keyboard shortcuts. So, we can state that a macro is like a recorded movie which can be run
any number of times. Macro is just a way of doing your work in a series of steps which it carries
out automatically once it is triggered. It can be very easily said that a macro is like a batch fie
created in DOS. It contains a series of commands. So, as and when a macro is called and run, the
instructions given in it are executed one by one.

A macro automates your tasks, thus saving a lot of your precious time. ‘Macro’ can just do
anything for you. Your imagination can be the only limitation to it. EXCEL offers macros in two
languages, Excel Visual Basic and Excel 4.0 Macro language. You can use either language to
create macros but Excel Visual basic is more difficult to use. Moreover, you also need know Excel
Visual Basic language itself. So, throughout our session, we would concentrate on learning how
to create macros using Excel 4.0 macro language.

Creating and Naming a Macro

A macro is very easy to create. Before proceeding further, first decide the steps that your macro
is supposed to carry out. Suppose you want to write a macro that would cut a range of cells and
paste it at some other location. Thus, in order to create a macro, carry out the following steps:

1. Select 'Tools\Macro' option from the main menu.

2. Select 'Record New Macro' option from the cascading menu. It would display 'Record
Macro' dialog box as seen in Figure 2.85.
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3. Name the macro under which you want to save it. Name to a macro can be given in 'Macro
Name' box. A long name upto 255 characters can be given to a macro. However, you cannot
include spaces in your macro name. Your macro name can have only numbers, letters and
underscore character. But There is one limitation to it. The macro name cannot start with a
number or an underscore character.

Figure 2.85: The 'Record Macro' Dialog Box

4. After assigning a name, you are required to give a keyboard shortcut to it. Giving a keyboard
shortcut is absolutely at the discretion of the user. A keyboard shortcut is assigned only if
the user wants to execute the macro using a keyboard. However, if any lowercase alphabet
is given in the 'Shortcut key' box, then the macro can be executed by pressing the <Ctrl +
'alphabet'> keys together. However, if an uppercase alphabet is used, then you need press
<Shift + Ctrl + 'alphabet'> keys together. Suppose you give the alphabet 'C' in the 'Shortcut
key' box, then this macro can be activated by pressing <Shift Ctrl+C> keys together. On the
contrary, only if 'c' in the 'Shortcut key' box is given, then in that case, the macro can be
activated by pressing <Ctrl + C> keys only.

5. Now, we proceed on to the 'Store Macro in' box. If you want to use the macro that you are
now trying to create in the current workbook only, then select the option 'This Workbook'
from the drop-down list. However, if you want to make your macro available to other
workbook, then select 'New Workbook' option from the drop down list.

6. In the 'Description' box, give some relevant and important details about your macro like the
date on which macro was recorded, the owner of the macro, the purpose for which the
macro has been created, etc. Thus, any kind of descriptive text can be given in this box. It
enables you to remember all the important things about your macro.

7. Now, as and when all the relevant details are filled in the 'Record Macro' dialog box, click at
the <OK> button. A very small 'Stop Recording' toolbar will appear on the screen. Till this
point of time, we have only told Excel that we want to create a macro. It is actually now when
the process of recording starts.

Recording the Macro

You can now proceed on to record your macro. Just perform all the essential steps to complete
your particular task. For this example, in which we have to cut a range of cells and paste at some
other location, do the following steps to record them in your macro:

1. Select the range of cells that has to be cut.

2. From the Edit menu, select the 'Cut' option.

3. Take your cursor at a location where you want to paste this range of cells.

4. Again, from the 'Edit' menu, select the 'Paste' option.

5. Click at the 'Stop Recording' button available on the 'Stop Recording' toolbar.
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worksheets of the current workbook. However, if you want this macro in other workbook, then
select 'New workbook' option in the 'Record Macro' dialog box. Don't forget to click at the 'Stop
Recording' button once all the necessary steps to be included in the macro are over. Otherwise
your macro is going to become unnecessarily big with unwanted steps in it.

Saving the Macro

The macro that we have just created in our previous example is made available only to the current
workbook. But, if you want that this particular macro should be made available to other workbook,
then choose 'New Workbook' option in the 'Record Macro' dialog box. EXCEL will then ask you
the name of the new workbook in which the macro has to be saved.

Using a Macro

Till this time, we were on our path of creating a new macro. Now, let us learn how to run or execute
a macro. You can run your macro in any of the following ways:

1. If a shortcut key has been assigned to your macro, then it can be activated by pressing
<Ctrl+'key'> or <Shift+Ctrl+'key'> depending upon the case of the 'key'.

2. A macro can also be run by selecting 'Tools\Macros\Macros' from the main menu. Then,
click at the macro name that you want to execute. Once the macro starts running, you can
stop it abruptly in between by pressing the 'Esc' key.

Deleting a Macro

If a macro is no longer needed, then it is advisable to delete it. In order to delete a macro, click at
the 'Tools\Macro\Macros' option from the main menu. A 'Macro' dialog box appears on the
screen. Select the macro that has to be deleted. Finally, click at the <Delete> button to complete
the process.

Editing Macro Options

Many a times, a macro requires some changes to be made to it. You can change the shortcut key
or description that has been given to the macro. Thus, in order to make changes to your macro,
click at the 'Tools\Macros \Macro' option of the main menu. A 'Macro' dialog box appears on the
screen. Click at the <Options> button to show the 'Macro Options' dialog box. Make all the
necessary changes and finally click at the <OK> button.

2.26 IMPORTING AND EXPORTING FILES

EXCEL allows you to import data from databases created by other programs such as Lotus 123
and dBase. So, this makes reading from and writing into files created by other spreadsheet and
database programs possible. It can help you in sharing information with other spreadsheet programs
like Lotus 123, Quattro Pro or Multiplan. EXCEL takes all the responsibility of converting files
from other worksheet database programs automatically as and when the file is either saved or
opened. The 'File\Open' command reads the file extension of the files created by other programs.
In the similar manner, when you try to save files, the 'File \save as' option helps you to save your
file in other types also. Files can be exported by clicking at the desired file and then selecting a
required file type in the 'Save as' dialog box. Files can also be imported which are created by
various versions of dBASE and Lotus 123. You simply have to pick the file using "File\Open"
option. EXCEL can also open plain ASCII text files. Let us import the file 'Shruti.Txt'. Start the
EXCEL program first and display a blank workbook.
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Figure 2.86: Step 1 of Text Import Wizard

1. Open the file 'Shruti.txt' by selecting 'Open' option from the 'File' menu. Figure 2.86 appears
on the screen.

2. Click at the <Next> button.

3. A dialog box by the name 'Text Import Wizard Step 2 of 3' appears on the screen. It guesses
where the columns should be put as shown in Figure 2.87.

Figure 2.87: Step 2 of Text Import Wizard

4. In case you want the columns to appear at some other place, then move the line by clicking
it and then dragging it. You can also remove a line in case you do not require it by double-
clicking at that particular line. Then, click at the <Next> button.

5. A 'Text Import Wizard Step 3 of 3' is shown on the screen as can be seen in Figure 2.88. This
dialog box allows you to set the Data Format for each column. You can also leave the data
as it is without changing the data format. Finally, click at the <Finish> button.



121

PC-Software Packages

Figure 2.88: Step 3 of Text Import Wizard

2.27 PRINTING A WORKBOOK

There could be a number of reasons for taking a printout of the workbook that you have just
created. You may  be required to give the yearly status of the overall working of the company to
your boss or you may want to keep a copy of the workbook for your own future reference. EXCEL
offers a very easy way of printing the workbook. You can very well control the overall look of the
whole printout and modify it to suit your own special requirements. You can preview your document
before taking a final printout. It will give the overall look of how your printout is actually going to
look on paper. So, for previewing the workbook, activate the 'Print Preview' option of the 'File'
menu. The Figure 2.89 shows a preview of a worksheet. Now, after previewing the workbook, you
are ready to take a printout. So, proceed with the steps given below:

Figure 2.89: Figure Showing Preview of a Worksheet

1. Open the file whose printout has to be taken.

2. From the 'File' menu select the 'Print' option. A 'Print' dialog box appears on the screen as
shown in Figure 2.90.

3. Choose the printer that you want to use out of all the installed printers on your system from
the 'Name' drop down list.
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4. You can select the pages of the workbook you want to print. Through the 'Print range'
option of the 'Print' dialog box. For example, if you want to take a printout of all the pages of
the current workbook, then click at the 'All' radio button. But sometimes, you require only
selective pages to be printed. For that matter, click at the 'Pages' radio button and type in the
starting number of the page in the 'From' box. Similarly, enter the page number till which the
printout has to be taken in the 'To' box.

5. Enter the number of copies you want to print in the 'Number of Copies' box.

Figure 2.90: The 'Print' Dialog Box

6. The 'Print What' option lets you to decide in printing, either the selected portion of the
worksheet or the whole workbook or just the active sheet(s).

7. You can also see the preview of the workbook by clicking at the 'Preview' button.

2.28 APPLICATION OF A SPREADSHEET IN
CORPORATE  SECTOR

Electronic spreadsheets contribute a lot in the day-to-day working of corporate sector. All the
managerial reports, price lists, etc., are prepared with the help of electronic spreadsheets. It helps
the management to take quick decisions. It is able to answer the important 'what if' questions of
the managers based on which they can design and develop various marketing and sales strategies.
These days almost all the managers make use of spreadsheets extensively.

Student Activity 15

1. What is a chart?

2. How will you create a chart using chart wizard?

3. What is a chart sheet?

4. What are embedded charts?

5. What are MACROS?

6. How will you create and record a macro?

7. How will you import an access file in a worksheet?

8. How will you print a workbook?

9. How will you save a micro?

10. What are the applications of a spread sheet in corporate sector?
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An operating system is an integrated set of specialized programs that is used to control and
manage the resources and overall operation of a computer system.

DOS is the most commonly used operating system. Loading of DOS into the main memory is
known as booting. DOS commands are of mainly two types: internal and external. Internal commands
are directly interpreted by the command processor, command.com. External commands are
interpreted with help of external files (with extensions.com or .Exe)

Storage areas on a disk are known as directories. A directory may contain files and/or sub-
directories inside it. The full name of a file or a directory (including path) is called pathname.

Wildcards special characters carrying special meaning. Two MS-DOS wildcards are‘?’ and ‘*’
The '?' can replace exactly one or none characters in a name. The '*' can replace number of
characters in a name.

Some DOS internal commands are copy, DEL/ERASE, REN, TYPE, DIR, CHDIR/CD, MK, DIR/
MD, RMDIR/RD, BREAK,CLS, DATE, PATH, TIME, PROMPT, etc. Some external commands are
DISK COMP, DISKCOPY, FORMAT, LABEL, PRINT, XCOPY, etc.

Batches of MS-DOS command stored under a filename with extension. BAT are known as Batch
files. The batch files with the name AUTOEXEC.BAT is automatically executed by
MS-DOS at the time of booting.

MS-windows is a GUI based operating system. In windows operating system, multiple applications
can be simultaneously run in different windows. In MS-windows, the screen upon which icons,
windows, etc., are displayed is known as desktop.

You can explore you computer through start button and taskbar, my computer and window
Explorer. The taskbar is a bar, which is usually located at the bottom of the screen. The start
button is located at taskbar. By clicking at start button, start menu appears wherefrom you can
start program, open document, customize you system, get help, search for items on your computer
and more.

Windows Explorer is another way of seeing what is on your computer. Windows explorer shows
the computer's contents as a hierarchy. The programs available under Programs section of start
menu can be started by clicking at start, then at programs and then at the desired program or
group. To quit an open program, just check at close button (X). A folder is a location in which you
can store files and other folders.

To create new folders start→find→folder commands are clicked in my computer window. To find
files or folders, start→find→files or folder commands are clicked. To rename a file, firstly the file
icon or name is selected and then file-Rename commands are clicked. To move a file, the file icon
or name is firstly selected, then edit→cut commands are clicked. Then the destination folder is
opened in a My computer windows and there Edit→paste commands are clicked.

To copy a file, firstly, the file icon or name is selected, then Edit→Copy Command is clicked the
destination folder is opened in a My computer window, and there Edit→paste commands are
clicked. To delete a file, a folder, firstly select the file icon or name and then either click Delete key
or click File→Delete commands. To create a shortcut to a file, firstly select the file or folder,
whose shortcut is to be created. Then drag the file icon through right mouse button to desired
location where shortcut is to be placed. And then select create shortcut. To shut down the
computer,  Start→Shut down commands are clicked.

A database refers to the collection of interrelated data and database management systems (DBMS)
is a computer program that manager a database effectively and efficiently. MS-Access offers
many features like tables, forms, queries, reports and data access pages to manage data, A new
database can be created either through wizard or by clicking File→New command or New button
or by pressing ctrl+N. While designing tables, you have to decide about field names, field types,
field size, field properties and primary key.
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At field level these validation techniques maybe used: Input mask, validation Rule and Text,
Default Value, Allow Zero Length, Required and Lookup values. The input Mask property specifies
and controls how data is entered and displayed.

A word processor is a package that processes textual matter and creates organized and flawless
documents. The word processor offers very useful features like speed, powerful editing and
formatting features, permanent storage, Graphics, object linking and embedding spell check and
mail merge etc.

Tables can be inserted in a word document through Table button of Standard toolbar and can be
manipulated through the Table drop down menu. Also word provides quite many drawing features
that can be used to include the desired graphics in  the document.

A spreadsheet is a software tool that lets one enter, calculate, manipulate, and analyze set of
numbers. A worksheet is a grid of cells made up of horizontal rows and vertical columns. A
worksheet is a group of worksheets. Three types of data can be entered in a Worksheet (i) Number
(ii) Text, (iii) Formulas, charts are the pictorial representation of worksheets data. Various chart
types in MS-Excel are: areas chart, column chart, bar chart, line chart, pie chart, XY (scatter) chart.

Chart in MS-Excel are saved in two ways: (i) embedded chart (ii) Chart sheet. Embedded chart is
a chart object that is placed on a worksheet and saved with that worksheet. Chart sheet is a sheet
in a worksheet that contains only a chart.

2.30 KEYWORDS
Alignment:  It refers to the way the right and left edges of a paragraph line up along the right and
left margins of your document.
Autocorrect:  It is a feature of the MS-Office package that corrects automatically when a word is
typed with wrong or nearly wrong spellings. The correction is made according to the list of
correct and incorrect words is provided.

Bullet:  A paragraph marker, usually indented to list paragraphs point wise.

Clipboard:  Space in the memory where an MS-Office application stores data, objects etc.,
originating from cut and/or paste actions.

Cursor:  Cursor is a pointer, which tells where on the document the action will appear or affect. The
cursor can be moved and placed anywhere on the document using pointing device like mouse.

Font:  It is a set of a typeface and its style.

Indentation:  It is the space left within the margin of a page.

Scroll Bars:  They are sliding narrow bars with arrows at the ends and a slider in between, used
to scroll through an active pane of a window. Two types available, according to their orientation
- Horizontal Scrollbar and Vertical Scrollbar.

Status Bar:  It displays the positioning of the cursor, displays the status of some important keys
of keyboard, shows the messages for the toolbar mouse points to it, displays messages for menu
option when a menu option is selected or pointed out by a user.

Style:  It is a set of formatting characteristics that can be applied to text in document to quickly
change its appearance.

Title Bar:  Title bar shows the name of the document and is situated in the top of the window
application.

Toolbar:  Toolbar is a container of various tool buttons.

View Buttons:  View buttons are shortcuts of various views in the View Menu, placed adjacent to
the horizontal scroll bar. These buttons select different ways the document can be viewed.
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Block:  It is a selected piece of text, graphics and other objects to be treated as a unit.

MS-Excel 2000

Absolute Reference:  Address of a cell or a range of cells with no reference to other cell  in terms
of row and column addresses.

Cell:  A Cell is a box at the intersection of a row and a column in a worksheet where data is stored.
There are 65536 x 256 = 16777216 cells in a single worksheet.

Column:  Columns are combination of all the vertical cells joined together in a single vertical line.

Fill Handle:  The small black square in the corner of the selection of a cell or range, which changes
to a black cross pointer when placed at the corner of selection.

Formula Bar:  Formula bar shows the formula instead of the result, if there is one present in the
current cell.

Formula:  It is an expression that performs operations on worksheet data. Formulas can perform
mathematical operations, such as addition and multiplication.

Full Screen View:  A view in which the entire desktop space is occupied by the current worksheet.

Headers and Footers:  They are text, page numbers, date, document’s title or file name, or the
author’s name that are usually printed at the top and bottom of each page in a worksheet
respectively. A header is printed in the top margin, footer is printed in the bottom margin.

Name Box:  This box shows the name or the address of the currently active cell.

Normal View:  A view of a worksheet in which no reference to pagination is displayed and print
area is not specified.

Range:  A group of cells, optionally having a name taken as one unit of cells.

Relative Reference:  It is address of a cell or range of cell with respect to a given cell.

Row:  Rows are combination of all the horizontal cells joined together in a single horizontal line.

Workbook:  It is a group of worksheets, which can be stored as a unit. A workbook is stored on
the disk in form of a file with extension .xls.

Worksheet:  It is the working area of MS-Excel. Each worksheet of a single workbook has its own
identity and is separate from other worksheets.

Workspace:  It is the working area of MS-Excel where workbooks, worksheets and other related
objects may be opened and manipulated.

MS-Access 2000

Action Query:  It is used to perform an action on records that meet the criteria specified in the
query object.

Application Programmers:  Computer professionals who interact with the system through Data
Manipulation Language calls, which are embedded in a program written in a host language (for
example, COBOL, PL/I, PASCAL, C). The programs are referred to as application programs.

Attribute:  Piece of information describing a particular entity. These are mainly distinguishing
characteristics of the individual entity.

Auto Number Data:  A data type that stores an integer that is incremented or decremented
automatically as records are added and/or deleted.
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Built-in Functions:  Small programs that perform simple calculations or data formatting by taking
optional arguments. These functions are already created for the users and they do not have to
create them.

Currency Data:  A data type that stores monetary data.

2.31 REVIEW QUESTIONS

Unsolved Questions
1. Fill in the blanks:

(a) A——structure in DOS resembles on inverted tree.

(b) ——command is used for formatting a hard disk or floppy disk.

(c) —is a special kind of batch file which is executed as soon as the operating system is
loaded in the computer’s memory.

(d) Windows supports file names upto——characters.

(e) The find option of the start menu help in —a particular file or a folder.

(f) The files once deleted in windows can be restored from the—.

(g) Word processing included——and——text to give organized look to the document.

(h) ——menu is used for enhancing the look of the document.

(i) Copying means——the contexts of the document while moving means——text from
one portion of the document and placing it at some other location.

(j) A——is a collection of related information.

(k) A——is a written set of instructions that automate repetitive tasks.

(l) These are ——rows and——columns in an excel worksheet.

(m) The formula entry in excel can be made by beginning the entry with a ——,——— or
sign.

2. State:  True or False:

(a) A file name with no extension is invalid in DOS.

(b) RD command removes all the files and sub-directories under the current directory.

(c) MD command is used to create a new file.

(d) XCOPY command is used to copy the files present in sub-directories.

(e) Windows contains a disk compression program which can essentially double the hard
disk space.

(f) Scan disk reconfigures files on the hard disk

(g) Page setting includes putting your text neatly between margins.

(h) A report is used for showing the data put in the table in an organized manner.

(i) You have to save the records, you enter after certain internals in Access.

(j) Excel allows to import data from databases created by other programmers.

Answers (Unsolved Questions)
1. (a) director (b) FORMAT (c) AUTOEXE. BAT (d) 255 (e) locating (f) Recycle bin (g) typing,

manipulating (h) FORMAT (i) duplicating, removing (j) database (k)Macro (l) 65536, 256 (m)
+, @,=

2. (a) False (b) False (c) False (d) True (e) True (f) False (g)True (h) True (i) False (j) True.

Detailed Questions
1. What do you mean by booting up?

2. What is the full form of ROM-BIOS?
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4. How many parts are there in a file name under MS-Dos? What are file naming conventions?

5. What are volume labels? How many characters can a volume label contain?

6. What are wild cards? What is the use of '?' and '*' wild card in MS-DOS?

7. What is the purpose of copy command?

8. To view a directory listing width wise, which command is used?

9. Which commands lets you create directories? Give example.

10. What is the use of switch /w in DIR command?

11. How is X COPY a better copy command than COPY?

12. What are batch files? What is the significance of AUTOEXEC.BAT file?

13. Give some of the advanced features of window 98.

14. What is the difference between copying and moving files and folders?

15. When a folders is copied to another place, do the sub-folders in the folder also get copied?

16. What is windows Explorer and give some of its functions?

17. Differentiate between notepad and WordPad.

18. What do you mean by dialog box? Also discuss its various components.

19. What is the start Group? What are the different functions that can be done through this?

20. Discuss some advance features of windows 98.

21. (i)     Give procedure to create a new folder in windows 98.

(ii) Give procedure for closing down the windows 98.

22. What is the function of taskbar and recycle bin?

23. Describe the functions of the Control Panel.

24. What are the advantages of a word processor over typewriters?

25. What is meant by text alignment? In how many ways can you align you text?

26. What is meant by page margins? Which option will you choose to set the margins of your
document?

27. What are the advantages of find or replace features of word processor?

28. Write your Bio-Data in MS-Word.

29. Prepare a business letter to you customer promising to attend to his complaint immediately.
Use page setup, formatting features, etc.

30. Prepare a table in which the budget comparison of three years is made.

31. What is data and why is it required?

32. What is information and how it differs from data?

33. Differentiate between a query and a report.

34. Differentiate between a form and the datasheet view.

35. Describe various ways of creating a table in access. Differentiable between a formula and a
function.

36. Differentiate between a formula and a function.

37. Differentiate between a table and a query.

38. What are the purposes of forms in Access 2000? Explain with appropriate examples.

39. Can an Excel chart be inserted into an Access report? How?

40. How many rows and columns are there in MS-Excel Worksheet?
41. What do you mean by range of cells?
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42. What do you mean by cell referencing and what are different types of referencing?
43. Why is formatting necessary?
44. What are the different types of data that can be entered in MS-Excel?
45. What is the difference between copying and moving a range?
46. What is the different components of chart? Explain.
47. Define embedded chart.
48. Define chart sheet.
49. Explain various types of charts available in MS-Excel.

50. Which types of  files can be imported and exported from MS-Excel?

2.32 FURTHER READINGS

Sanjeev Gupta and Shameena Gupta,  Computer Aided Management (Using MS-Office 2003
Tools), Excel Books.

Manoj Kumar, M. Shamir Bhudookan,  Information Technology for ‘O’ Level, Editions De
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UNIT

3
DATA PROCESSING

L E A R N I N G  O B J E C T I V E S

After studying this unit, you should be able to understand:

Various modes of data processing.

Basic functions carried out in data processing.

Data hierarchy and data structure.

Application portfolio of business organization.

Computerized financial accounting system, inventory control system payroll system and
invoicing system.

U N I T  S T R U C T U R E
3.1 Introduction
3.2 Modes of Data Processing
3.3 Basic of Data Processing
3.4 Data Hierarchy
3.5 Data Structure
3.6 Application Portfolio Development
3.7 Management of Data Processing Systems in Business Organizations
3.8 Computerised Financial Accounting System (FAS)
3.9 Computerised Inventory Control System
3.10 Computerised Payroll System
3.11 Computerised Invoicing System
3.12 Summary
3.13 Keywords
3.14 Review Questions
3.15 Further Readings

3.1 INTRODUCTION

The computer processes the data to give information. Processing of data is done by the CPU in
various ways. In this unit we will discuss various types of data processing techniques, their
functions, data hierarchy and structure, At last some computerized system models are discussed
for your ready reference.

3.2 MODES OF DATA PROCESSING

Organizations generally follow the following types of data processing systems with the aim of
optimizing efficiency. The systems are:

Batch Processing

Also referred as serial or off-line or sequential processing.

This type of processing requires the data to be initially grouped (as a batch) before it is processed
serially, and the results obtained periodically.
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The batch might be a group of sales orders or purchase orders, etc., collected off-line.

The batch is processed at definite period of time in stipulated frequency, and each transaction in
batch is processed in serial order.

The method of batch processing reduces the idle time of a computer system because transition
from one job to another does not require operator intervention.

It is the most appropriate method of processing for many types of applications, such as payroll or
preparation of customer statements, where it is not necessary to update information (records) on
daily basis.

Batch processing suffers from several disadvantages which are as follows:

l Reduces timeliness in some cases.

l It makes each job wait in line at each step and often increases its turnaround time.

l It is difficult to provide the desired priority scheduling.

On-line Processing

On-line processing is that type of processing where the result of data processing transaction is
available immediately.

It permits transaction data to be fed under CPU control directly into secondary on-line storage
devices from the point of origin without sorting it first.

It also permits users to enter into a conversation with the computer to send and receive messages,
within a fraction of a second after the enquiry message has been transmitted.

This conversation permits the user to process transactions one after the another with greater
assurance that the actions taken by the computer are correct. This type of processing also
provides a satisfaction to the users that they are able to command the machine. However, this
type of processing can not be used in all circumstances as otherwise the processing time will
increase. Examples of online applications include:

Banking, stock exchanges, stock control, work progress control in plants, inventory status, etc.

Real Time Processing

Real time system is defined as a data processing system in which the time interval required to
process and respond to inputs is so small that the response itself is useful for controlling the
physical activity of a process. Real time processing provides immediate (not periodic, as in batch
processing) transaction input capability from all input originating stations.

The essential requirements of a real time processing system include:

l direct connection (on-line) between input/output devices and the central processor, and

l fairly fast response time, allowing two-way communication.

The characteristic of real time data processing that truly distinguishes it from the more common
batch and on-line processing systems is the immediacy of its response on receipt of a message.

Thus, all on-line systems are not necessarily real time data processing systems. The application
areas of real time systems are:

l Enquiries about customer's account status can be answered in seconds.

l Credit appraisal can be carried out immediately.

l Sales analysis master file can be updated on-line. This file provides a ready information to
the sales manager regarding sales trends, etc.

Real time system also finds extensive application in airlines booking, banking system, air and
ground traffic control, automatic radar connected defence and space programs.
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Distributed processing, broadly speaking, involves a computer system linked by a communication
network where processing is performed by separate computers.

Often, each computer in the system is chosen to handle a specific workload with the network
supporting the system as a whole. When distributed processing is used, it requires that databases
be located at different sites for efficient functioning.

The database is broken up into logical cooperating parts and situated at a different location. User
can access data from any location, easily accessing the local as well as the remote databases.

Distributed Database Systems (DDBS) forms the backbone of distributed computing.

This form is most convenient for organizations with many branch offices located over great
distances. Each branch stores data elements relating to its daily operations at its own site. A
major part of processing can be taken care of at the local level.

A typical application is in banks where all the branches have intelligent terminals linked to a big
computer at the head office. Data from the branches is sent to the master where it is processed.

Student Activity 1

1. What is the aim of any processing system?

2. Define Batch processing system.

3. What are the disadvantages of batch processing system.

4. Define on-line processing.

5. What are the essential requirements of a real time processing system?

6. Describe distributed data processing.

3.3 BASIC FUNCTIONS OF DATA PROCESSING

Data Processing is the restructuring, manipulation or recording of data by people or machine, to
increase their usefulness and value for some particular purpose.

Following are the basic functions carried out in any data processing:

Origination

The first function involved in the processing of data is the origination of the data to be processed.

Specifically, the nature, type and origin of the source documents must be determined, such as
sales orders, purchase orders, etc.

Data Capture

Data must be recorded or captured in some form or the other before they can be processed. What
data are important and should be collected for input and processing depends upon the organization
and the system.

Data maybe captured in paper forms using source documents and in paperless forms through:

l Keyboards

l Automated teller machines

l Other direct input devices that accept input data in machine readable form
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Sorting

Normally, it is easier to work with data if they are arranged in a logical sequence. e.g., First to last
time sequence.

Biggest to smallest.

Oldest to newest, etc.

Arranging classified data in such a sequence is called "sorting".

Merging

This function allows multiple files to be put together in a sequence, provided the files are already
in sorted order.

e.g.: A file of a new customer could be merged into an existing customer master file that is stored
on a magnetic disk in customer number sequence.

Calculating

The arithmetic manipulation of data to create meaningful results is known as calculating, and is a
common data processing task.

This process is usually the most significant part of the manipulation operation because the
results are generally provided as part of the output.

Summarizing

Reducing masses of data to a more concise and usable form is called summarizing. Generally, the
data is summarized into the form desired for output.

e.g.:   Pie charts
Bar charts

Other graphs

These are the few of the many of computer generated graphics that are used to view data at a
glance.

Managing Output Results

Once data have been captured and manipulated, one or more of the following operations maybe
needed:

Output

After the various operations on the data have been completed, the delivery or communication of
the information or results must be carried out by:
(a) Reporting, which is the format presentation and distribution of processed data.
(b) Issuance of documents, such as cheques, invoices, and reports.
(c) Retrieval, which is the fetching of a specific item or items of stored information at the

request of a user.
(d) Analysis, which encompasses all of the ways in which the receivers utilize output, i.e., use

the information provided by the system.
(e) Communicating and reproducing (transmission).

Transferring data from one location or operation to another, for use or further processing, is data
transmission, a process that continues until information in a usable form reaches the final user.
Sometimes, of course, it is necessary to copy or duplicate output documents.

Storage

Finally, the results of the processing of data must be retained for future use of reference. This
function is called storage.
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Listed below are the components of the data hierarchy in the ascending order of complexity:

This is called a data hierarchy because databases are composed of files, files are composed of
records, and so on.

Bit

The term bit is short for binary digit. It can assume either of the two states, representing numeric
value 0 or 1.

Byte

In a computer system, basic unit of information is called a byte. A byte of information is generally
stored by using 8 bits in a specified combination.

Field or Item

A field or item of data is one or more bytes that contain data about attributes of an entity.

Record

A record is a collection of fields relating to a specific entity.

File

A file is a collection of related records. The concept of a computer file is very similar to the manual
file in a filing cabinet.

Database

A database consists of all the files of an organization, structured and integrated to facilitate
updation. of files and retrieval of information from them.

Simple Bit
Byte
Field or item
Recod
File

Most Complex Database
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Data maybe organized in various ways; the logical or mathematical model of a particular situation
using data is called a data structure.

A data structure is a class of data that can be characterized by its organization and the operations
that are defined on it.

Data structures are also called abstract data types.

Student Activity 2

1. What are the basic functions of data processing?

2. What is  the difference between data capturing and data merging?

3. What are various ways to summarize data.

4. Describe data hierarchy.

5. What is a data structure?

3.6 APPLICATION PORTFOLIO DEVELOPMENT

An application portfolio of a business organization is a compilation of information about the
organization's investments in its IT-based application infrastructure. The information is organised
to show how these investments support the organization's mission and programs and to
demonstrate the relationships among current and planned investments. The portfolio enhances
the ability of key decision-makers to assess the probable impact of investments on the organization's
programs and infrastructure, as well as on the overall IT infrastructure. These decision-makers
include organization executives, managers etc.

Portfolio-based application management is intended to guide the stewardship of vital assets of
the organization. It is central to plans of the organization to improve the overall performance. The
portfolio approach recognizes the maturing capabilities of the organization. It also recognizes the
continuous advance of technology and the need for the organization to see new initiatives in the
context of their total operations, including their IT application investments. The portfolio provides
a process for co-ordinating new projects in the context of a business plan and with consideration
of the larger IT application portfolio.

The approach has its origin to 1996 Washington State Strategic Plan and includes the foundational
policies, procedures, and processes necessary to make informed decisions about IT alternatives
and achieve a very high rate of project success.

The application portfolio:

l Discloses links among organization strategies and business plans and investments in
applications;

l Facilitates analysis of the risks associated with investments made in applications and helps
ensure that appropriate risk mitigation strategies are adopted;

l Provides a baseline for organization-level performance reporting; and

l Helps ensure that the organization IT infrastructure as a whole is effectively integrated.

Characteristic of Portfolio-based IT Management

Portfolio-based IT application management refines the oversight process used to shepherd a
number of complex projects through the development process. Those experiences, coupled with
extensive consultations with key stakeholders, made clear the need redress shortcomings of the
existing process.

The portfolio concept is grounded in the management principle that any significant investment
requires careful monitoring to maximize its value and insulate it from threats to its integrity. This
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commercial paper, and equity investments all of which are commonly managed in portfolios.
These portfolios allow decision-makers to view the range of investments as a whole but also
consider discrete investments in context.

The need for an application portfolio is less well understood with respect to investments but no
less important. Organization investments on applications involve significant taxpayer funds; are
often mission-critical; and are increasingly interrelated in a digital, networked environment.
Investments in applications can be leveraged with great effect if the portfolio is sufficiently
flexible to adapt to changing business and service needs. Their value, on the other hand, can be
undermined by rigid design, unsubstantiated claims about capabilities or performance, and neglect.

Portfolio-based application management is a coordinated approach to the stewardship of the full
range of technology investments. It ensures that new initiatives are seen both in the context of
the organization wide infrastructure and the respective department-specific application portfolios.

It establishes a framework within which:

l Comprehensive information about the context of an organization's overall operations is
readily available for decision-making.

l The development and deployment of application is driven by the clearly defined business
needs of an organization in serving citizens and fulfilling its legislative mandate.

l Department heads bring executive focus to application investments and will have new
management tools for meeting statutory responsibilities for the stewardship of these
investments in their respective departments.

l A formal, objective process exists to evaluate whether a project should be initiated and by
which to determine the most appropriate form of oversight based on a comprehensive risk
analysis.

l Large projects are broken into smaller, more easily managed projects with each phase
adding value on its own without committing funding authorities to subsequent phases.

Portfolio-based IT management organizes information about all IT resources into the perspective
of an investment portfolio. The portfolio is responsive to the needs of a variety of decision-
makers, including agency executives, agency technical managers, agency program managers and
the like. Information is structured to facilitate recognition of trends, analysis of problems and
opportunities, and the evaluation of alternatives within the context of an organization's overall
investment.

Included in the application portfolio is information about an organization's:

l Mission, strategies, programs, and business processes
l Installed hardware, software, and networks and physical facilities
l Technical management and staff capabilities
l Applications that support organization programs and business processes
l Partnerships or interfaces with other organizations
l Current and planned projects
l Cost and benefits of current and planned investments
l Problems and opportunities involving the applications.

3.7 MANAGEMENT OF DATA PROCESSING SYSTEMS
IN BUSINESS ORGANIZATIONS

In a typical business organization the data processing system maybe fairly complex. Managing
the system is the key factor that determines the success of the organization as a whole. The
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structure of the management depends on the size and complexity of the system. There may be
systems simple enough to be managed by a single manager, while in some cases an entire
department maybe involved. In a typical scenario the organization of the data processing system
consists of:

1. EDP (Electronic Data Processing) Manager

2. System Programmers

3. Application Programmers

4. Auditors

5. Maintenance Engineers

6. Database Administrators etc.

In general, following are the responsibilities of the data processing manager:

1. Identifying the need of acquisition of new technology including hardware and software.

2. Evaluating the same.

3. Procuring the approved technology.

4. Providing the EDP services to all the users in the organization according to their needs.

5. Adding new features of processing and removing obsolete ones.

6. Incorporating new business rules and providing required interfaces to the users.

7. Accounting for the usage of the resources.

8. Ensuring the availability of the system by scrutinising and by taking corrective measures in
case of any breakdown.

Student Activity 3

1. What do you mean by application portfolio?

2. What are the characteristics of portfolio-based IT management?

3. What information is included in the application portfolio of an organization?

4. Who belong to the organization of the data processing system?

5. List the responsibilities of the data processing manger.

3.8 COMPUTERISED FINANCIAL ACCOUNTING
SYSTEM (FAS)

The financial accounting system is the heart of the overall distribution system. Its functions as a
traffic cop to route financial information in the correct file or account.

Financial accounting is an art of recording and processing all transactions within an organization
with outsiders and includes events affecting the financial position of the organization. It results
in preparation of the annual profit and loss account as well as balance sheet for the organization.

Why Computerized FAS?

The control of funds coming into and going out of the firm is obviously very important and the
use of computers should make such control more effective.

A great volume of accounting data is numerical and is always processed with the same method.
This makes computerization relatively easy.

Calculations should be more accurate.

Reports can be supplied faster and frequently.
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What is Inventory?
l Inventory refers to buffer stock of items of use being maintained by the organization to

prevent losses resulting from non-availability of materials.

l Different levels of stocks of different items will be maintained depending upon their
consumption level, cost, and other characteristics.

Why Control Inventory?
l Inventories account for 50-70% of the total cost of operation in most organizations.

l While keeping inventory is unavoidable, it must be remembered that inventory is an idle
resource and it adds to the cost. Excessive inventories will reduce organization's profitability.
Therefore, inventories must be closely monitored and controlled.

Objectives of Inventory Control
l To minimize the loss of business due to non-availability of required materials.

l To minimize the total cost of materials including procurement, storage, and handling costs
consistent with required service levels.

Scope of Inventory Control Function
l Materials planning

l Materials requisitioning

l Materials receipt and inspection

l Materials storage

l Materials issues, returns, and adjustments.

Figure 3.1: An Overview of Inventory Control/Material Management
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Payroll system is concerned with accurate and timely computation of compensation to each
individual employee.

In addition, the payroll system generates relevant information inputs to budgetary control and
financial accounting systems.

The objective of the payroll system is wages calculations and associated record keeping.

Description

Each organization has an employee compensation/wage policy. In addition, employee compensation
is also subject to certain statutory provisions like Income Tax regulations. The processing logic
of the payroll system has to take into account all relevant provisions.

The system uses two types of data:

a) Fixed data like employee name, address, etc., which is stored in the database and can be
retrieved from there.

b) Variable data like attendance, overtime, deductions, etc., which has to be fed as inputs.

The system produces two types of outputs:

a) Individual oriented outputs like pay slips, income tax statement, provident fund statements
etc.

b) Organization oriented outputs like salary ledger, department-wise salary statements,
consolidated provident fund statements, consolidated income tax statements etc.

In the process, all the relevant databases and the files will also be updated.

System Outline

3.11 COMPUTERISED INVOICING SYSTEM

Invoicing is part of a larger system, namely, sales order processing and invoicing system.

The system is concerned with:

l Receipt of customer order

l Validation of customer order
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l Invoice Generation

Once the invoice is generated, accounts receivable system takes over. File containing newly
generated invoices becomes an input to the accounts receivable system.

System Outline

Processing Steps

Sales orders from customers received in variety of ways in the form of order form, through fax,
over phone are entered into the computer system.

Orders are validated through checking of item prices and customer credit rating. Valid orders are
stored in the Order File.

Orders are processed after checking the availability of items from the finished goods inventory
file. This step generates three outputs, namely, Picking List, Packing Slip, and Sales Ledger.

Once the order has been processed, corresponding invoice is prepared by referring to price
master file. In this step, the required number of invoice copies are generated and an invoice ledger
is produced. Newly generated invoices are copied to the invoice master file.

System Outputs
Packing List: is a document generated to help warehouse staff assemble all items included in

one customer order quickly and conveniently. It contains the Order No., Item
No., Quantity and the location of an item in the store.

Packing Slip: is a document accompanying the order consignment to the customer. It contains
customer order number and the list and quantity of items in a particular
consignment along with forwarding address.

Invoice: is a bill or a claim made by the supplier on the customer for the goods supplied.
It contains customer order reference, list and quantity of items supplied, prices,
total amount payable, payment date, and discounts as applicable along with
payment instructions.

Sales Ledger: is daily listing of all sales made showing sales order number and order value.

Invoice Ledger: is daily listing of all invoices prepared during the day.
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Student Activity 4

1. Why does an organization need computerized FAS?

2. What is Inventory? What are its objectives?

3. What is a payroll system?

4. What is invoicing system? Describe its processing step.

5. What are the various outputs of a system?

3.12 SUMMARY

Various types of data processing systems followed by the organization to optimize their efficiency
are batch processing, online processing, real time processing and distributed data processing.

The basic functions carried out in any data processing include the origination of the data to be
processed, capturing of data be fore processing, sorting the data, merging the multiple files,
performing calculations and summarizing it. Then the results of processing of data are stored for
future reference.

The smallest unit of data is bit. 8 bits form one byte. One or more bytes that contain data about
attributes of an entity is a field. A collection of fields relating to a specific entity forms a record,
collection of related records forms a file and the collection of all files of an organization form a
database.

An application portfolio of a business organization is a compilation of information about the
organizations investments in its IT-based application infrastructure. The portfolio approach
recognizes the maturing capabilities of the organizations. The portfolio concept is grounded in
the management principle that any significant investment requires careful monitoring to maximize
its value and insulate it from threats to its integrity. The portfolio is responsive to the need of a
variety of decision-makers, including agency executives, agency technical managers, agency
program managers and the like.

Financial accounting is an art of recording and processing all transactions within an organization
with outsiders and includes events affecting  the financial position of the organization. This
system is computerized to do more accurate calculations and faster and frequent supply of
reports.

Some other systems that can be computerized in an organization include inventory control system,
payroll system, Invoicing system, etc. The outputs of the system includes packing list, packing
slip, Invoice, sales ledger and Invoice ledger.

3.13 KEYWORDS

Batch Processing: Processing that requires the data to be initially grouped (as a batch) before it
is processed serially, and the results obtained periodically.

Online Processing: Processing where the result of data processing transaction is available
immediately.

Real Time Processing: Data processing system in which the time interval required to process
and respond to input is so small that the response itself is useful for controlling the physical
activity of a process.

Distributed Data Processing: Data processing which involves a computer system linked by a
communication network where processing is performed by separate computers.

Sorting: Arranging the data in a local sequence.

Bit: Representing numeric value 0 to 1.

Byte: Basic unit of information, generally stored by using 8 bits.

Field: One or more bytes that contain data about attributes of an entity.
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File: A collection of related records.

Database: Collection of all files of an organization.

Data Structure: A class of data that can be characterized by its organization and the operations
that are defined on it.

Application Portfolio: A compilation of information about the organization's investment in its IT-
based application infrastructure.

3.14 REVIEW QUESTIONS

Unsolved Questisons
1. Fill in the blanks:

(a) In—processing the result of data processing translation is available immediately.

(b) ——forms the backbone of distributed computing.

(c) Data must be ——or——before they can be processed.

(d) Basic unit of information is a computer system is called a ——

(e) A datastructure can be characterized by its —and —that are defined unit.

(f) The ——approach recognizes the maturing capabilities of the organization.

2. State: True or False:

(a) The method of batch processing reduces the idle time of a computer system.

(b) The first function involved in the processing of data is the capturing of data.

(c) The data is summarized into the form desired for output.

(d) A database is a collection of related records.

(e) Payroll system is concerned with accurate and timely computation of compensation of
each individual employee.

Answers (Unsolved Questions)
1. (a) Online (b) Distributed Database systems (c) recorded, Captured (d) byte (e) organization,

operations (f) portfolio

2. (a) True (b) False (c) True (d) False (e) True

Detailed Questions
1. Describe various modes of data processing system.

2. What is the difference between on-line processing and Real-time processing?

3. What do you mean by the terms merging and summarizing of data?

4. How does the information communicated?

5. Why is storage of information required?

6. Describe the hierarchy of data.

7. Describe computerized pay roll system. Also draw its system model.

8. Describe the objective and scope of Inventory control system.

9. Describe various system outputs of an organization in its Invoicing system.

3.15 FURTHER READINGS

Ramesh Bangia, Business Systems, Laxmi Publication.

Robert  J Thierauf, Data Processing for Business and Management, John Wiley & Sons.
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SOFTWARE DEVELOPMENT

L E A R N I N G  O B J E C T I V E S

After studying this unit, you should be able to:

Describe software development process.

Understand various phases of software development.

U N I T  S T R U C T U R E
4.1 Introduction
4.2 Computer Software Systems
4.3 Software Development Process
4.4 Summary
4.5 Keywords
4.6 Review Questions
4.7 Further Readings

4.1 INTRODUCTION

Computer software has become a driving force. It is the engine that drives business decision
making. It is a key factor that differentiates modern products and services. Software is virtually
inescapable in a modern world.

The software development process has been the focus of considerable attention over the last
decade. It is a frame work for the tasks that are required to blind high-quality software.

4.2 COMPUTER SOFTWARE SYSTEMS

A commercial organization performs various activities. The important ones among them include
financial accounting, inventory control, and payroll. Most of these activities are carried out
manually. As the dimensions of these activities increase, the organization may prefer to mechanize
the activities to operate smoothly. Computer manufacturers have come to the rescue of business
organizations. They have developed packages/programs, for carrying out the activities like payroll
preparation, inventory control, invoicing system, and financial accounting. This chapter discusses
these four important computerized applications in detail.

When we consider the payroll problem, it is obligatory on the part of every employer to pay the
wages to employees within a prescribed time limit. When the number of employees is large, it is
preferred to have a computerized system of preparing the pay bills rather than manual ones. A
computer software package on payroll thus becomes an integral part of a large business
organization.

Similarly, financial accounting is another field where computerization can play an important role.
The financial accounting package is one which helps the organization in preparing various financial
reports, ledgers, and journals of monetary transactions.

In a large production-oriented organization, it is essential to have a control over the investment in
inventory of raw materials. A computerized inventory control system can reduce considerable
amount of time in processing the data which is necessary to control inventory.
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Software development for business applications is not an easy task. In developing a large software
(e.g., MIS), many people are involved and many months or even years are spent. However, a small
application (e.g., Payroll) can be developed in few weeks or months by a single or few programmers.
For such small systems, software development activities maybe done implicitly without proper
documentation. But, for large systems, these activities must be done explicitly with proper planning
and documentation. Whether a system is small or large, software development revolves around a
life cycle that begins with the recognition of users' needs and understanding their problem. A
plan is made for solving the problem and then a sequence of activities are performed step by step.
The basic activities or phases, that are performed for developing a software are:

1. Feasibility Study: Feasibility study is the first phase in development of a new system
(candidate system). This phase starts when the user faces a problem in the current system
(manual or already computerized) and submits a formal request to the EDP department or an
outside software development company either for a new system or for modifying the current
system. After receiving the request, the overall incharge of software development team,
Systems Analyst, begins the preliminary investigations to determine whether the system
requested is feasible to develop or not.

2. Systems Analysis: When the systems analyst decides that the requested system is feasible
and the management agrees to continue the development process, the next phase of SDLC
is determination of systems requirements. This phase includes studying of existing system
in details and collecting data in order to find out the requirements of the users.

3. Systems Design: After collecting and studying user's requirements, the system is designed.
This phase involves identification of inputs data, output reports and the procedures to
process the data.

4. Development of Software: When the design (properly documented) is accepted by the
requested department, the programmers start designing of data structures and writing of
program. The programmers test their individual programs and integrate them into a single
system.

5. Systems Testing: Testing is the most vital phase of SDLC. In this phase, the system as a
whole is tested with different techniques to ensure that the software is bug free.

Figure 4.1: Seven Phases of Software Development Life Cycle
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6. Implementation: The tested system is installed at the user's place and implemented. This is
generally considered the last phase of SDLC. However, the systems development work
continues until the users of requested department accepts the candidate system.

7. Maintenance: After implementation, the systems need be maintained in order to adapt the
changing business needs. Maintenance is sometimes not considered as a phase of SDLC,
but it is an essential part of a software project that never ends.

The different phases of Software Development Life Cycle (SDLC) are illustrated in Figure 4.1.

It maybe possible that the candidate system fails due to any major mistake occurred in any of the
development phase. In that case, any or all of the phases are needed be reviewed again, so that
the system is completely accepted by the requested department. This is the reason, why 'life
cycle' term is used in software development phases. We will discuss about each phase in detail in
subsequent sections.

4.4 SUMMARY

For development a large a software for any business application, many people are involved and
many months or even years are spent. Whether a system is small or large, software development
revolves around a life cycle that with the recognition of user's needs and understanding their
problem. The various phases involved include feasibility study, system analysis, system design,
development of software, system testing, Implementation and maintenance. If the candidate
system fails due to any major mistake occurred in any of  the development phase, any or all of the
phases are needed be reviewed again, so that the system is completely accepted by the requested
department.

4.5 KEYWORDS

System Analysis: Study of existing system in detail and collecting data in order to find out the
requirements of the users.

System Design: Identification of input, output and procedures to process the data.

System Testing: Testing of the whole system with different techniques to ensure that the software
is bug free.

4.6 REVIEW QUESTIONS

Unsolved Questions
1. Fill in the blanks

(a) ____is the first phase in development a new system.

(b) The system analyst decides that the requested system is____and the management
agrees continue the ____process.

(c) ____phase involves identification of inputs data, output reports and the procedures
to process the data.

(d) ____is sometimes not considered as a phase of SDLC.

2. State: True or False:

(a) Few people can easily develop a large software in very short duration of time.

(b) Feasibility study begins when the user faces a problem in the current system.

(c) The programmers can design data structures before the actual acceptance of the design
by the requested department.

(d) Implementation is generally considered as the last phase of SDLC.
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1. (a) Feasibility study (b) Feasible, development, (c) System design (d) Maintenance.

2. (a) False (b) True (c) False (d) True.

Detailed Questions
1. What is a computer software system?

2. Describe the various phases of software development process.

3. What are the seven phases of SDLC? Draw diagram?

4. What is system testing? Why is it required?

5. What will happen if a system fails?

4.7 FURTHER READINGS

N.D.Birrell, M.A.Ould, A Practical Handbook for Software Development, Cambridge
University Press.

Pankaj Jalote, An Integrated Approach to Software Engineering, Springer.
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FILE SYSTEM AND DATABASE

L E A R N I N G  O B J E C T I V E S

After studying this unit, you should be able to understand:

Various types of files.

Various file organizations.

Master and transaction file.

File design.

Designing and generating reports.

Relevance of database management system.

U N I T  S T R U C T U R E
5.1 Introduction
5.2 Various Types of Files
5.3 Files Organization
5.4 Master File
5.5 Transaction File
5.6 File Design
5.7 Designing Reports
5.8 Relevance of Database Management Systems
5.9 Integration of Application
5.10 Introduction to a Micro Database Manager
5.11 Summary
5.12 Keywords
5.13 Review Questions
5.14 Further Readings

5.1 INTRODUCTION

Files and database have become an essential component of everyday life in modern society. In the
course of a day, most of us encounter several activities that involve some interaction with a
database, like in banks to deposit and withdraw funds; if we make a hotel or airline reservation; if
we access computerized library catalog; or if we order a magazine subscription from a publisher,
chances are that our activities will involve someone accessing a database.

To understand the basics of database, we must start with files and its various types and organization
which together form the database.

5.2 VARIOUS TYPES OF FILES
Depending upon the type of content, a file can be categorized as:

1. Data file

2. Program file

3. Object code file
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5. Text file (unformatted file)

6. Formatted file

Data Files
l A data file is used to store the data records. These data files are well defined data structures

that contain related data organized in convenient groupings (records) of data items.

l Each data file has two additional types of records: Header record, and types record.

l Header records contain file identification information and keep apart different groups of
records in a file.

l Trailer records contain codes to mark the end of a set of data records. These also record file
usage information.

l Categories of data files:

Depending upon the nature of data, data files can be categorized as:

1. Master file

2. Transaction file

3. Work file

4. Audit file

5. Backup file

l  File organization:

Data in files can be organized in different ways. These data records can be organized in
anyone of the following ways:

1. Serial

2. Sequential

3. Indexed Sequential

4. Directly Accessible/Random

Program Files

Program files are used to store programs in different languages provided by different software
vendors. These files have different extensions depending on the language used to write a program.

e.g.: 1. A program file written in 'C' language has extension. C.

        2.     A program file written is C++ language has extension. CPP.

Object Code Files

These files store compiled programs written in a language. These files contain the machine code.

e.g.: After compilation, C compiler creates a file having extension.OBJ

Executable Files

These files store ready to execute programs. These files may have extension.EXE.COM or .BAT.
These programs can be directly executed from the command prompt.

Unformatted Text Files
l These files are simple files containing simple text.

l Text files can be created using any text editor or line editor.
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e.g.: Text files can be created using MS-DOS Edit editor or Notepad editor provided by
MS-Windows.

Formatted Text Files

These files contain formatted text. These also contain some commands and symbols to format the
text. These files can be created using any word processor.

e.g.:MS-WORD creates a formatted text file having extension .DOC.

Student Activity 1

1. What are the various types of files depending on the type of content?

2. What are data files? What are its various categories?

3. What is a program file?

4. Which files are said to be executable files?

5. What is the difference between unformatted and formatted text files?

5.3 FILES ORGANIZATION

File organization refers to the relationship of the key of the record to the physical location of that
record in the computer file.

The two main objectives of computer based file organization are:

l ease of file creation and maintenance, and

l providing an efficient means of storing and retrieving information.

The four file organization methods that are commonly used in business data processing
applications are:

1. Serial

2. Sequential

3. Direct or Random

4. Indexed Sequential

The selection of a particular file organization depends upon factors like, the type of application,
the method of processing for updating files, size of file, etc.

Serial File Organization

In serial file organization records are stored without any consideration of their order or sequence.

Records have to be accessed in the serial fashion only.

Examples are: memory dumps, archival files, records of events, transaction files.

Each record is written after the last record in the current file. The order of records in the serial file
is according to the time when the data was generated.

Sequential File Organization

In a sequential file, records are arranged in the ascending or descending order or chronological
order of a key field.

To access these records, the computer must read the file in sequence from the beginning.

The retrieval search ends only when the desired key matches with the key field or the currently
read record.
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file.

Sequentially organized files are normally created and maintained on storage media such as magnetic
tape, cartridge tape, magnetic disks, etc.

Advantages
1. Easy to organize, maintain, and understand.

2. There is no overhead in address generation locating a particular record requiring only the
specification of the key field.

3. Relatively inexpensive I/O media and devices can be used.

4. It is the most economical and efficient file organization where the activity ratio (the ratio of
the total number of records in transaction file and the total number of records in master file)
is very high. That is why this file organization is most suitable for transaction files.

Disadvantages
1. It proves to be very inefficient and uneconomical for applications in which the activity ratio

is very low.

2. Since an entire sequential file may need be read to retrieve and update few records,
accumulation of transactions into batches is required.

3. Transactions must be stored and placed in sequence prior to processing.

4. Timeliness of data in the file deteriorates while batches are being accumulated.

5. Data redundancy is typically high since the same data maybe stored in several files,
sequenced on different keys.

6. Random enquiries are virtually impossible to handle.

Applications
Payroll System

Billing and customer statement preparation

Bank cheque processing

Financial accounting

Direct or Random File Organization

A direct file (also referred to as a relative or random organization) consists of records organized in
such a way that it is possible for the computer to directly locate the desired record without having
to search through any other records first.

A record is stored by its key field.

For mapping the key fields to the locations, an arithmetic procedure called hashing algorithm is
frequently used.

This address generating function is selected in such a manner that the generated addresses
should be distributed uniformly over the entire range of the file area and a unique address must be
generated for each record key.

A Direct Access Storage Device (DASD) such as drum, disk, etc., are essential for storing a direct
file.

Advantages
1. The access to and retrieval of a record is quick and direct (within a fraction of a second).

2. Transactions need not be sorted and placed in sequence prior to processing.
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3. Accumulation of transactions into batches is not required before processing them. They
maybe processed as and when generated.

4. It can also provide up-to-the minute information in response to enquiries from
simultaneously usable on-line stations.

5. If required, it is also possible to process direct file records sequentially in a record key
sequence.

6. A direct file organization is most suitable for interactive on-line applications.

Disadvantages
1. These files must be stored on a direct access storage device. Hence, relatively expensive

hardware and software resources are required.

2. File updation (addition and deletion of records) is more difficult as compared to sequential
files.

3. Address generation overhead is involved for accessing each record due to hashing function.

4. May be less efficient in the use of storage space then sequentially organized file.

5. Special security measures are necessary for on-line direct files that are accessible from
several stations.

6. System design around it, is complex and costly.

Applications

A direct file organization is most suitable for interactive on-line applications such as:

1. Airline/Railway reservation systems

2. Teller facility in banking applications

Indexed Sequential File Organization
Basic principle "having index (directory)"

e.g.: A directory (index) in a large multistoried building that helps one to locate a particular
person's room within a building instead of searching door by door.

The contents (which serve as an index) help us to locate (page of the desired topic) so that one
can turn directly to that page to begin reading instead of searching each page.

Indexed sequential files use exactly the same principle.

In an indexed sequential file, records are stored sequentially on a direct access device (i.e.,
magnetic disk) and data is accessible either randomly or sequentially.

The sequential access of data occurs as one record at a time until the desired item of data is found.

The records of the file can be stored in random sequence but the index table is in sorted sequence
on the key value.

This technique is known as Indexed Sequential Access Method (ISAM).

Advantages
1. Permits the efficient and economical use of sequential processing techniques when the

activity ratio is high.

2. Permits direct access processing of records in a relatively efficient way when the activity
ratio is low.

Disadvantages
1. These files must be stored on a direct access storage device. Hence, relatively expensive

hardware and software resources are required.

2. Less efficient in the use of storage space than some other alternatives.
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This file organization is a compromise approach that combines some of the advantages of both
the sequential and direct approaches, and therefore used in almost all the applications, like
Material A/C, Banking Industry, etc.

5.4 MASTER FILE

Master files are files of a fairly permanent nature, e.g., inventory, payroll, etc. They include some
information which is of a permanent nature and also data which is continuously updated by
recent transactions.

e.g.: The master file could contain records having the following fields:

Emp No. Emp Name Emp Address Date of Joining

These attributes about an employee change less frequently.

Updation of Master File

The normal means of updating a master file is by:

1. Addition of data/records

2. Deletion of data/records

3. Amending of data/values

Types of Master Files

1. Static master files (or reference files)

l Permanent or semi-permanent nature.

l Example of some business entities are products, suppliers, customers, employee, etc.

l These are subject to occasional revision.

2. Dynamic master files (or table files)

l Transitory nature

l Example of some business entities are customer orders, works orders, price lists etc.

5.5 TRANSACTION FILE

Transaction files are files in which the data relating to business events is recorded, prior to a
further stage of processing and are created from source documents used for recording events or
transactions.

e.g.: Customer's orders for product

Purchase orders, job cards, invoice, despatch notes, etc.

A transaction file is a temporary file containing all relevant data about all transactions of one type.

e.g.: Daily sale transaction file

Daily stores issue file

A transaction file normally has two purposes:

1. To accumulate data about relevant events as they occur.

2. To update master files to reflect the results of most recent transactions.
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Student Activity 2

1. What do you mean by file organization? What are the various methods of file organization?

2. What are the advantages of sequential file organization?

3. List some application of direct file organization.

4. What is index sequential file organization?

5. Define master file and transaction file.

5.6 FILE DESIGN

File design refers to the relationship of the key of the record to the physical location of that record
in the computer file.

The two main objectives of design are:

l ease of file creation and maintenance, and

l providing an efficient means of storing and retrieving information.

To design a file, there are four methods that are commonly used in business data processing
applications. They are:

1. Serial

2. Sequential

3. Direct or Random

4. Indexed Sequential

The selection of a particular file organization depends upon factors like, the type of application,
the method of processing for updating files, size of file, etc.

Serial File

In serial file, records are stored without any consideration of their order or sequence.

Records have to be accessed in the serial fashion only.

Examples are: memory dumps, archival files, records of events, transaction files.

Each record is written after the last record in the current file. The order of records in the serial file
is according to the time when the data was generated.

Sequential File
In a sequential file, records are arranged in the ascending or descending order or chronological
order of a key field.

To access these records, the computer must read the file in sequence from the beginning.

The retrieval search ends only when the desired key matches with the key field or the currently
read record.

On an average, about half the file has to be searched to retrieve the desired record from a sequential
file.

Sequentially organized files are normally created and maintained on storage media such as magnetic
tape cartridge tape, magnetic disks, etc.

Advantage
1. Easy to organize, maintain, and understand.

2. There is no overhead in address generation locating a particular record requiring only the
specification of the key field.

3. Relatively inexpensive I/O media and devices can be used.
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the total number of records in transaction file and the total number of records in master file)
is very high. That is why this file organization is most suitable for transaction files.

Disadvantages
1. It proves to be very inefficient and uneconomical for applications in which the activity ratio

is very low.

2. Since an entire sequential file may need be read to retrieve and update few records,
accumulation of transactions into batches is required.

3. Transactions must be stored and placed in sequence prior to processing.

4. Timeliness of data in the file deteriorates while batches are being accumulated.

5. Data redundancy is typically high since the same data maybe stored in several files,
sequenced on different keys.

6. Random enquiries are virtually impossible to handle.

Applications
Payroll system

Billing and customer statement preparation

Bank cheque processing

Financial accounting

Direct or Random File

A direct file (also referred to as a relative or random organization) consists of records in such a
way that it is possible for the computer to directly locate the. desired record without having to
search through any other records first.

A record is stored by its key field.

For mapping the key fields to the locations, an arithmetic procedure called hashing algorithm is
frequently used.

This address generating function is selected in such a manner that the generated addresses
should be distributed uniformly over the entire range of the file area and a unique address must be
generated for each record key.

A Direct Access Storage Device (DASD) such as drum, disk, etc., are essential for storing a direct
file.

Advantages
1. The access to and retrieval of a record is quick and direct (within a fraction of a second).

2. Transactions need not be sorted and placed in sequence prior to processing.

3. Accumulation of transactions into batches is not required before processing them. They
maybe processed as and when generated.

4. It can also provide up-to-the minute information in response to enquiries from
simultaneously usable on-line stations.

5. If required, it is also possible to process direct file records sequentially in a record key
sequence.

6. A direct file organization is most suitable for interactive on-line applications.

Disadvantages
1. These files must be stored on a direct access storage device. Hence, relatively expensive

hardware and software resources are required.



154

Computer Application
in Management

2. File updation (addition and deletion of records) is more difficult as compared to sequential
files.

3. Address generation overhead is involved for accessing each record due to hashing function.
4. Maybe less efficient in the use of storage space then sequentially organized file.
5. Special security measures are necessary for on-line direct files that are accessible from

several stations.
6. System design around it, is complex and costly.

Applications

A direct file organization is most suitable for interactive on-line applications such as:

1. Airline/Railway reservation systems

2. Teller facility in banking applications

Indexed Sequential File

Basic principle "having index (directory)"

e.g.: A directory (index) in a large multistoried building that helps one to locate a particular
person's room within a building instead of searching door by door.

The contents (which serve as an index) help us to locate (page of the desired topic) so that one
can turn directly to that page to begin reading instead of searching each page. .

Indexed sequential files use exactly the same principle.

In an indexed sequential file, records are stored sequentially on a direct access device (i.e.,
magnetic disk) and data is accessible either randomly or sequentially.

The sequential access of data occurs as one record at a time until the desired item of data is found.

The records of the file can be stored in random sequence but the index table is in sorted sequence
on the key value.

This technique is known as Indexed Sequential Access Method (ISAM).

Advantages
1. Permits the efficient and economical use of sequential processing techniques when the

activity ratio is high.

2. Permits direct access processing of records in a relatively efficient way when the activity
ratio is low.

Disadvantages

1. These files must be stored on a direct access storage device. Hence, relatively expensive
hardware and software resources are required.

2. Less efficient in the use of storage space than some other alternatives.

Applications

This file organization is a compromise approach that combines some of the advantages of both
the sequential and direct approaches, and therefore used in almost all the applications, like
Material A/C, Banking Industry, etc.

Student Activity 3

1. What do you mean by file design? What are the objectives of file design?
2. Differentiate between serial file and sequential file.
3. What is a direct file?
4. What are the disadvantages of an  Indexed sequential file?
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Systems analysts specify reports when they need a record of data or a report of information, or
circulate a large volume of information to several persons simultaneously.

Only those reports whose printing is absolutely necessary should be printed. One well designed
report may sometimes replace several poorly designed ones. Providing unnecessary details assists
no one, so analysts should be alert to avoid producing extraneous data.

Printed Reports

Printed reports vary in size, although analysts often use these standard sizes:

l 91/2 by 11 inches

l 11 by 14.7/8 inches

l 8 by 14.7/8 inches

These sizes are for continuous forms (sometimes called pin-fed or fan-fold forms)–connected
sheets of papers that feed into the printer one after the other.

All the features of printed output are available in microfilm and microfiche, the two film output
methods. Film output reduces output cost by approximately one-third. After developing in the
microfiche machine, film can be stored and retrieved when needed. For reference data used only
sporadically, such as private saving account balance that changes infrequently and can have
interest pasted every three months, microfilm could be a useful output option.

A page of output takes so little space when stored on microfilm. One square inch of a film can
store as much information as several pages of paper report. A 3.5 inch card stores the equivalent
of hundreds of pages.

The time taken to locate the film reel or card containing the information wanted the user must
maintain an index and to load the film into a microfilm or microfiche reader for viewing is a real
disadvantage.

Special Forms

Reports could be printed on simple paper. But usually, when an organization sends a report to its
customer, the logo and the name of the organization is also printed on it. Sometimes, the report is
printed on a paper which is "pre-printed". Recall your high school marksheets. The name of the
board, the year and logo of the board as well as the name of examination passed were printed on
the paper. The marks, name, school name, date of birth, etc., were printed afterwards. Another
example is your electricity bill. The titles of various labels are preprinted. The values against them
are printed by the information system.

Layout of a Printed Report

An output layout is the arrangement of items on the output medium. When analysts design an
output layout, they are building a mock up of the actual report or document as it will appear after
the system is in operation. The layout should show the location and position of the following:

l  All variable information

Item details

Summaries and totals

Control breaks

Separators
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l All preprinted details

Headings

Document names and titles

Corporate name and address

Instructions

Notes and comments

As we discussed earlier, the layout is a blueprint that will guide the construction of programmes
later in the development process. Each variable in the layout must be accounted for in programme
instructions.

Guidelines for Designing Printed Report
l Reports and documents have to be designed to be read from left to right and from top to

bottom.

l The most important items should be easiest to find (roll number in a marks crosslist is most
important, hence it is placed on the left most column).

l All pages should have a title and page number and show the date on which the output was
produced.

l All columns must be labelled.

l Abbreviations must be avoided.

Some organizations specify standards that guide design practices in addition to the above
guidelines. A sample report format is shown in Figure 5.1.

Figure 5.1: Sample of Report Layout
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Commercial outputs need formatted output. These formatted outputs are known as reports. A
formatted report may have the following:

1. Report heading

2. Page heading

3. Page numbering

4. Footers

5. Some remarks

6. Date, month, and year of printing

Commercial outputs may also extend over multiple pages. In that case, one will have to keep a
provision in his program so that certain details get printed on every page.

e.g.: One may have to print page headings on every page.

Report maybe of

1. Single page

2. Multiple page

Languages provide different picture templates for these purposes.

Multiple Page Report

Multiple page reports in general may consist of following parts:

1. Report heading

2. Report sub heading

3. Page heading

4. Page footer

5. Report detail

Report Heading

It represents the title of the report and appears, only on the first page of the report.

Report Sub Heading

It is printed as and when required on each page.

Page Heading

It is printed on the top of each page.

Page Footer

It is printed at the bottom of each page. It is generally the total number of records on the page, sum
of the numeric data, etc.

Report Detail

This constitutes the main body of report. The output details or the information of the main
consequence are listed in this group.

Reports with Control Break

The most important objective of a program is reporting. We need summarized information for
decision making. For presenting the summarized information one can use the concept of control
break.
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In control break report, one need group information based on some common criterion.

Example:

In this report control break is on the region.

Analysis of report shows the following points:

1. Records of a particular region are grouped together and printed at one place.

2. When the control break occurs, certain procedures are followed. Such as total sales of that
region.

3. It maybe necessary that performance of each region is printed on each page, i.e., when the
control break occurs the report is printed on a fresh page.

4. At the end of the report, it maybe necessary to calculate and print the grand totals.

Label Generation

Creating Labels means to generate address slip in computer. Creating mailing labels is a two step
process:

(1) Designing Label Form

(2) Production of Labels

Designing Label Form

In this step, we design labels. We select the label layout and then place the fields, text and
pictures and other objects on it. After designing label, don't forget to save it.

Production of Labels

When you have designed and label form you want, you can print the labels at any time. At this
time, label is ready to use.

5.8 RELEVANCE OF DATABASE MANAGEMENT
SYSTEMS

Database Management System (DBMS) in very important for an organization. One of the main
advantages of using a database system is that the organization can exert, via the DBA, centralized
management and control over the data. The database administrator is the focus of the centralized
control. Following are the important features of DBMS:

(a) Reduction of Redundancies: DBA avoids unnecessary duplication of data and effectively
reduces the total amount of data storage required. It also eliminates the extra processing
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duplication is the elimination of the inconsistencies that tend to be present in redundant
data files. Any redundancies that exist in the DBMS are controlled and the system ensures
that these multiple copies are consistent.

(b) Shared Data: A database allows the share of data under its control by any number of
application programs or users.

(c) Integrity: Data integrity means that the data contained in the database is both accurate and
consistent. Therefore, data values being entered for storage could be checked to ensure
that they fall within a specified range and are of the correct format. Centralized control can
also ensure that adequate checks are incorporated in the DBMS to provide data integrity.

(d) Security: Data is of vital importance to an organization and maybe confidential. Such
confidential data must be accessed by unauthorized persons. The DBA who has the ultimate
responsibility for the data in the DBMS can ensure that proper access procedures are
followed, including proper authentication schemes for access to the DBMS and additional
checks before permitting access to sensitive data. Different levels of security could be
implemented for various types of data and operations.

(e) Conflict Resolution: Since the database is under the control of the DBS, therefore, he
should resolve the conflicting requirements of various users and applications. In short,
DBA chooses the best file structure and access method to get optimal performance for the
response critical applications, while permitting less critical applications to continue to use
the database, albeit with a relatively slower response.

(f) Data Independence: Data independence is usually considered from two points of view,
physical data independence and logical data independence. Physical data independence
allows changes in the physical storage devices or organization of the files to be made
without requiring changes in the conceptual view or any of the eternal views and hence in
application programs using the database.

Logical data independence implies that application programs need not be changed if fields are
added to an existing record nor do they have to be changed if fields not used by application
programs are deleted.

5.9 INTEGRATION OF APPLICATION

In a typical business organization several applications work in tandem to realize its business
objectives. However, when implemented and managed separately the applications neither achieve
a cost effective solution nor they are easily manageable. The application availability and sharing
can be greatly enhanced by integrating the existing applications in one single unit. The management
control and security concerns make application integration mandatory. Therefore, these individual
applications need to be integrated into not department-wide but enterprise-wide application.
Many solutions have come to foray like ERP (Enterprise Resource Planning).

According to a recent survey, a typical global company has 30 to 50 enterprise applications and
spends 25 to 40 per cent of its Information Technology (IT) budget on application integration.
And integration requirements are intensifying with the current wave of acquisitions and mergers.
Custom point-to-point solutions and other e-band-aids can solve pieces of the problem in the
short term, but they are typically expensive to produce and difficult to maintain. Application
integration aims at creating a cost-effective integration architecture and infrastructure to promote
interoperability among applications. And interoperability is the key to agility for the accelerating
change that rules today's global marketplace.

Cross-functional business processes through integration enable the open flow of information
between systems, across organizations, between enterprises and among trading partners. Several
technologies are available to integrate web-based applications, front-and-back-office systems,
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ERP systems, and package software applications. Some of the most popular application integration
solutions are PeopleSoft, Oracle, SAP, and other leading ERP systems, as well as all leading
database management systems (DBMSs). A typical application integration looks similar to the
one depicted in the figure given below:

There are several issues related to integration of applications such as:
1. Cost: Cost is by and large the most important issue in application integration. The cost of

integration must justify the overall improvement achieved.
2. Compatibility: Generally, the applications are developed and implemented in isolation with

little or no consideration with other applications. This fact gives rise to compatibility
problems among the component applications.

3. Legacy applications: Some applications may exist in the organization which is probably
very old (say implemented in very old technology) and yet cannot be thrown off. Such
systems are called legacy systems. Integration of these systems sometimes is very
challenging.

4. Migration: The database and/ or process maybe required to be implemented in new
technology from existing old ones. Many a time the source code does exist only an executable
form of the process maybe available. In such cases, reverse engineering exercise maybe
needed.

5. Operational control: Once an application is integrated with another one, there is in general
a shift in the control from one entity to another. There may also be a sharing of control on
the application. Therefore, a redesigning of the control and authority is often required.

6. Security: Application integration exposes the system to more security threats than when
they are stand-alone. The vulnerability of the system to security threats must be considered
very seriously.

7. User training: Along with the integration there maybe significant change in the way, users
have been interacting with the system hitherto. Therefore, user training in the new
environment must also be considered carefully.

5.10 INTRODUCTION TO A MICRO DATABASE
MANAGER

The database manager is a program module which provides the interface between the low-level
data stored in the database and the application programs and queries submitted to the system.
Databases typically require lots of storage space (in gigabytes). This must be stored on disks.
Data is moved between disk and main memory as and when needed. The goal of the database
system is to simplify and facilitate access to data. The performance in terms of response time, is
also very important.
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The database manager module is responsible for all these tasks in the following way:

1. Interface with the file manager: Database manager interacts with the file manager of the
operating system by storing raw data on disk using the file system usually provided by a
conventional operating system. The database manager would translate a DML (Data
Manipulation Language) statement into sequence of low-level file system commands for
storing, retrieving and updating data in the database.

2. Integrity enforcement: It enforces integrity by checking that updates in the database do
not violate consistency constraints. For example, in a bank database, it is the task of the
database manager to see that no bank account balance is below Rs. 1000 as otherwise it
would violate consistency constraint.

3. Security enforcement: By defining security checks and constraints, the database manager
ensures that the database is safe. The database manager is endowed with the power of
letting the users use the database and also deny it. It is the sole responsible person to
provide access rights to a user like - read only, read-write etc.

4. Backup and recovery: Database is such a valuable asset that the database manager must
ensure that it is not damaged or lost. Therefore, it regularly takes backup of the database. In
case of any failure it initiates suitable recovery procedure to resurrect the database. It must
also do it in the least amount of time.

Student Activity 4

1. What is a printed report? Describe its layout.

2. Give the necessary guidelines to design a printed report.

3. What are labels? How you generate them?

4. What are the features of DBMS?

5. List some issues related to integration of application.

6. What is a micro database manager?

5.11 SUMMARY
l A file is a collection of related records.

l A file is made up of record, which are made up of fields, which in turn are made up of
characters.

l Fields within logical records are normally called "data items".

l A record is recognized or identified by the record KEY.

l Data files can be broadly classified as master files, transaction files, and references files.

l The physical nature of the storage device will have a direct bearing on the way files are
organised on it and also on the method of access.

l There are three main types of file design: sequential, indexed sequential and direct access.

l System analysts specify reports when they need a record of data or a report of information.
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l Printed reports vary in sizes. Its all the features are available in microfilm and microfiche.

l The layout is a blueprint that will guide the construction of programmes later in the
development process.

l A formatted report may have Report heading, Page heading, Page numbering, Footers,
some remarks, date, month and year of printing.

l In control break report, one need group information bared on some common criterion.

l DBMS reduces data-redundancy, allows to share data, assures data integrity and security,
resolves the conflicts among various users and supports data independence.

l The database manager module is responsible for managing interface with the file manager,
integrity enforcement, security enforcement, and backup and recovery of data.

5.12 KEYWORDS

File: A collection of related records.

Data File: Well defined data structures that contain related data organized in convenient groupings
of records.

Program Files: Files used to store programs.

Executable Files: Files which store ready to execute programs.

Direct File: A file which consists of records that can be directly located without having to search
through any other records.

Index Sequential Access Method (ISAM): The technique where the records of the file can be
stored in random sequence but the index table is in sorted sequence on the key value.

Master Files: Files which include some information of permanent nature and are updated by
recent transactions.

Transaction Files: Files in which the data relating to business events recorded, prior to further
stage of processing and are created from source documents used for recording events or
transactions.

Serial File: File where records are stored without any consideration of their order or sequence.

Sequential File: File where records are arranged in ascending or descending order or chronological
order of a key field.

Redundancy: Duplication of data.

Data Integrity: Implies that the data  contained in the database in both accurate and consistent.

Database Manager: A program module which provides the interface between the low level data
stored in the database and the application programs and queries submitted to the system.

5.13 REVIEW QUESTIONS

Unsolved Questions
1. Fill in the blanks:

(a) A——is used to store the data records.

(b) Data in files can be organized——,——,—or——.

(c) ——is the most economical and efficient file organization.

(d) A——is essential for storing a direct file.

(e) System design around random file organization is——and——.
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File System and Data Base(f) ———are files of a fairly permanent nature.

(g) Commercial outputs need——output called——.

2. State : True or False:

(a) A transaction file is a temporary file containing all relevant data about all transactions
of one type.

(b) In a serial file, records are stored without any consideration of their order or sequence.

(c) A direct file organization is most suitable for airline/railway reservation systems.

(d) Reports and documents have to be designed to be read from left to right and from top
to bottom.

(e) A database does not provide data sharing and data security.

Answers (Unsolved Questions)
1. (a) Data file (b) serially sequentially, index sequentially, randomly (c) sequential file

organization (d) direct access storage device. (e) complex, costly (f) Master files
(g) formatted, reports

2. (a) True    (b)   False    (c)  True   (d)  True     (e)   False

Detailed Questions
1. What is the difference between a data file and an executable file?
2. What is the difference between a program file and an object code file?
3. What is a formatted text file?
4. Describe various types of file organizations.
5. Compare sequential and Index sequential file organization?
6. What are the advantages and disadvantages of random file organization?
7. What is a master file? Describe its various types.
8. What is the purpose of having a transaction file.
9. Describe various file design methods.
10. List some applications of sequential file.
11. Why do we require printed report?
12. Describe the layout of a printed report?
13. What should a formatted report contain?
14. Describe the reports with control break?
15. What do you mean by data redundancy and Integrity?
16. How does DBMS support security of data?
17. What are the issues related to integration of an application ?
18. What are the responsibilities of a database manager module?

5.14 FURTHER READINGS

Sanjeev Gupta, Shameena Gupta, Computer Aided Management (Using MS-Office 2003
Tools), Excel Books.

Manoj Kumar, M. Shamir Bhudookan, Information Technology for ‘O’ Level, Editions De
L’Ocean Indien.
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6
PROGRAM AND DEVELOPMENT

L E A R N I N G  O B J E C T I V E S

After studying this unit, you should be able to understand:

How to define a program.

Various steps in program development.

Characteristics of a good program.

Flow charts and rules for drawing flow charts.

Input-process-output analysis.

U N I T  S T R U C T U R E

6.1 Introduction
6.2 Program Definition
6.3 Steps in Program Development
6.4 Characteristics of a Good Program
6.5 Data Handling and Declaration
6.6 Introduction to Flow Charts
6.7 Input Process Output Analysis
6.8 Summary
6.9 Keywords
6.10 Review Questions
6.11 Further Readings

6.1 INTRODUCTION

A program is a series of instructions that perform a particular task and is recorded in some form on
a computer disk. Simply, program is an abstract collection of instructions for computers to perform
specific tasks. It is variously known as a program or software program.

6.2 PROGRAM DEFINITION

In order to solve a computation problem, its solution must be specified in terms of a sequence of
computational steps, each of which maybe effectively performed by a human agent or by a digital
computer.

Systematic notations for the specification of such sequences of computation steps are referred to
as programming languages.

A sequence of statements (instructions) in order to carry out a defined task is referred to as
program.

The task of developing programs for the solution of computation problems is referred to as
programming.

A person engaged in the activity of programming is referred to as programmer.
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The following basic steps are involved in writing computer programs:

1. Problem identification

2. Task analysis and data analysis

3. Output identification

4. Designing the solution

5. Data validation

6. Implementation and debugging

7. Final documentation and maintenance

Ideally, these steps are generally performed in sequence. But in practice, the development goes
through a spiral process.

6.4 CHARACTERISTICS OF A GOOD PROGRAM
A "good" program has the characteristics mentioned below:

Accuracy : The program must do what it is supposed to do, and meet the criteria laid
down in its specification.

Reliability : The program must ALWAYS do what it is supposed to do, and never
crash.

Efficiency : The program must use the available store space and resources in such a
way that the system's speed is not wasted.

Robustness : The program should cope with invalid data without stopping with no
indication as to the cause and without creating errors.

Usability : The program must be easy to use and well documented.

Maintainability : The program must be easy to amend, having good structuring and
documentation.

Readability : The code in the program must be well laid out and explained with
comments.

6.5 DATA HANDLING AND DECLARATION
The main function of a computer program is data processing. A program:

Accepts data from outside the computer as its input.

Carries out a set of processes on the data.

Stores the data for future use.

Presents the results of this processing as its output.

e.g.: Details of an order from a client maybe input and invoice maybe output in a case.

In context of a computer program, data is a sequence of 0's and 1's, in coded form.

Almost all program languages expect the program to start by declaring any data item used by it.
This means listing the name given to each item of data, and stating what kind of data it is?

Special translating program turns these instructions in form which gives the correct interpretation
to each label. This will ensure the program treats a number as a number and not as a character.

Types of Data
Constants

Data which is predetermined before a program is used is known as constants. Values remain
unchanged during the execution of a program.
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Have a fixed range in computer applications.

Types integer / fixed point (e.g., 0, 303, + 155)

real/floating point (e.g., 24.567, -123.5, 0.546)

character / string (e.g., 'MICROSOFT', '10, Lenin Road')

Variables

Data which may change or be assigned different values as the program runs is known as
variables.

Limitations imposed by language on maximum number of characters used to form variable
names.

Variable Types

Each type occupies different storage in RAM and contains values within limits specified for
constants of the same type.

Integer or fixed point

Real or floating point

Character or string

Student Activity 1

1. What is a program?

2. What are the various steps involved in development of a program?

3. What are the characteristics of a good program?

4. What are the various data types involved in a program?

6.6 INTRODUCTION TO FLOW CHARTS
Pictorial description of program logic.

Clarifies step by step logic of the program.

Symbolic representation of each input, output and processing logic.

Establishes a link between the programer and the user.

Helps understanding, error corrections, and changing of programs.

Independent of program coding activity in any language like COBOL, C, or PASCAL.

Part of program documentation.

Flow Chart Symbols

Terminal Box

The beginning, end of a point of interruption in a program, is represented by the terminal box.

Input/Output Box

Any function of an input/output device (marking information available for processing, recording,
processing information, etc.) is represented by input/ output box.

e.g.: END

e.g.: Input A
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A group of program instructions that perform a processing function of the program is represented
by this symbol.

Decision  Box

This box is used to document points in the program where a branch to alternate paths is possible
based upon variable conditions.

Connector

An entry to, or an exit from another part of the program flow chart is represented by this symbol.

Flow Lines

Flow lines connect symbols to show the sequence of logical setups.

←     ↑     ↓     →

Predefined Box

A group of operations not detailed in the particular set of flow charts are represented by the
predefined box.

Rules for Drawing Flow Charts

Rule 1

Program flow charts should use conventional symbols.

Rule 2

The logic of a program flow chart should flow from top to bottom and from left to right.

e.g.: A≥B

(C)

e.g.:
Calculate
Gross Pay
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Good Logic

Bad Logic

Rule 3

Each symbol should have one entry point and one exit point.

Rule 4

Instructions within symbols should be in language.

Rule 5

Clearly label the exits of a decision symbol.
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Flow charts are used for a broad variety of applications in different types of work. These give a
clear graphical/pictorial representation of the various paths that must be followed to perform the
acts to accomplish the goals of the program.

Flow charts are invaluable at the time when modifications must be made to the original program to
perform additional services not planned originally.

Flow charts are language independent. Flow charts are a visual representation, and hence provide
a convenient alternative to the usual narrative description for a program of system.

Flow charts offer a controllable level or detail. They are usable from the most summary systems
level to the most detailed programming level.

Drawbacks of Flow Charts

Flow charts are something new and strange to work with for beginners. When modifications are
made in the original program, corresponding changes must be made in the flow charts of the
program in the documentation.

Flow charts may not reveal significant steps to be followed in actual coding. Flow charts are often
cumbersome to use and costly to produce. Flow charts do not constitute a programming language,
they are person-to-person means of communication, not person-to-computer. Flow charts are
difficult to produce at a summary level.

Logical Constructs used in Flow Charts

The three types of logical constructs are:

Sequential logic

Selective logic

Iterative logic

Sequential Logic

The instructions are executed in order from top to bottom.

Selectional Logic

This employs a number of structures called if structures, each of which is essentially a selection
of one, out of several alternatives. This is equivalent to the code:

IF test

THEN A;

ELSE  B;

end if

Instruction 1

Instruction 2

Instruction 3

Instruction 4

↓

↓

↓

↓
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Iterative Logic

This involves the structures involving loops. Iterative construct is further categorized as: Do
While-End do, Repeat-Until, and For-Next loops.

While test

do process;

end do;

repeat process;

until test;

Flow Chart Examples

Example 1.  Draw a flow chart to print first 100 numbers using Do While-End do logic.
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Example 3.  Draw a flow chart to allow the user to enter a non-blank name and display a welcome
message for the user on the screen.

Example 4.  Flow chart for a program to calculate salary.
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Types of Flow Charts

The two major varieties of flow charts used presently in practice are:

System flow charts

Program flow charts

System Flow Chart

In system flow charts, the unit of data transformation is usually an operation, i.e., it usually
shows the work done by an entire computer program.

e.g.: Sorting a file of data, Inverting a matrix, Producing a report.

System charts stress on what data is used and produced at various points in a sequence of
operations.

It represents the flow of documents, the operation or activities performed, the persons or
work station.

It is an important tool of system analysis and plays a key role in the evaluation of existing
system, designing, and documentations of new systems.

System flow charts are usually prepared as an aid to the management and systems analysts.

Program Flow Charts

In program flow charts the unit of data transformation is usually an operation or short
sequence of operations that a computer performs.

Program flow charts stress on how data is transformed.

Such a diagram provides complete and detailed sequence of logical operations, to be
performed in the central processing unit of the computer for executing the program.

Generally, the programer will use these flow charts to translate the elementary steps of a
procedure into a program of coded instructions.

6.7 INPUT PROCESS OUTPUT ANALYSIS

Every process can be thought of as an agent that takes some input(s) and transforms it (them)
into output(s) as shown below:

The input-process-output analysis of a system is vital to understand, characterize and design a
system. Therefore, it is extensively used in the system analysis and design. Under this approach,
the entire system is broken down into small processes. For each process the set of inputs and
outputs are identified. The same is expressed using DFD (Data Flow Diagrams). If a process is
complex to interpret it maybe further broken down into simpler processes repeatedly until each
process is simple enough to be handled separately.

Student Activity 2

1. What is a flow chart?

2. Describe various flow chart symbols.

3. Describe the rules for drawing flow charts.

4. What are the draw backs of flow charts?

5. Describe the logical constructs used in flow charts.

Process
Input(s) Output(s)
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7. Write a short note on Input-process-output analysis.

6.8 SUMMARY

A program is a series of instruction that perform a particular task. The task of developing programs
for the solution of computation problems is referred to as programming. The steps involved in
writing computer programs are problem identification, task and data analysis, output identification,
designing the solution data validation, Implementation, debugging final documentation and
maintenance. A good program should be accurate, reliable, efficient, robust, reusable, maintainable
and readable. The main function of a computer program is data processing. Various types of data
include constants and variables.

Flow charts are the pictorial description of program logic. The symbols used in a flow chart
include terminal box-to represent the beginning and end of a program; Input/output box-to
represent any function of an input/output device; processing symbol-to represent instructions
that perform a processing function; decision box-to document those points where a branch to
alternate paths is shown; connectors-to represent an entry to, or an exit from another part of the
program flow chart; flow lines-to connect the sequence of logical setups; and predefined box-to
show a group of operations not detailed in the particular set of flow charts. Flow charts offer a
controllable level of detail but still are something strange to work with for beginners. The logical
constructs used in flow charts include sequential logic, selective logic and iterative logic. The
two major varieties of flow charts are system flow charts and program flow charts.

Every process takes some input (s) and transforms it (them ) into output (s). The input-process-
output analysis of a system is vital to understand, characterize and design a system.

6.9 KEYWORDS
Program: A series of instructions that perform a particular task and is recorded in some form on
a computer disk.

Programming: The task of developing programs for the solution of computation problems.

Programmer: A person engaged in the activity of programming.

Constant: Data which is predetermined before a program is used.

Variable: Data which may change or be assignment different values as the program runs.

Flowchart: Pictorial representation of program logic.

6.10 REVIEW QUESTIONS

Unsolved Questions
1. Fill in the blanks:

(a) A sequence of instructions in order to carry out defined task is referred to as_____

(b) Data which is predetermined before a program is used is known as_____

(c) ______is the pictorial description of program logic.

(d) The ______analysis of a system is vital to understand, characterize and design a
system.

2. State: True or False:

(a) A good program must do what it is supposed to do.

(b) The code in the program must be well laid out and explained with comments.

(c) Each variable type occupies same storage in RAM.
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(d) Flow charts are not a parts of program documentation.

(e) The logic of a program flow chart should flow from top to bottom and from left to right.

Answers (Unsolved Questions)
1. (a) Program (b) Constants (c) Flow chart (d) Input process output

2. (a) True (b) True (c) False (d) False (e) True

Detailed Questions
1. Define a program, programming and programmer.

2. What do you mean by data declaration?

3. What is a flow chart? Describe its various types.

4. What is the used of predefined box in a flowchart?

5. Describe the function of a connector in the flow chart.

6. What are the advantages of flow charts.

7. Describe various logical constructs used in flow charts.

8. Draw a flow chart to print prime numbers between 1 and 100.

9. Draw a flow chart to calculate amount using formula A= P(1+r/100)n.

6.11 FURTHER READINGS

Richard Holowczak,  Programming Concepts - A Brief Tutorial for New Programmers,
http://cisnet.baruch.cuny.edu/holowczak/classes/programming.

Manoj Kumar, M. Shamir Bhudookan, Information Technology for ‘O’ Level, Editions De
L’Ocean Indien.
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UNIT

7
PROGRAMMING CONCEPTS

L E A R N I N G  O B J E C T I V E S

After studying this unit, you should be able to understand:

Various techniques of program design.

Linear and structured programming.

Basic constructs of structured programming.

The modular design of programs and communication between modules design.

The requirements of module design.

U N I T  S T R U C T U R E
7.1 Introduction
7.2 Program Design Techniques
7.3 Programming Techniques
7.4 Modular Design of Programs
7.5 Module Design Requirements
7.6 Summary
7.7 Keywords
7.8 Review Questions
7.9 Further Readings

7.1 INTRODUCTION

A set of program design concepts has evolved over the past three decades. Although the degree
of interest in each concept has varied over the years, each has stood the test of time. Each
provides the program designer with a foundation from which more sophisticated design methods
can be applied. In this chapter we will discuss various techniques of program design. The concept
of modularity will also be discussed.

7.2 PROGRAM DESIGN TECHNIQUES

Top Down Design

The top down design approach is based on the fact that large problems become more manageable
if they are divided into a number of smaller and simpler tasks which can be tackled separately.
What is really required is that each of these parts have the properties of a module.

Top down design approach is performed in a special way. The main program is written first. It is
tested before sub-programs are written. To do this, the actual sub-programs are replaced with
stubs. The stubs simply test to see if the data is passed correctly.

After the main program is written and checked, each module is written and tested in turn. This
should first be done without the main program in order to isolate a stub if an error occurs.

A simple main program is written to test the sub programs. If the modules run properly, then it is
tested with the main program.

If the module and the main program run properly then the next module is written and checked and
so on.
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To describe the program at its highest level, we use something called the "universal program",
and then by a process of "stepwise refinement" work out the details of each part of the program.

Example 1

Problem:  How to reach Kolkata from Delhi by train?

Let us apply top-down design approach on this problem. Break this problem into smaller problem
as follows:

Figure 7.1: Top-down Design

The problem (whole) has been broken into smaller problems each easily manageable and solvable.
If need be, these smaller tasks may be further broken into still smaller tasks. These smaller tasks
- viz. how to buy a ticket, can be solved easily than the whole problem at a time.

Advantages
1. At each stage, the sub programs are tested by themselves and then the main program is

tested. Whenever modules are added, they are tested with the main program so if any error
occurs it will probably be in a module only and this will be easy to debug.

2. It is desirable for modules to be kept small in general. As far as possible a module should be
less than 100 statement lines long.

Top Down Implementation
1. Start with a very simple and short statement of what the program does. This is the top level

in the design.

2. Go to the next level of details for the whole program, try to describe the program as sequence,
selection or repetition of main tasks. Each of these tasks should be complete in itself but will
be described in greater detail at the next level of program development. These tasks are
called module. A module should have just one entry point and just one exit point.

3. This process is repeated step by step, and at each step all the modules at that level are
refined or developed to the next level of details. This is called step-wise-refinement. The
step-wise-refinement stops when there are sufficient details for the procedure to be written
in a programming language.

4. At the intermediate steps in the refinement, pseudo code or flowcharts are used to represent
the procedure.

5. At every stage unnecessary details are left out.

6. It is important that at each stage the .individual modules are checked to make sure that they
perform the correct actions on the appropriate data.
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A bottom up approach would be to write the most basic subroutines in the hierarchy first and
then use them to make more sophisticated subroutines.

Example 2

Problem:  How to reach Delhi to Kolkata by train?

Figure 7.2: Bottom-up Approach

The pure bottom up approach is generally not recommended because it is difficult to anticipate
which low level subroutines will be needed for any particular program. It can often be a useful first
step to produce a library of basic functions and procedures before embarking on a major project.

In the bottom up approach it is usually assumed that the basic routines created will be general
enough to be used more than once.

Using the subroutines, to construct a program, save yourself repeating the same lines of code by
reusing it.

A routine that is used many times has a very difficult status to those higher in the hierarchy. It is
more like a basic instruction in the programming language than a large scale program component.

7.3 PROGRAMMING TECHNIQUES

Linear Programming

Linear program is a method for straight forward programming in a sequential manner. This type of
programming does not involve any decision making. A general model of these linear programs is:

1. Read a data value

2. Compute an intermediate result

3. Use the intermediate result to compute the desired answer

4. Print the answer

5. Stop.

Structured Programming

Structured programs are the ones that are divided into functional modules and arranged in an
hierarchical order instead of programs written in a sequence.
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One of the most versatile properties of a digital computer is that it can make a "decision", thus
creating a branching point. There are also times when it becomes necessary for a program to
"Look Back" over a set of statements, a number of times. If branching and looping can be used,
then much more complex iterative algorithms can be written, which in turn results in more complex
programs.

There are procedures that can be used for writing these complex programs that make them much
less error prone and much easier to debug. The technique for writing such programs are referred
to as Structured programming.

Structured programming refers to the process in which we break the overall job down into separate
piece of modules. The above figure shows, that how a salary program is broken down into number
of small modules.

These modules, in turn, are broken down into smaller pieces which can also be further subdivided.
Modules must be chosen in such a way that we can specify how they have to interact. In effect,
there is a contact between each pair of modules.

This contact specifies two things:

1. What the module will do?

2. What assumptions is it making about the behavior of the other modules? In particular, we
must specify explicitly what inputs a particular module is to receive from the various other
modules and what outputs it is to provide for them.

Advantages to Structured Programming

1. Decreases the complexity of the program by breaking it down into smaller logical units.

2. Allows several programmers to perform coding simultaneously.

3. Allows common functions to be written once and then use in all the programs needing it.

4. Decreases debugging time, because modules make it easier to isolate errors.

5. Amendments to single modules do not affect the rest of the program.

6. It saves time to use modular structures rather than using self made structure. If a job can be
done well by using what is already available and known to be well tried and tested then
trying out something new for sake of it, is a waste of effort.

7. Standard method; so, less time is required in writing programs.

8. It is easier to name modules in such a way that they are easy to find in the documentation,
and consistent.



179

Programming ConceptsBasic Constructs of Structured Programming

There are three program constructs used normally in structured programs. They are:

1. Sequence

2. Selection

3. Repetition (Iteration Logic)

Sequence

Structure consists of the action followed by another till the desired result is obtained.

Statement 1

Statement 2

---------------

---------------

Statement n

Selection
This construct indicates a decision one way, two way or multi-way selection.

In conditional execution there is a need carry out a logical test and then take some particular
action which depends upon the result of that test.

Selection is a special kind of conditional execution in which a particular group of statements
is chosen from several available groups.

If (condition is true) then

sequence of statements

else

another sequence of statements

end if

The selection structure consists of a test for a condition followed by two alternative paths
for the program to follow. The program selects one of the program-control paths depending
on the outcome of the test condition. After performing one of two paths, the program
control returns to a single point. This pattern can be termed as if ... else because of its logic.

Iteration
In most cases programs require that a group of consecutive instructions be executed
repeatedly until some logical condition has been satisfied. Generally, the required number
of repetitions are not known in advance. This type of repetition is known as conditional
looping.

Another type of repetition is unconditional looping. In this, the execution of a group of
consecutive instructions is repeated for some specified number of times, this is done by for
loop.

The repetitive structure can also be called loop and represents an iterative process. Iterative
logic refers to structure involving loops of which, there are two types:

1. do while (condition is true)

a sequence of statements

end do

2. repeat

a sequence of statements

until (condition is true)
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These three coding structures allow a program to be read from top to bottom, making the logic of
the program more visible for checking and maintenance.

These control structures are easy to use because:

1. They are easy to recognize when looking for solutions to programming problems.

2. They are simple to deal with because they have just one entry point and just one exit point.

3. They are free of the complications of any particular programming language.

Student Activity 1

1. List various program design techniques.

2. Describe top down design technique.

3. Describe bottom-up design technique.

4. Define linear program and structured program.

5. What are the basic constructs of structured programming?

7.4 MODULAR DESIGN OF PROGRAMS

One of the key concepts in the application of programming discipline is the design of a program
as a set of units referred to as blocks or modules.

A program module is defined as the part of a program that performs a separate function, e.g.,
input, input validation, processing of one type of input.

A program module maybe quite large, so that it maybe further divided into logical sub modules.
The process of subdivision continues until all modules are of manageable size in terms of complexity
of logic and numbers of instructions.

Programs can be logically separated into the following functional modules:

1. Initialization

2. Input

3. Input data validation

4. Processing

5. Output

6. Error handling

7. Closing procedure

The modules reflect a logical flow for a computer program. After initialization, processing proceeds
logically with input, input validation, various processing modules and output. Error handling
maybe required during execution of any module.

Basic Attributes

A module is a collection of program statements with five basic attributes.

An input

An output

A function

A mechanism

Internal data
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The structure charts show the interrelationships of modules by arranging them at different
levels and connecting modules in those levels by arrows. An arrow between two modules
means the program control is passed from one module to the other at execution time. The
first module is said to call or invoke the lower level modules.

There are three rules for controlling the relationship between modules:

There is only one module at the top of the structure. This is called the root or boss module.

The root passes control down the structure chart to the lower level modules. However,
control is always returned to the invoking module and a finished module should always
terminate at the root.

There can be no more than one control relationship between any two modules on the
structure chart, thus, if module a invokes module b, then b cannot invoke module a.

Communication between Modules

Two types of informations are passed between modules:

(i) Data

(ii) Control

Data is shown by an arrow with an empty circle at its tail.

Control items are used to direct program control and show error or end of file conditions. This
control couple is shown by a filled-in circle on the tail of arrow.

7.5 MODULE DESIGN REQUIREMENTS

A hierarchical structure should present many advantages in management, development, testing
and maintenance. However, such advantages will only occur if the module design reflects certain
particular qualities like independence and strength.

Coupling: Coupling means the strength of relations between modules. Modules should
have little dependence on other modules in a system so that any change in one module has
limited effect on any other modules. It means that coupling should be minimized.

Cohesion: Cohesion means strength of relations within a module. Modules should carry
out a single processing function, i.e., cohesion should be maximized.

Span of: It means number of modules subordinate to a calling module. Modules should
interact with and manage the functions of a limited number of lower level modules. Limit of
span of control is 5 to 7 modules.

Size: The number of instructions contained in a module should be limited so that module
size is generally small.

Shared Use: Functions should not be duplicated in separated modules, but established in
a single module that can be invoked by any other module when needed.

Student Activity 2

1. What is a program module?

2. What are the functional modules of a program?

3. What are the basic attributes of a program model?

4. Describe the rules for controlling relationship between various modules of a program.

5. Describe various requirements of module design.
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In the top down design technique, the main program is written and tested before sub programs are
written, then each module is written and tested in turn. A bottom-up approach would be to write
the most basic subroutines in the hierarchy first and then use them to make more sophisticated-
subroutines. Linear program is a method for straight forward programming in a sequential manner.
Structured programs are the ones that are divided into functional modules and arranged in a
hierarchical order. Branching and looping allows much more complex iterative algorithms to be
written, which in turn results in more complex programs. Structured programming decreases the
complexity of program by breaking-down into smaller logical units, reduces debugging and program
writing time. The three program constructs used in  structured programs are sequence, selection
and repetition (iteration) logic.

A program module is the part of a program that performs a separate function. The structure charts
show the interrelationships of modules by arranging them at different levels. Two types of
informations are passed between modules: Data and control.

The qualities reflected by the module design include coupling, cohesion, span of, size and shared
use.

7.7 KEYWORDS

Universal Program: The program at its highest level.

Linear Program: A method for straight forward programming in a sequential manner which does
not involve any decision making.

Structural Program: programs that are divided into functional modules and arranged in an
hierarchical order.

Structured Programming: The process of breaking the overall job into separate pieces of modules.

Program Module: The part of program that performs a separate function.

Coupling: Strength of relations between modules.

Cohesion: Strength of relations within a module.

7.8 REVIEW QUESTIONS

Unsolved Questions
1. Fill in the blanks:

(a) In_____approach, a simple main program is written first to text the sub programs.

(b) In top down design, modules should be kept_____

(c) Using the_____, to construct a program, save yourself repeating the same lines of
code by reusing it.

(d) _____are divided into functional modules and arranged in an hierarchical order.

(e) _____means the strength of relations between modules and ____means the strength
of relations with a module.

2. State : True or False:

(a) A bottom up approach would be to write the most basic subroutines in the hierarchy
first and then use them to make more sophisticated subroutines.

(b) Linear programming also involve decision making.
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(d) The iteration structure is a special kind of conditional execution of a group of statements.

(e) Functions may be duplicated in separated modules.

Answers (Unsolved Questions)
1. (a) top down design (b) small (c) Subroutines (d) Structured programs (e) Coupling,

Cohesion.

2. (a) True (b) False (c) True (d) False (e) False.

Detailed Questions
1. What is the difference between top down and bottom-up design approach?

2. What are the advantages of top down design?

3. Describe the top-down Implementation.

4. Give a general model of linear programs

5. Define structural programming.

6. What is a program module.

7. Define conditional looping.

8. What is Iterative logics?

9. How does two modules communicate?

10. Differentiate between coupling and cohesion.

7.9 FURTHER READINGS

Peter Van Roy and Seif Haridi, Concepts, Techniques, and Models of Computer Programming,
MIT Press.

Richard Holowczak, Programming Concepts - A Brief Tutorial for New Programmers,
http://cisnet.baruch.cuny.edu/holowczak/classes/programming.
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8
PRESENTATION GRAPHICS

L E A R N I N G  O B J E C T I V E S

After studying this unit, you should be able to understand:

How to create a presentation on PC using wizard or template. Or a blank presentation?

Components of power point screen.

Auto content wizard.

Different views available in power point.

Displaying the slides.

Saving a presentation.

U N I T  S T R U C T U R E
8.1 Introduction
8.2 Creating a Presentation on PC
8.3 Creating a New Presentation
8.4 PowerPoint Views
8.5 Creating a Presentation Using a Template
8.6 Creating a Blank Presentation
8.7 Opening an Existing Presentation
8.8 Displaying the Slides
8.9 Saving a Presentation
8.10 Closing a Presentation
8.11 Summary
8.12 Keywords
8.13 Review Questions
8.14 Further Readings

8.1 INTRODUCTION

PowerPoint is a presentation software package included in Microsoft Office suite. It is used to
create professional quality presentations. A presentation is a structured delivery of information.
Presentation can be reproduced on transparency, paper or on-screen. PowerPoint features can be
used to work on slides, organize presentation contents with outlines and generate speaker notes
and audience handouts. Teachers, professors, politicians and sales representatives make
presentations to sell their concepts. Some other notable presentation software packages are
Harvard Graphics and Lotus Freelance.

PowerPoint 2000 helps you structure the ideas and information that you may want to convey to
your audience. It lets you create the contents of your presentation by typing/inserting text,
pictures, sounds and animations. With it, you can add visual images, supporting documents and
audio recordings to enhance your presentation. PowerPoint makes the creation of any presentation
simple by providing built-in professional designs called AutoLayouts and templates. You can
also create different versions of. a presentation for different audiences and build your contents in
either a text-based outline view or a design based slide view.

8.2 CREATING A PRESENTATION ON PC

Before you start creating presentations, you need understand the layout of the PowerPoint screen.
The PowerPoint screen displays several toolbars and other basic screen elements (refer to the
Figure on next page).
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Presentation GraphicsThe components of a PowerPoint screen are:

Menu Bar: It is similar to the menu bar in other Microsoft Office applications having File,
Edit, View, Insert, Format, Tools, Window, Help menus.

Toolbars: Toolbars are collections of buttons that you can click and activate some of the
most common commands in PowerPoint. These commands can also be activated through
menus.

Status Bar: It is located at the bottom of the PowerPoint screen. It displays the number of
the current slide and the name of the template on which the presentation is based.

Vertical Scroll Bar: It helps you to scroll through the slides in a presentation.

Slide Buttons: They are located at the bottom of the vertical scroll bar and help you to
display the previous and next slides.

8.3 CREATING A NEW PRESENTATION

PowerPoint offers a variety of ways to create a new presentation. You can create a presentation
by using wizard or a template. You can also create a blank presentation.

Starting AutoContent Wizard

Everytime you start PowerPoint 2000, the PowerPoint dialog box is displayed which offers methods
of starting the session. You can use it to choose the method for starting your PowerPoint 2000
session. The main choices are Creating Blank Presentation or Opening an Existing Presentation.

The first option in the PowerPoint dialog box under Create a new presentation using is the
AutoContent Wizard. The AutoContent wizard is a guide composed of several screens that help
you to create a professional presentation quickly and easily. It basically takes you through series
of questions. You can choose options to create a good presentation.

The steps to create a presentation using the AutoContent Wizard are:

1. Select the AutoContent Wizard option from the PowerPoint dialog box.

A dialog box as shown in the figure is displayed.
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The AutoContent Wizard can create 8 to 12 slides with suggested content that you can
change.

2. Click on the Next Button.

A dialog box as shown in the figure is displayed.

Press a category button for the type of presentation you are going to create and then select
the presentation that best suits your need.

3. Select the Presentation style in the Next screen as shown:

The given screen shown on next page helps choose the type of output you will be using
and the wizard will select the best color scheme for your presentation. You can change
the look of your presentation by applying other color schemes available in the format
menu.
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4. Enter data into each text box and click on the Next Button.

The information entered by you will be put into the presentation by the wizard for you. You
can always change this information later.

5. The Next screen will end the AutoContent Wizard and in turn your presentation will be
created as shown below.
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The Presentation Created by the wizard for you will be seen in the Normal view as displayed in the
figure below.

8.4 POWERPOINT VIEWS

Microsoft Power Point comes with different views to help you while you are creating a presentation.
The two main views you can use in PowerPoint are normal view and slide sorter view. To easily
switch between views, you click the buttons at the lower left of the PowerPoint window.

Normal View

Normal view contains three panes: the outline pane, the slide pane, and the notes pane. These
panes let you work on all aspects of your presentation in one place. You can adjust the size of
different panes by dragging the pane borders.

Presentation in
normal view

Outline pane

Notes pane
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Presentation GraphicsOutline Pane: Use the outline pane to organize and develop the content of your presentation.
You can type all of the text of your presentation and rearrange bullet points, paragraphs, and
slides in this pane.

Slide Pane: In the slide pane, you can see how your text looks on each slide. You can add
graphics, movies, and sounds, create hyperlinks, and add animations to individual slides.

Notes Pane: The notes pane lets you add your speaker notes or information you want to share
with the audience. If you want to insert graphics in your notes, you must add the notes in notes
page view.

These three panes are also displayed when you save your presentation as a Web page. The only
difference is that the outline pane displays a table of contents so that you can navigate through
your presentation.

Slide Sorter View

In slide sorter view, you can see all the slides in your presentation on screen at the same time,
displayed in miniature. This makes it easy to add, delete, and move slides, add timings, and select
animated transitions for moving from slide to slide. You can also preview animations on multiple
slides by selecting the slides you want to preview and then clicking Animation Preview on the
Slide Show menu.

At any time while you are creating your presentation, you can start your slide show and preview
your presentation by clicking Slide Show.

Change the Size to the Panes in Normal View

Do one of the following:

1. To change the size of a pane in normal view, drag the right border of the outline pane or the
top border of the notes pane.

2. At the lower left of the PowerPoint window, click Outline View to enlarge the outline pane or
click Slide View to enlarge the slide pane.

What Happen to Slide View and Outline View?

Slide view and outline view have been combined in normal view.

If you would like to use the old slide or outline view, you can add the command to a menu or
toolbar.

1. On the Tools menu, click Customize, and then click the Commands tab.

2. In the Categories box, click View.

Presentation in Slide Sorter View

Slide
Sorter
toolbar
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3. Drag the Outline or Slide command from the Commands box to the menu or toolbar you
want to add it to.

If you are adding the command to a menu, when the menu displays a list of commands, point to
where you want the command to appear, and then release the mouse.

Student Activity 1

1. What is power point?

2. Describe various components of a power point screen.

3. How will you create a presentation using Auto content wizard?

4. Describe various views available in power point.

8.5 CREATING A PRESENTATION USING A TEMPLATE

A presentation template is a saved presentation file that contains predefined slide and title
masters, color schemes and graphic elements. The presentation templates also includes masters
with pre-formatted fonts and styles.

The steps to apply a template to a new presentation are:

1. Select the Template option from the PowerPoint opening dialog box. The following screen
appears.

2. Click on the Design Template tab to display various design templates.
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is displayed as shown in the figure below.

4. Select the layout from the New Slide dialog box and click OK button.

A slide as shown in the figure below will be displayed

Template is a general term used for a pattern, which will remain same throughout the Presentation.
All the slides will have the same background as selected by you.

8.6 CREATING A BLANK PRESENTATION

The third option in the PowerPoint dialog box is creating a blank presentation. The steps in
creating a blank presentation are as follows:

1. Select the New option from the File menu. The New Presentation dialog box is displayed.

2. Select the General tab and double - click on the Blank Presentation icon. The New slide
dialog box is displayed.

3. Select the suitable layout and click on the OK button.
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A slide as shown in the figure will be displayed.

8.7 OPENING AN EXISTING PRESENTATION

The steps to open an existing presentation are:

1. Select the Open an existing presentation from the PowerPoint dialog box. The list given
below activates. You can select from the list provided to you or you can select from the
Open dialog box as shown below.

2. Select the appropriate drive and folder.

3. Type the name of PowerPoint file to be opened in the File name text box or select a file name
from the list.

4. Click on the Open button.
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There are several ways to navigate from slide to slide when you are editing your presentation.
The method you choose depends on what view is currently active. The Keyboard or the Mouse
can be used to navigate through the slides whichever you find easy to use.

Using the Keyboard

To navigate through the slides in your presentation, employ the shortcut keys listed in the
Table 8.1.

Using the Mouse

You can also use the mouse to scroll through your presentation. In the Normal, Slide, and Note
page views, the vertical scrollbar also contains Previous Slides and Next Slide buttons. You can
click the buttons to move to the previous or next slide.

Table 8.1

8.9 SAVING A PRESENTATION

You can save the presentation you're working on - whether it's new or you've saved it before - and
you can also save a copy of it with a different name or at a different location. You can save any
presentation in HTML format so that it can be viewed on the Internet. You can also save a
presentation so that whenever you open it, it always starts as a slide show.

The steps to save a presentation are:

1. Select Save from the File menu.

or

press Ctrl + S

The Save dialog box is displayed as shown in figure below.

2. Enter the File name when the Save button gets activated.

3. Click the Save button.
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To close a presentation, select the Close option from the file menu. If the current file is unsaved,
Power Point will display a dialog box with Yes/No options. Select Yes if you want to save the file,
No if you do not want to save the file or Cancel to return to your file without saving it.

Student Activity 2

1. Write a step wise procedure to create a presentation using a template.

2. Write a step wise procedure to create a blank presentation.

3. How will you open an existing presentation?

4. How will display the slides of a presentation?

5. How will you save a presentation?

6. How will you close a presentation?

8.11 SUMMARY

The application software that can professional looking visual aids is called presentation. Graphics
software. MS-Power point can be started by clicking at start→programs→Microsoft power point.
A slide can contain one or more of  these component: Titles, Graphs, Drawing objects, clipart and
pictures. The slide components that are used for reference are: Handouts note, on lines. A new
presentation can be created through one of these methods: (i) Auto content Wizard (ii) Blank
presentation. A new slide can be added by either clicking at common tasks option of formatting
toolbar, and then selecting new slide option, by clicking at insert menu’s new slide option. A
presentation in power point can be viewed in any of these views. Normal, outline slide, slide
sorter, slide shows and notes page views.

8.12 KEYWORDS

Design Template: A set containing graphics design and color scheme of a presentation.

Handouts: Compressed versions of  the slides in a presentation.

Outlines: Summarized version of slides, that contain only tiles and main text.

Presentation Graphics Software: A software that lets one create professional electronic
presentation.

Slide: An electronic page in electronic presentation

Slide Show: Electronic presentation that can run on computer screen or a protection device.

Speakers' Notes: Small images of slides along with explanatory notes.

8.13 REVIEW QUESTIONS

Unsolved Questions
1. Fill in the blanks:

(a) Power point is a ____software.

(b) The ____is a guide that help you to create a professional presentation quickly and
easily.

(c) The normal view contains three panes:____,____and____.

(d) ____view allows you to see all the slides in you presentation on screen at the same
time.

(e) ____is a pattern which will remain some throughout the presentation.
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(a) The two main views of power point are normal view and slides sorter view.

(b) You can preview you presentation by clicking slide show.

(c) The presentation templates does not include masters with pre-formatted fonts and
styles.

(d) The keyboard and the mouse can be used to navigate through the slides.

(e) Slide view and outline view have been combined slide-sorter view.

Unsolved Answers
1. (a) Presentation (b) Auto content wizard (c) The outline pane, the slide pane, the notes

pane (d) Slide sorter (e) Template

2. (a) True (b) True (c) False (d) True (e) False

Detailed Questions
1. What is a slide?

2. What is a slide show?

3. What is an outline view of slide?

4. Describe various panes of slide in normal view.

5. How will you open an existing presentation?

6. What are the basic components of a slide?

7. What is the use of slide sorter view in power point?

8. In which pane can you insert speakers notes.

8.14 FURTHER READINGS

K.K. Shahjahan, MS-Office, Excel Books.

Sanjeev Gupta, Shameena Gupta, Computer Aided Management (Using MS-Office 2003
Tools), Excel Books.
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9
DATA COMMUNICATION AND NETWORKING

L E A R N I N G  O B J E C T I V E S

After studying this unit, you should be able to understand:

How to describe data communication and its various types.

Approaches and modes of data transmission.

Working of modem/fax modem.

Multiplexing.

Components and types of computer network.

Network topology and cables.

OSI model of network.

LAN and its popular types.

Client /server and peer to peer networking.

Network operating system and network environment.

U N I T  S T R U C T U R E
9.1 Introduction
9.2 Data Communication
9.3 Multiplexing
9.4 Components of Computer Network
9.5 Local Area Network (LAN)
9.6 Uses of a Network
9.7 Topology
9.8 Networking Cables
9.9 OSI Layout and IEEE
9.10 Popular Types of LAN
9.11 Inter Networking
9.12 Public Networks
9.13 Client/Server vs. Peer to Peer Networking
9.14 Network Operating Systems
9.15 Network Management
9.16 LAN in Business Environments
9.17 Summary
9.18 Keywords
9.19 Review Questions
9.20 Further Readings

9.1 INTRODUCTION

Today world is often referred to as global village. All thanks to today’s revolutionary technology.
Because of today’s technology, we can communicate to any portion ion any corner of the world
from anywhere in the world. And the credit for all this goes to the communication revolution that
has happened in this century, especially in the last thirty years. Advances in
the communication technology, have made possible nearly everything we dreamt of.

It is basically communication that makes you take advantage of massive mainframe processing
power if you turn your PC into a terminal of a mainframe. It is communication that lets you chat
with different people across the globe through an on-line services. It is again communication that
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allows you to access huge servers of information on virtually any subject via networks of
computers. And that is why this chapter is dedicated to this fascinating combination of
communication, computer and networking.

9.2 DATA COMMUNICATION

Flow of information for purpose of efficient management and business process control requires
effective use of computer systems and networking technologies. Even for a simple important
exercise of printing any information from a computer by an attached printer to a computer, there is
a requirement for error free data transmission from the computer to the printer. The whole concept
of data communication is based upon principles of sending data, checking and confirming its
receipt following error correction technique to ensure accurate data transmission.

This communication is possible with the approach known as protocols. The data flows between
two devices as sequential bits (0 and 1) across a transmission medium say copper wire. These bits
are grouped to form a character. A character may be a number, an alphabet or a symbol. As a
standard, generally 8 bits form a byte or a character. Each bit (0 or 1) is represented as a voltage
level on a transmission medium. As a standard, bit 0 represents a positive voltage and bit 1
represents a negative voltage. These signalling conventions are followed by most of the
communicating devices. The most common interface standards are RS232c or V5, X.21 etc. In
RS232c signalling standard, voltage level between +5V to + 15V represents bit 0 and voltage level
between -5 to -15V represents bit 1. During an idle state while the data is not being transmitted,
only the electric current flows through a transmission medium (wire). At the instance of data
transmission the current in the wireline is intercepted in a particular way to superimpose data that
is representable as the voltage levels to traverse towards receiving device.

Asynchronous Transmission

In asynchronous mode of data transmission each character (byte) is transmitted one at a time.
Each character is preceded by a start bit. The purpose of start bit is to inform the receiving device
that a character transmission has begun. The transmitted character ends with a stop bit. The stop
bit suggests that a character has been transmitted. Each bit represents a voltage level for a
specific length of time to enable the receiving device to recognize and record the incoming signal
accurately. This specific length of time determines the rate of data transfer that may be measurable
in bits per second. In asynchronous mode of transmission there is no indication of the speed at
which the character is being transmitted. Therefore, there is no perceptible method for the receiving
device to sample the incoming signal precisely to recover the transmitted data. For this lack of
synchronization of transmission this mode of transmission is called asynchronous transmission.
This anamoly of non synchronization is overcome by providing internal clocks at each end,
transmitting as well as receiving. Both internal clocks work at the same rate such that on the
receipt of start bit the receiver device starts its internal clock to instruct receiver's interface to
sample the incoming signal.

Notes: Some systems may require more than one stop bit as a character terminator. This is generally
for slower devices typically with slow mechanical components. Other important point to note is that
there are several kinds of bit representations of a character. Most commonly used are ASCII (American
Standard Code for Information Interchange) and EBCDIC (Extended Binary Coded Decimal
Information Code). In widely used ASCII representation 7 bits uniquely represent a character. The
8th bit is called parity bit and used primarily for identification of success or failure of a character
transmission device to sample the frame of information appropriately at correct signalling rate.

Synchronous Transmission

In synchronous mode of data transmission a block of characters is transmitted one at a time. Each
block of characters is preceded with a few synchronization (SYN) characters. These SYN characters
contain the timing information which is used by the receiving device clock onto the sending
device's signal. Since, in this mode of data transfer the block contains the timing information
using SYN characters that allows automatic synchronization, this process is known as synchronous
transmission. The size of blocks of characters may vary therefore there exist the ASCII control
characters termed as STX (start of text) and ETX (end of text) that are used as delimiters. The
synchronous mode of data transmission is advantageous when there exists large volume of data
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to be transmitted at a higher data transfer rate. The efficiency of synchronous transmission varies
according to the block size and dependent upon the protocol. If the block size is too small the
overheads of protocol is more due to additional SYN characters and delimiters in header although
the probability of error in transmission reduces. In case the block size is too large the general
efficiency for large data transfer may improve in terms of data transfer rate but the probability of
error in transmission increases. Therefore, for a reliable error free data transfer over a long distance
requires that a maximum block size be fixed. Frequently used block size standard in most of the
protocol is 512 bytes. Generally the level of efficiency in the synchronous mode of transmission
is higher than in the asynchronous mode of transmission. (Refer Figure 9.1)

Figure 9.1 : Asynchronous Transmission

Figure 9.2 (a): Synchronous Transmission

Figure 9.2 (b): Synchronous Transmission of Variable Block Sizes

Notes: A block of data is also referred as a packet. A sequence of blocks that is transmitted from a
sending device needs to be reassembled at the receiving device. Each packet contains a packet or block
identity number and routing address for destination for accurate reassembly as the original data. In
case of identification of error on receipt of a packet, a request is sent to the sending device for
retransmission of that packet again. (Refer Figure 9.2)

Error Management in Data Transmission

In synchronous transmission, the most common approach of error detection in data transmission
is CRC (Cyclic Redundancy Check) or check sum. This is adopted as a CCITT standard. CCITT
(Consultive Committee for International Telephony and Telegraphy) is an international committee
of telecom standards based in France. A checksum that is a remainder of data is divided by a fixed
polynomial or a bit pattern is appended to the data bits before transmission. At the receiving
device the data is verified against the checksum. For recovery of erroneous data packets in
general and an error free data transfer in particular, generally it is implicit for the receiving device
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incorrect receipt. In the case of a satellite link connection a technique known as FEC (Forward
Error Correction) is followed primarily for memory access and also for data transmission and
recovery. This approach deters response back to the sending device by incorporating some
additional information embedded in the data. The receiving device makes the necessary correction
automatically by the identification of these codes in the embedded data. These codes are also
referred to as Hamming codes.(Refer Figure 9.3)

Figure 9.3: Packet Switching

Notes: Issues of Interoperability

The structure of the unit of data sent should be recognized at the receiving end;

The representation of data (ASCII/EBCDIC) should be the same on both sides of data
communications;

There should be a method of introducing checkpoints for recovery during large data transfer
in the event of failure;

There should be adequate security measures;

There should be end to end protocol in both communicating hosts to recover from errors in
a similar fashion;

Both communicating hosts should use similar addressing techniques. Approaches for Data
Transmission

Approaches for Data Transmission

In a network of communicating devices there are two popular approaches for data transmission.
First approach is to open a connection across the network and  let the data pass through that
connection. At this connection, the routing information is established and route numbers are
assigned to blocks of data. This connection is also referred as a virtual circuit. Another approach
is a connectionless approach. In this approach all packets carry full address of its destination and
sequence identity. Each packet takes routes independently without a preestablished route and
reassemble and re-sequence at the receiving device. This approach is also referred to as a datagram
service.
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Modes of Data Transmission

In the simplest form of data transmission data flows in one direction. In a half duplex system of
data transmission data flows in the forward and backward directions to the receiving and the
sending devices but not simultaneously. Most common example of a half duplex system is a radio
link or a wireless set. In a full duplex system of data transmission data flows in both directions
simultaneously. A typical example of a full duplex data transmission is the RS232c interface.
RS232c interface is typically designed to connect any digital equipment to a data communication
equipment. A modem is a typical DCE.

Working of Modem/Fax Modem

A modem is a modulation and demodulation device. A typical function of a modem is to convert
the digital output of a computing device into analog signals at the transmitting end. This
modification of a digital signal is known as modulation. A modem also converts the analog signal
into digital at the receiving end of computing device. This function is known as demodulation.
The computing devices (computers) connected with modems are also known as DTE (Data Terminal
Equipments). The basic function of a modem is to enable communication between computers
remotely located. Modem is connected to a computer port via a telephone line. The analog signals
are carried through the telephone line. (Refer Figure 9.4)

Figure 9.4: Working of a Modem

The criteria for selection of modem should depend upon the speed of transmission, error correction,
data compression capability and Hayes compatibility. The modems that are less than 14400 bits/
sec data rates as speed are mostly obsolete now. User should prefer a modem with speed equivalent
or greater than 28800 bits/sec. A modem should be easily configurable to be used for TCP /IP
(Transmission Control Protocol/Internet Protocol). This protocol enables a modem to communicate
with most of the other modems, use of internet and most of the networking technologies. We
would discuss more of TCP/IP in the next chapter on ‘Telecommunications’. A modem should
support V protocol. V 4.2 protocols have supplanted the old Microcom’s MNP4 protocols for
error correction. For data compression, V.42b is protocol should be preferred. MNP5, MNP10 are
data compression protocol available from Microcom. The shortcoming of MNP protocol is that
these cannot handle already compressed data. A modem should be Hayes compatible. Hayes
compatibility has become de-facto standard for modems because most modems follow Hayes
command set for their configuration. (Refer Table 9.1)
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There are two types of modems; internal and external. Internal modems are card sized and installed
inside the computer. An external modem is box shaped powered by an external power adapter and
connected to the computer with a serial cable. For faster modems 14.4 kps and above the computer
should be fitted with 16550 UART chip based serial port. Fax modems are designed to send and
receive faxes in addition to data.. Fax software is also needed to send fax. There are fax standards
ranging from Group I to Group IV or Class 1 and Class 2. Group IV and Class 2 are faster, more
efficient and the latest standard and therefore generally preferred. Some of the modems come with
digitalized voice capability also. These modems can function as voice answering machine also
when used with appropriate software.

The popular brands of modems available today are TEK from MroTek, Boca from Boca Research/
Power Tel, Soltrix from Soltrix/Amketee, Optima, Accra from Hayes/Datamatics, Sportster from US
Robotics/Soom from Soom Telephonics, MT Series from multitech, Comsphere from AT&T,
Paradyne/Crompton Greaves, etc.

Serial and Parallel Transmission

In serial transmission each byte of information takes eight time slots for transmission. In parallel
transmission eight separate wires are used to send each bit simultaneously. Over long distances
serial transmission is a popular approach for data transmission. Parallel transmission is generally
used over short distances because of its advantage of speed in comparison to the serial
transmission. Generally the interface between a computer and a printer have a parallel connection.
The cost overheads of parallel transmission is higher than serial transmission. Internal clocks
facilitate the synchronization of data received from eight transmission lines because these bits
may traverse at marginally different speeds.

Lines of Communications

There are basically two popular lines for communications. A public telephone is the ordinary
voice grade line. This line is routed through many relay systems and electromechanical systems.
This line of communication is also referred to as PSTN (Public Switched Telephone Network). A
leased line of communications is generally not subjected to the level of switching as in PSTN.
This line of communications accommodates wider range of frequencies than the voice grade. A
leased line of communications consists of bidirectional simultaneously operating two telephone
circuits.

9.3 MULTIPLEXING

Multiplexing is a technique of channelling multiple data inputs into one connection. The approaches
used to implement multiplexing is generally based on division of communication channel into time
slots or frequency bands. This technique was developed to overcome deficiency of old mainframe
machine which had direct terminal connections access for various peripherals and other computers
connected to it. Mainframe machine served as host to these terminals. This led to poor utilization
of the system because majority of connected systems remain inactive for major period of time
whereas some of the systems were saturated with requirement of data access or processing at a
specific time. Moreover the feasibility to provide port for each terminal as requirements grew was
vague. (Refer Figure 9.5)

Table 9.1 : Modern Speed and Protocol 

Modem speed Basic Protocol Error correction Data compression 

14.4 kps V.32 V.42 V.42bis 

28.8 kps V.34 V.42 V.42bis 
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Figure 9.5: Working of a Multiplexer

Student Activity 1

1. Define data communication.

2. Differentiate between synchronous and a synchronous modes of transmission.

3. Describe error management in data transmission.

4. Describe various approaches of data transmission.

5. Describe the working of modem.

9.4 COMPONENTS OF COMPUTER NETWORK

Till now we have covered the basic concepts of data communication, therefore we are in a
position to study the methodology of communication in a network of interconnected computers
located in different places. The typical hardware in a network of computers consists of the
following components:

(a) computers,

(b) peripherals such as printers, scanners, plotters and modems, cables, network interface
cards,

(c) hubs and switches,

(d) repeaters, bridges, routers, gateways.

9.5 LOCAL AREA NETWORK (LAN)

A LAN is a network of computers that are interconnected in a particular fashion and contained
within a limited area say a building.

A typical LAN has two components:

a) A host computer that is called ‘File server’. Large networks may have more than one
Fileservers.

b) Workstations or the terminals of a LAN are interconnected and connected to the Fileserver.
Workstations in a LAN are personal computers that have their own processing power.

The significant feature of a LAN is that its workstations are intelligent terminals with a capability
of distributed processing. This is unlike in a mainserver or miniframe centralized server based
environment where the connected terminals are dumb without processing power of their own.
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The prominent reasons which led to development and popularity of LANs are:

1. Sharing of expensive resources such as disk, files, printers, plotters, modems and software
was needed.

2. Diskless nodes (workstations) of a LAN provided security and virus protection by not
allowing to download important data from server or uploading unwanted software.

3. Distributed processing for inter-user communication within an organization and information
exchange was the most suitable model for MIS development.

4. Data management in a LAN environment is more efficient than the centralized processing
systems. Since, no users directly request to server for data without resorting to file transfer
on a stored media like floppy or hard disk.

5. LANs are more flexible and modular. This implies that LANs can be expanded easily by
adding of workstation with the support of networking software. If more disk storage is
needed, another hard disk can be installed or other file server can be connected in a LAN.
More than one LAN can be bridged to share data and communicate.

6. Most LANs have fault tolerant features such that in case of power failures LANs are
capable of disk mirroring and disk duplexing to safeguard data.

Notes: The hardware components hubs, switches, repeater, bridges routers and gateways are
generally applied whenever expansion of a LAN is required beyond geographic limits of optimum
performance or when two or more LAN systems are needed to be integrated for sharing of
peripherals and data resources. Modems are used alongwith telephone lines in the following cases:

(i) WAN (Wide Area Network) is needed for communication of computers located in remote
sites of an organization.

(ii) A computer user needs to access information from remote file server.

(iii) A computer user needs to send/receive electronic mail to/from a remote computer system.

We would describe this component appropriately while discussing internet working of LANs.

9.6 USES OF A NETWORK

The network provides an intelligent switching capability between the devices for purpose of
sharing. For instance an expensive laser printer in network can be share be by many microcomputers
in a network. The network enable creation of a large buffer where data accumulates from various
computing devices. In case of print sharing the buffer activates as a queue on a special device
known as print server. In a typical office environment the facilities of terminal access to central
computing machine such as mainframe, access to external and remote devices, access to database
or messaging or e-mail provisions necessitate the networking of devices. The environments like
point of sales in retail outlets, central heating thermostats and time clocks, automatic telling
machines to banks main computers, process control devices in a manufacturing environment are
not feasible without networking.

9.7 TOPOLOGY

The structure or layout of the cabling in connecting devices together to form a network is called
topology of the network. The advantage of a structured topology is that it is easier to add or
delete a node in the network.
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Bus

The Bus consists of a single communication channel. Each connected device is attached to the
media at an interface point. Each connected device has a unique hardware address. Data transfer
takes place using these hardware addresses. The bus will have more complex arrangements with
several interconnected segments.

Advantages

Simple layout

Ease in connectivity

Locating cable faults is easy

Ideal for one to many data transmissions since all connected devices see the traffic on the
cable. The signal reaches all stations regardless of their position on the bus.

Bottlenecks

There is no automatic acknowledgement of receipt by virtue of the topology. The signals stop on
reaching the end of the cable and do not return by default to the sender. Therefore, the higher
level protocols exists which can ensure that data is successfully exchanged.

Ring

Unlike bus topology, in a ring configuration the data transmission is unidirectional. Data
transmissions are received by each station’s interface as the data passes through the interface
connection. Like bus topology, each interface only copies the data from the network. Thereafter
data communicates to the device connected to the network on basis of the packet’s destination
address. Each network interface connection has its own hardware address for identification.
Typical ring topology is generally used in the large network Fibre Distributed Data Interface
(FDDI).

In ring topology, each interface station allows data transmission to pass through the interface
with only a few bits delay. For instance, consider circulation of a data packet (say 128 bytes), the
start of data packet may well have circulated around the ring and arrived back at the originating
station before the end of the packet has left for circulation. There is always only one circulating
data packet on the ring.

Advantages

No routing problems since everyone on the ring receives the data. The addressed node
makes copy of the data for circulation

Every generated packet eventually returns to the node therefore the acknowledgment of
successful data transmission is trivial

Larger networks may be constructed from a number of interconnected rings.

Bottlenecks

In case one of the nodes fails network comes to a halt.

Star

Generally, it includes a central switching system or hub. In the figure, if station D wishes to talk to
station B, it does so via the hub. In case a new device is required to be added it interfaces with
another cable attached to the central point. And if the hub is physically close to the connected
device then the individual cable rum would not be problematic. (Refer Figures 9.6, 9.7 & 9.8)
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Figure 9.6: The Bus Topology

Figure 9.8: Star Topology

The Hub makes the routing decisions
Nodes interface is simple
If the switch fails, entire network halts
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Advantages

Better overall reliability against cable faults provided the central point which is switching
data to the destination is robust

Only a single node will be unavailable in the event of cable failure

LANs implemented on the star topology are sometimes based on existing telephone wiring
in the building and do not normally have high data transfer rates.

Bottlenecks

In case the switch or hub fails the entire network is halted.

9.8 NETWORKING CABLES

The main transmission media used in LANs are twisted pair, coaxial cable and fibre optic.

Twisted Pair Cable

It consists of two wires which provides a signal path and a return polyethylene dielectric and
shielded by braided metal. This is covered in a plastic jacket.

Coaxial Cable

There are many types of coaxial cables reflecting the differing number and type of protection
shield used.

Data rates, as high as 500 Mbps, are supportable, but normally it is upto 50 Mbps. Error rates may
be of the order of 10e-9. Distances up to 500m can be covered without signal degradation. Coaxial
cable support baseband as well as broadband transmission. Baseband transmission possess
digital signals from one workstation to another usually at a speed of 10 Mb/s upto distance of
nearly 10000 feet. Broadband transmission enables transmitting of voice, audio, video and data
signals (e.g., television and cable television transmission) at a speed of nearly 5 Mb/s over
distances nearly 10 Km.

The cost of cable installation is usually higher than the cost of cable itself. Flexible coaxial cable
is used in thin wire Ethernet. Therefore, it is relatively easy to install. Rigid coaxial cable is used in
the original thickwire Ethernet. Therefore it is more difficult to install for it requires more careful
handling.

Fibre Optic Cable

It consists of hair like grass strands, covered with cladding and an outer jacket. This is often used
for backbone networks and is the foundation for the over 100Mbps FDDI network. These span
long distances without signal degradation. Though these are highly reliable, installation of these
cables is much more expensive than other type of available cables. For category of cables and
their features refer Tables 9.2 &  9.3.

Table 9.3: IBM Cable Specifications

Table 9.2: Cable Category Rated in Mhz 
Category 1 Ordinary telephone cable or RS 232 

Category 2 Data cables upto 4 Mbps 

Category 3 Data cables upto 16 Mbps 

Category 4 Data cables upto 20 Mbps 

Category 5 Data cables upto 100 Mbps 
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1. What are the various components of a computer network?

2. Define LAN. Name its components.

3. What are the used of a network?

4. What is a topology? Name various network topologies.

5. Describe various types of cables used in networking.

9.9 OSI LAYOUT AND IEEE

ISO (International Standards Organization) has put forward (ISO/OSI) reference modem to ensure
interoperability of LAN systems provided by various vendors. LAN operations and accessing
schemes are described in OSI (Open System Interconnection) standards. Several IEEE committees
have developed a set of standards for LAN topologies and access methods using the OSI standards
as a foundation. (Refer Table 9.4). These standards aim at networking designs to become more
flexible and open.

 Table 9.4: IEEE Established 802 Committees to Set Various LAN Standards

We discuss seven layers of OSI in a sequence, layer 1 to layer 7. We would perceive importance
of OSI layering system later in our discussion where emphasis is drawn on usage of these layers
by various components of LAN for a smooth functioning. (Refer Figure 9.9)

Figure 9.9: OSI Reference Model

OSI Seven Layers Model

Physical Layer

This is the bottom layer of the model. It specifies:

The way the data and control characters are physically signalled to each other.

All the properties related with the representation of a bit.

Physical connections, i.e., specifications of plugs and sockets.

Details of the media.

7 File transfer, access and management document and message interchange etc.

6 Data representation transformation and security

5 Dialog and synchronisation control

4 End to end transfer management

3 Network routing and addressing

2 Framing, data transparency, error control

1 Mechanical and electrical network interface definitions

Application
layer

Presentation
layer

Session layer

Transport
layer

Network layer

Link layer

Physical layer
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Link Layer

Flow control of data is implemented within this layer. This layer ensures that the bits carried by
physical layer have a structure. This layer is responsible for transferring blocks or packets of
information between each of the connecting points.

Network Layer

Network layer is primarily responsible for routing of information on basis of internet address
format. This level receives packet sized data block from transport level and maps to network
addresses.

Transport Layer

Flow control and sequencing of data blocks is performed at this level. Transport layer provides
reliable end to end exchange of data. This layer is responsible for optimization of the transmission
by multiplexing.

Session Layer

Session layer provides coordination between users by selecting mutually acceptable protocols.
This layer establishes calls to exchange the data bit streams. This layer effects check points for
recovery of data.

Presentation Layer

Presentation layer maps the various data representations into an external data format enabling
correct interpretation of the information received. This layer implements the confidentiality or
security of data. This layer enables the compression of data.

Application Layer

Application layer provides a range of service interfaces for application programs such as e-mail,
directory services, file transfer, etc. This effects the interchange of information amongst various
application processes.

9.10 POPULAR TYPES OF LAN

The most popular types of LAN are as follows:

a) Ethernet

b) ARCNet

c) Token Ring

d) Switched Ethernet

e) 100VG and LAN

f) Fast Ethernet

g) Fibre Distributed Data Interface

h) ATM

The types (d), (e), (f), (g) and (h) are the latest developments in the LAN types. The development
of these LANs was necessitated due to increase in demand of network's bandwidth. The discussion
on these LANs would be followed after we define the term 'bandwidth' and seek reasons for its
increased demand in the modem corporate world. We initiate our discussion with explanation of
the first three LAN types.

Ethernet

Ethernet network was designed and developed by Xerox and DEC. It was initially designed to use
coaxial cable though later development enabled it to use other cabling systems. The methodology
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of communication for ethernet is CSMA/CD (Carrier Sense Multiple Access/Collision Detection).
In the protocol CSMA/CD, the physical layer of user's workstation generates a carrier sense
signal. This signal is listened to by the other workstation. This other workstation waits and
begins communication only if such a signal is not detected. Popular cable connections for ethernet
are thick ethernet coaxial and thin ethernet coaxial.

ARCNet

ARCNet network was designed and developed by Datapoint Inc.,United States. ARCNet is a
baseband token passing network system. In an ARCNet network transmission speeds are nearly
2.5 Mbps. Generally, ARCNet LAN is on a hybrid topology that is combination of liner bus and
star.

Token Ring

Token ring network is physically a star and electrically a ring. It is based on IEEE 802.5 standard.
In a token ring network token passing scheme is used. It involves a hardware known a MAU
(Multistation Access Unit) that is used to connect upto 8 stations in a network.

Notes: All LAN connections need a network interface card and a networking operating software such
as Novell Netware, Vines, etc. A LAN has a particular cabling system such as coaxial, thin or thick
ethernet, twisted pair, etc. A LAN uses hubs, switches and connectors through the cabling system
and networking topologies. A hub is a centralized distribution point for all traffic on a network just
like a warehouse distribution centre. In bound data traffic from NIC (Networking Interface Card)
arrives at the hub. The hub receives and rebroadcasts it's copy to all workstations connected to the
hub. Stackable hubs are stacked and connected through a proper interface port such that they appear
as single hubs. These are also called Active hubs. Nonstackable hubs are not connectable. Active hubs
split and relay network signals and amplify the signal strength whereas Passive hubs only split and
relay network signals without strengthening signals. Active hubs are connected to the network
backbone. Passive hub is generally connected to the active hubs. Intelligent hubs include a pooling
protocol SNMP (Simple Network Management Protocol) that obtains network performance and the
status data from network. Dumb hub needs management from MIS and networking department.

Notes:

Bandwidth
Bandwidth of a communication network can be described as the amount of data that can be fit through
a network connection. In broadcasting, bandwidth is the measure of the spectrum between the highest
frequency and the lowest. Unit of bandwidth is hertz (Hz.). The evolution of more network capacity
bandwidth in terms of computing efficiency and network speed in data communication has gained
momentum owing to:

The rapid increase in computing power at the desktop level.

The proliferation of bandwidth hungry applications such as multimedia, e-mail, messaging
Groupware and distributed databases.

Advent of Internet and Intranet access; and availability of Web servers and browsers.

The corporate is demanding high bandwidth networks to boost quality of their data communication
and management information systems. More users, file servers, application servers, workstations
and peripherals of high performance capabilities has contributed to increase in network traffic. The
aim of the corporate to improve the sharing of information by consolidating multiple LANs into one
shared LAN has necessitated the search for high speed networking technologies.

Switched Ethernet

Switched Ethernet 10 Mbps uses switch to segment a large LAN into smaller LANs. This ensures
dedicated 10 Mbps connection to a particular PC at all times. Though the switched Ethernet hub
is inexpensive and effective solution, it has a drawback. In some of situations it can move the
bandwidth bottleneck to another point in the network.
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100VG any LAN

This LAN was developed by Hewlett Packard and IBM and standardized under IEEE 802.12
specifications. This is based on DPAM (Demand Priority Access Method) which is somewhat
similar to Token ring or FDDL This LAN has not become much popular because other technologies
like ATM and Fast Ethernet provide better compatibility with existing networks.

Fast Ethernet

Fast Ethernet or 100BaseT is an extension of Ethernet specification as approved under IEEE 802.3.
These networks provide higher bandwidth with data rate as high as 100Mbps. These networks
preserve core Ethernet protocols CSMA/CD and are compatible with existing ethernet wiring
types, media and applications.

Fibre Distributed Data Interface

FDDI is an ANSI standard technology for fibre optic networks mostly suitable for high end
workgroups requiring data rates around 100 Mbs. CDDI (Copper Distributed Data Interface) uses
similar technology and is relatively much cheaper networking solution. Since FDDI is an expensive
technology, it is being used mostly as a backbone interconnect between low speed LANs.
Backbone is a wire that stretches between networks. Other application areas where it has been
found useful are data intensive and bandwidth hungry such as multimedia, CAD/CAM (Computer
Aided Design and Manufacturing), 3D modelling, etc.

Notes: The user workstations are connected to servers. Servers are connected to a network
backbone. Generally backbone networks use broadband network system. The advantage
of this system is that it provides large bandwidth and is capable of transmitting across very
large distances.

AIM

Asynchronous transfer mode is promoted by ITU (International Telecommunication Union) as
high speed communication link for desktops as well as a high performance backbone for LANs
and WANs. The most salient feature of ATM is its scalability in speed varying from 25 Mbps to
multiple Gigabits per second. The other feature of ATM is that it allows simultaneous transmission
and receipt of data without interruption (duplex mode). ATM also allows simultaneous transmission
of video, image, audio and data over a single line. Despite the high potential of ATM technology
for high bandwidth networking, the prevalence of ATM is currently severely restricted due to
several factors. Firstly, ATM is considerably expensive technology. Secondly, many of the
applications need alteration to be successfully run on high bandwidth provided by ATM. ATM
may be considered if volume of transactions on a network is very high and a seemless integration
of LANs and WANs is required.

9.11 INTER NETWORKING

In our earlier discussion we have learnt that a LAN is network of computers generally contained
within a limited area say a building. These networks of computers are usually built on one type of
network card and cable. A LAN may be expanded to a limited extent by adding workstations and
limited length of cable. Beyond these limits performance of a LAN may degrade. Expansion of a
LAN is possible by boosting the signals to accommodate long distances. A repeater may be used
for this purpose.

Bridges are the devices that link two distinct LANs. Bridges may also be used to divide a overloaded
LAN with great data traffic into two separate trunks. A router is bridge like device that interconnects
several types of LANs. The main function of router is to provide the best route for the packets of
information through the interconnection of LANs. Bridges can direct data to different segments
of a network using physical addresses but they cannot direct data traffic to another network. A
router directs data using logical addresses therefore it can send data to traffic bounds to unknown
destination, to another router, which knows the destination. A Switch is a high speed bridge that
segments a LAN traffic such that it switches packets from one segment of LAN to another in a
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matter of milliseconds. This switching is done so efficiently that it appears that the whole and
each segment of LAN has full access to the entire bandwidth of the network.

A Gateway is used to interconnect two dissimilar LANs. Since, a sort of translation is needed for
two dissimilar networks therefore gateway is more sophisticated, slower in performance and
expensive relay device. For example, if a Novel netware network which is running IPX/SPX protocol
is connected to a VAX host running VMS operating system, the data from netware LAN has to be
correctly interpreted by the VAX host. The Gateway relay device is extremely useful for
communication of LANs as distinct as running on SNA and DECnet protocols. The Gateway
operates on network layer and above. Besides the already described internetworking devices,
there is another internetworking device known as Brouter which functions as a bridge as well as
a router.

One of the popular vendors marketing Brouters is Bay Networks. Brouter routes when routing is
possible and if unable to do so it bridges. Refer Figure 9.10 (A,B,C,D,E,F) to get a better
understanding of the functionality of the internetworking devices.

9.12 PUBLIC NETWORKS

The most common public networks that have been available consist of X.25 services. X.25 network
is interface between many remote LANs connected through gateways or routers. Frame relay and
ATM are lately being used as alternative of X.25 services. X.25 implements addressing, routing
and multiplexing at network

Figure 9.10 (a): Different Internetworking Device

Figure 9.10 (b): Repeater Works on Physical Layer
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Figure 9.10 (c): Bridge Works on Data Link Layer

Figure 9.10 (d): A Bridge Joins two Similar Networks for Network Expansion and Increase
Performance by Reducing Network Traffic

Figure 9.10 (e): A Bridge also Connects Dissimilar LANs such as Ethernet and Token Ring

Figure 9.10 (f): Router Works on Network Layer
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layer whereas the X.25 services are available worldwide therefore interconnection between LANs
is achievable on global basis. The speed of connection is 64 kps, though in practice lower speeds
such as 8 kps are available at busy times. This renders high speed burst from LANs connected to
X.25 without any advantage. Frame relay implements addressing, routing and multiplexing at data
link layer. Frame relay services range normally from 64 Kbps to 2.048 Mbps. ATM and Frame relay
technologies are generally complimentary. ATM can be used for high volume transmissions while
Frame relay may be used for low speed connections in the same data network.

Salient features of Frame relay are:

1) Unlike X.25, Frame relay works without network layer involvement.

2) Frame relay uses error detection rather than error correction on transmission as in X.25.

3) The conversion of X.25 to frame relay is not tedious.

4) The Frame relay can carry voice.

5) The Frame relay has also been in use in broadband ISDN (Integrated Services Digital
Network ). ISDN is a digital phone connection technology that provides voice, data and
image transmission facility over single connection. ISDN is capable of providing internet
access speed to the tune of 56 KB.

9.13 CLIENT/SERVER VS. PEER TO PEER NET-
WORKING

There exist two kinds of LANs: Client/Server and Peer to peer that may be installed as per the
requirement of an organization. In Client/Server LAN the server is centralized and has the large
database, large internal memory, user interface and application software. Workstations request
for the server resources. The server executes the request. Any workstation cannot act as a server
to any other workstation even if it has got the storing capacity containing data and the application
software. Peer to peer are low cost LANs where each workstation may act as a server to any other
workstation. Peer to peer networking is only suitable for maximum of 25 workstations only. It is
generally suitable for sharing of office oriented software such as spreadsheet, databases, e-mail,
word processing softwares but not a large application of on-line billing, statistical process control,
inventory control (Refer Table 9.5). The typical examples of available Client Server LANs are
Novel Netware, Windows NT, LAN Manager, Bayan Vines, Artisoft LANtastic, etc. The typical
examples for peer to peer networks are Novell Netwarelite and Windows for workgroup from
microsoft.

Table 9.5: Client Server vis Peer to Peer LAN

9.14 NETWORK OPERATING SYSTEMS

The salient feature of a networking operating system is that each workstation in a network works
uniformly through the same operating system based at the server. This provides seem less

 Client server Peer to Peer 

Workgroup 
size 

10-500 2-25 

Remote 
location 

May include many remote locations Limited to telephone access 

Applications Primarily a large database. Can also include 
standard productivity software 

Primarily productive software such 
as spread sheets, graphics, etc. 

Security Data is sensitive and requires full authentication 
of user for each application. Security 
administrator is required to make changes 

Password is appropriate for most 
data users who determine security 
needs for themselves 
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integration in the working environment. For example Networking operating systems Unix, Novell
netware or Windows NT the file system is accessible by just providing the path search for
particulars file from workstation to remote server. The structure and access control to all files is
identical. We would discuss Novell netware as a LAN operating system in some details.

Novell Netware

Novell Netware (current version 4.1) is presently one of the most popular NOS (Networking
Operating Systems). Netware is compatible both with IBM compatible PCs and the Macintosh
range of Apple computer systems. Netware is a very open system because it operates across
multiple platforms and multiple protocols such as IPX/SPX (Internetwork Packet exchange/
Sequenced Packet exchange), TCP /IP (Transmission Control Protocol/Internet Protocol),
Appletalk, X.25 and so on. Netware fileserver provides a common file system implemented through
NCP (Netware Core Protocol). The facilities provided by NCP are:

1. File access in read, write, open, close modes.

2. File locking that protects file and enables only one user to modify a file at a time.

3. Security levels that determine rights of file for users, groups and everyone. Rights may be
executable, read only, read and write, etc.

4. Network security that is maintained by assigning a login name and password to every
individual LAN users. The LAN administrator has supervisor login name that gives him all
rights for LAN maintenance such as creating groups, changing passwords or login names,
etc.

5. Print server and queue management.

6. Network management.

7. Resource allocations to users/groups such as disk space, networking time and accounts,
etc.

8. The netware include SFT (System Fault Tolerance) level 1, level 2 security. In case of server
failure, in level 1 of SFT duplexing of FAT and directory entry table takes place. In similar
cases, SFT level 2 provides disk mirroring and provides an object oriented approach in
managing resources and users on internetwork. Other salient features are:

Login through windows;

Graphical network analysis;

WAN connectivity;

Multiple language capability of success or failure of a character transmission;

Imaging services using HCSS (High Capacity Storage System) that enables transfer or
migration of image document and other files. HCSS also provides support for mounting
optical devices and juke boxes as Netware server volumes;

Management capability through NetView or SNMP (Simple Network Management,
Protocol).

Netware 4.1 is available in packs of ten users and above. For small scale implementation of LAN,
Novell offers Netware Lite, a Peer to Peer networking system. Novell netware is a client server
based networking operating system.

9.15 NETWORK MANAGEMENT

Having broad overview of LAN, we briefly discuss the technical issues of LAN management. The
concern for interconnection and interoperability of LANs necessitates this discussion. There are
variety of LANs available with variety of protocols such as TCP /IP, OSI, XNS (Xerox Networking
System), SNA/APPC (System Network Architecture), ATP(Apple Transport Protocol), NETBEVI
and IPX/SPX. The network management assumes more relevance where integration of these
variety with interoperability is concerned. The popular range of network management tools that
are available are CMIS/P (Common Management Information Service and Protocol) from BT,
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Overview from HP, Netview from IBM, NMS from Novell, Spider Sentgel from Spider, SunNet
Manager from SUN, SNMP Lattiset from SynOptics, Net Director from V-B. In a networking
environment a network manager is responsible for maintaining the configuration, allocating
necessary disk space, ensuring the appropriate growth and installation of LAN, user training and
providing the appropriate security levels for smooth functioning of LANs. A networking uses the
network management tools for troubleshooting any discrepancy in LAN functioning at any time.

9.16 LAN IN BUSINESS ENVIRONMENTS

LAN environments vary in functionality and services in distinct business environments. When
we talk of business environment we take a note of the type of business the organization conducts
such as hospitality, marketing, manufacturing, tours and travels,

Figure 9.11 (a): Manufacturing Environment

Figure 9.11 (b): Servers
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banking, finance, stock and shares, engineering, etc. For example, LAN in a manufacturing set up
may have numerically controlled machines, automatic guides vehicles, robotics and mini or
mainframe as server, microcomputers as workstations, Novell netware or Vines or Unix as an
operating system, CAD/CAM software (like Autocad) and a database software system such as
sybase, informix, ingres, etc. A tour and travel reservation office may have a pentium microcomputer
as a fileserver and microcomputer terminals (nodes) as workstations for on-line billing generation,
networking operating system such as Microsoft windows NT or Novell netware, a database
engine based on RDBMS Oracle, Ingres, Informix or Foxpro. (Refer Figure 9.11 (a,b)

Student Activity 3

1. Describe OSI layer model of a network.

2. Name some popular LANS.

3. Define token ring network.

4. Define ATM.

5. Describe Internetworking.

6. What are public networks?

7. Write a short note on Novell network.

8. Write a short note on Lane in Business environment.

9.17 SUMMARY

Flow of information for purpose of efficient management and business process control requires
effective use of computer systems and networking technologies. This communication is possible
with the approach known as protocols. The data flows between two devices as sequential bits
(0 and 1) across a transmission medium say copper use. In asynchronous mode of data transmission
each character (byte) is transmitted one at a time.

The data transmission can be asynchronous or synchronous. CRC (Cyclic Redundancy Check) is
the most common error detection technique in synchronous transmission.

A modem is used to convert the digital output of a computing device into analog signals and vice
versa. The communicating device (computers) connected with modems are also known as DTE
(Data Terminal Equipments).

Multiplexing  is a technique of channeling multiple data inputs into one connection. Mainframe
machine served as host to these terminals.

LAN is a network of computers that are interconnected in a particular fashion and contained
within a limited area say a building. It has two components-A host and workstations.

The network provides an intelligent switching capability between the devices for the purpose of
sharing. The structure of layout of the cabling in connecting devices together to form a network
is called topology of the network. Various LAN topologies include BUS, RING, and STAR. The
transmission media used in LANs are twisted pair curial cable and fabler optic. The seven layers
of OSI model include Physical layer, link layer, network layer, transport layer, session layer,
presentation layer and application layer.

Some popular LANs include Ethernet, AR (net token ring, Switched Ethernet, 100 VG and LAN,
and Fast Ethernet.

9.18 KEYWORDS

Modem: A modulation and demodulation device which converts the digital signal into analog and
vice versa.

LAN: A network of computers that are interconnected in a computers that are interconnected in
a particular fashion and contained within a limited areas say a building.
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Topology: The structure or layout of the cabling in connecting devices together to form a network.

Gateway: A device used to connect two or more dissimilar networks.

9.19 REVIEW QUESTIONS

Unsolved Questions
1. Fill in the blanks:

(a) In_____mode of data transmission, each character is transmitted one at a time.

(b) A block of data is also referred as a_____.

(c) The two popular approaches for data transmission include_____and _____.

(d) A modem is a _____and_____device.

(e) _____is a technique of channeling multiple data inputs into one connection.

(f) _____is the layout of the cabling in connecting devices together to form a network.

(g) _____cable is often used for backbone network.

2. State : True or False:

(a) Internal modems are designed to send and receive foxes in addition to data.

(b) Parallel transmission is generally used over short distances.

(c) In a bus topology, the data transmission is unidirectional.

(d) The cost of cable installation is usually higher than the cost of cable itself.

(e) ARCnet LAN is on hybrid topology.

Answers (Unsolved Questions)
1. (a) asynchronous (b) packet (c) virtual circuit, datagram services (d) modulation,

demodulation (e) Multiplexing (f) Topology (g) Fibre optic

2. (a) False (b) True (c) False (d) True (e) True.

Detailed Questions
1. Differentiate between asynchronous and synchronous modes of transmission.

2. What are the advantages of asynchronous mode of transmission?

3. What are the various modes of data transmission?

4. What is the difference between serial and parallel transmission?

5. Give reason that led to the development and popularity of LANs.

6. What is a topology? Describe various types of topology? Describe various types of
topologies?

7. What are the advantages of Bus topology?

8. What are the bottle necks of Ring topology?

9. Differentiate between twisted pair and coaxial cable.

10. Write a short note on fiber optic cables.

11. Describe the function of transport layer in OSI model.

12. Write short notes on the following:

(i) Ethernet

(ii) ARC net

(iii) Token ring

(iv) Switched Ethernet

(v) 100 VG any LAN
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(vi) Fast Ethernet

(vii) Fiber Distributed Data Interface

(viii) Peer to peer networking

(ix) Client server networking.

(x) Network management.
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